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DSLRs are amazing devices for sure, but I’m no great fan of jumbo-sized shooters. I don’t
want to weigh myself down with heavy gear on a mountain trek or annoy people on the
street by pointing a huge lens in their direction. I prefer to use something more compact
and unobtrusive, but with all the benefits of a complete system. I was really excited when
I discovered  Micro Four Thirds in early 2011, although back then I still had trouble
choosing the right components for my personal setup.

Two years later, the Micro Four Thirds lens market has expanded enormously and I
wanted to find out just how good all these new optics are. We got hold of a cross-section
of today’s lenses – from high-end primes to standard kit zooms – and took them back to
the c’t photo lab for a thorough test.

Thanks to the compact dimensions of the hardware, our outdoor test shots were  a
dream to shoot. The two camera bodies packed easily into my shoulder bag and the
complete set of lenses into a daypack. The hardest part of the test was finding the right
weather, as our test cameras didn’t always have exposure times that were short enough
to match the maximum apertures of some of the lenses in bright sunshine. In this case,
clouds were nearly always welcome.

All in all, the Micro Four Thirds system has grown up fast and now offers a real alternative
to the established DSLR heavyweights. Of course, no system is perfect, and you can read
more about the pros and cons of MFT in our in-depth report starting on page 18.

Have fun with Issue 11!

Sophia Sieber 
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Could’t Stop Reading 

Yesterday I bought c’t Digital Photography 
Issue 9 by accident (didn’t know it before) and
I couldn’t stop reading almost to the last
article. Your technical competence is
outstanding and rock solid, yet extremely well
presented and easy to read. Your articles are
very well written and the selection of topics is
nicely balanced and various. I particularly
appreciate the regular mentions and inclusion
of open source alternatives.

Aron Lentsch

Thanks very much for your kind words.
Comments like yours confirm that our
philosophy of publishing long articles with 20
pages and more is the right approach, even if it
is an unusual concept for a contemporary
photo magazine. See page 100 for this issue’s
open source tool test.

Impressive Attention for Open
Source Software

Issue 9 first impressions: Outstanding job, guys!
I’m suitably impressed and especially happy
with the multi-page spread on Jason Lee. He
deserves it. I spotted him some time ago on
Flickr and have been following him ever since.
In print, his images look even more exciting
than on the web. 

Your commitment to even-handedness
when it comes to attention for open-source
software was already impressive in your
computer mag, but it shows here as well. Top
marks for that!

I cannot let you go without one little bit of
criticism here: the image database software file
recognition test. Had a look at the samples
provided on the DVD – how on earth you
decided to have all of these generated by
Photoshop, I don’t know. Obviously, an
Adobe-specific format like PSD or PSB will not
be read by many other programs. It’s like
expecting Photoshop to read GIMP’s native XCF
format. That skews the results heavily.

Otherwise I still have tons of reading to do
and you certainly made good on your promise
of being the most comprehensive photography
mag available bar none, so a big, big THANKS!

Mike Bing

Thanks for your praise and your valuable
comments. Photoshop is still the standard
professional image editing tool, and a quality
image database should be able to at least
recognize these files, although we admit
some of them are quite exotic. PSD files are
still being used in many private image
databases, and we think database software
should be able to display them. We conducted
our tests using a fresh Windows 7 installation
with all updates and the versions of the
programs that were current at the time. The
factors that influence test results include the
program version, the installed RAW codecs
and even OS system updates, so comparing
such a system with Mac or Linux simply
doesn’t make sense under any circumstances.

Why Did You Not 
Test Canon DPP?

Chromatic Aberrations, Issue 9 (2012), p.66

I’m a subscriber from the very first issue and I
think yours is the most valuable photo
magazine on the market.

I really enjoyed and appreciated the article
about chromatic aberrations and the software
tools test, but I don’t understand why you did
not test Canon’s DPP software as well, since
you tested Nikon Capture NX 2.

I’m using a Canon 5D mark II camera with
the EF 24-105L lens and I was disappointed to
find it produced chromatic aberration, which
I’m used to mitigating using DPP, so I’d
appreciate a test that includes it. 

Keep doing such a great job.

Stefano Colombo

First of all, thanks for your feedback. Most
camera manufacturers provide proprietary
RAW conversion software with their products,
so we had to decide which one to use for our
test. Nikon is the only manufacturer to offer its
software as a retail version, which was the main
reason we chose it in preference to Canon’s
DPP. Also, many photographers nowadays use
third-party RAW conversion software, such as
Photoshop Lightroom, because it offers more
advanced features than the free tools provided
by the camera manufacturers, and features
were the focus of our test.

More eBooks on DVD Please

Your article quality remains outstanding,
thank you. On page 54 of Issue 10 there is a
reference to The Art of Black and White
Photography, which is an eBook that was
included on the free DVD in Issue 6. I don’t
think there has been an eBook included on
the DVD since Issue 7.

Please consider including more eBooks on
your DVD (PDFs please). Although I watch 
and learn things from the videos you provide,
I really like the eBooks. Even if a
photography-related eBook is a couple of
years old, most of the time the information
would still be useful.

Richard

We will be including eBooks on our DVDs in
future. However, we are restricted by the
availability of suitable material and the
relevance of the themes covered, so there
won’t be one in every issue.
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Reader Forum

Readers’ Letters

We are always happy to receive your
comments and suggestions in a letter,
an e-mail to editor@ct-digiphoto.com
or at www.facebook.com/ct-digiphoto.
We reserve the right to abbreviate your
input for publication. Our comments
are printed in italics.

Tell us what
you think:





Steven van Veen is a fashion and portrait
photographer and uses this video to show

you how to produce spectacular protraits
without the use of complex gear.

Using a very simple approach, he shows us
how to turn a rainy day shoot in an ordinary
hallway with a picture window into fantastic
results with soft, virtually shadow-free light.

As well as introducing you to the basics of
shooting in available light and giving you tips
on how to find and use spontaneous locations
away from the studio, the tutorial also reveals
how the photographer adapts his model’s
styling to match the location and lets us in on
exactly which equipment and camera settings
he uses to achieve his results. For example, he
uses a wide f3.2 aperture to separate the subject
from the background and skilfully utilizes the
changing intensity of light within the location
to vary the effect of the results.

Steven shoots handheld using a relatively
high ISO value of 800 – a value that the Nikon
D700 used here is capable of applying without
producing too much noise. It is fascinating to
watch how he uses basic equipment and simple
instructions for his model to quickly produce
really impressive portraits. (sea)

Photomizer 2 
Special Edition

c’t Special Version Software
Photomizer is a quick and easy
solution to many exposure and color
corretion challenges, and includes a
range of other advanced tools too.

Photography began as a means to an end 
for Tobias Hauser, helping him to document

his trips around the world and share his
experiences with others. His hobby became his
profession and he has now spent more than ten
years presenting his work in books, calendars
and lectures. 

His work has taken him to some of the most
beautiful countries on Earth, and this video
documents his trip through a country that is
known worldwide for its plentiful flora, fauna
and landscapes. Almost a third of the land is
comprised of protected nature reserves, 
making it a perfect hunting ground for exotic
photographic subjects. 

Tobias provides us with valuable tips on
shooting in this extraordinary location and
explains why the often neglected rainy season
is actually a great time for a photo trip. In
addition to many candid portraits, his images
show fantastic landscapes studded with
mountains, volcanoes and rain forest. The
country’s national parks are home to many rare
species, and this video provides a great insight
into why a trip to this tiny Central American
republic should be high on everyone’s list of
destinations. (sea)

Available Light
Photography

Video Tutorial
This video shows that available light
and a couple of simple techniques are
all you need to produce flattering
portraits in ‘bad’ weather. 

On the Road 
in Costa Rica

Video Travelog
Costa Rica offers a rich selection of
exotic photo subjects. This report tells
you all about how to approach a photo
tour in this fascinating country.

8 c’t Digital Photography 11 (2013)

This issue’s free DVD includes a wide frange of free and full version image processing and photo tools,
including our own VStripe time-lapse image generation software (see page 94). We have also a included
a free, full version of Photomizer 2, which will help you to quickly and easily correct color and exposure
errors in your photos and create new HDR-style images from your own source material. Sample images
from our Micro Four Thirds lens test and five expert video tutorials round out this issue’s offerings.

Free DVD | Highlights

Snapshots often suffer from poor exposure,
and beginners especially prefer to rely on

their cameras’ auto exposure software rather
than getting involved in complex settings and
risking missing the important moment. The
results are often dull or incorrectly exposed. This
special c’t version of Photomizer 2 will help you
optimize such photos using just a few clicks. In
addition to color and exposure correction tools,
the program also includes HDR simulation
functionality that you can switch to automatic
mode or control using a dedicated slider. 

The software also includes dedicated profiles
for optimizing photos that were captured using
scanners, smartphones and webcams. Before
and after views allow you to check your changes
before saving them. 

Use of the software requires (free) online
registration from the installer interface. Once
you have registered, you will receive a serial
number via e-mail that gives you unlimited use
of the software and includes an exclusive 20
Euro discount on an upgrade to the current full
version or a 100 Euro discount on the Photoshop
plug-in version. Please note that the special
edition software doesn't support batch
processing or noise and artifact removal. (tho)

DVD Highlights
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DVD-Highlights | Contents

Image Processing Tools
Artweaver Free 3.1.3

ChromAcute

Fix-CA

GIMP 2.8.2

GIMP Portable 2.8.2

GREYC’s Magic Image Converter
(G’MIC) 1.5.3.0

HeliosPaint 1.5

Image Analyzer 1.34

Inkscape 0.48.4

Inkscape Portable 0.48.4

Photomizer 2 Special Edition

Photivo

PSPI 1.0.7

RawTherapee

Photo Tools
Awesome Duplicate Photo Finder 1.1

Enblend/Enfuse

ExifTool 9.15

FastStone Image Viewer 4.7

FastStone Image Viewer Portable 4.7

Hugin 2012.0.0

MacPorts

PhotoRec 6.13

XnView 1.99.6

Sample Images
Micro Four Thirds Lens Test

Video Tools
Deshaker 3.0

VirtualDub 1.9.11

VirtualDub Portable 1.9.11

VStripe

Video Tutorials
Available Light Photography

Costa Rica Photo Tour

Create Your Own Time-Lapse Images 
from Video Clips

Retouching Portraits of Children

Photoshop Tutorial: 
The Lab Color Booster

Water Droplets in Focus

DVD Contents



The influence that two neighboring

ecosystems have on each other is known 

as the 'Edge Effect'. Which aspects of this

phenomenon interest you as an artist? 

Daniel Kukla: ‘Edge Effect’ refers to the
transitional zone between two distinct
ecosystems. These are dynamic places with a
high level of biodiversity that are able to
sustain species from both environments.
Because it is exceedingly difficult to witness
this type of phenomenon as a casual
observer, I was looking for a way to use art to
portray the interaction between these ‘twin’
landscapes.

You used a large, square mirror to reflect

the second ecosystem in your 'Edge Effect'

photos, and the photos themselves are

also square. Why did you take this

approach? 

When I first arrived in the area I was
experimenting with about 30 small 
6 x 6-inch mirrors, along with pieces of
broken mirror and larger, rectangular
mirrors. When I placed the rectangular
mirrors on the easel I found that they closely
resembled landscape paintings or
photographs, while the small mirrors and
shards did not reveal enough of the

contrasting landscape. The square mirror not
only matched the aspect ratio of the images
captured by my medium-format camera, but
also gave me sufficient space to frame the
opposing landscape.

The edge effect occurs in many different

environments. Why did you choose the

desert as your subject?

The Joshua Tree National Park straddles a
huge swath of land in the south-western
USA and contains a large edge zone where
the Mojave and Sonoran deserts meet. It is
an important area for studying the effects of

10 c’t Digital Photography 11 (2013)

Portfolio | Daniel Kukla

Portfolio

Daniel Kukla
How do mankind and nature influence each other’s development? 
This is the central question that shapes the work of biologist and 
photographer Daniel Kukla.



large cities and climate change on the
environment. This aspect of the project
particularly appealed to the biologist in me.

Working in a desert sounds like a real

challenge – tell us about some of the

problems you encountered.

Life in the desert is an extreme experience:
the plants and animals that inhabit this
environment are poisonous and covered in
spikes and thorns, the sun is harsh and
temperatures fluctuate between 40 degrees
Celsius and below freezing. The most
frustrating obstacle to my Edge Effect

project was the wind, which constantly
toppled my lighting equipment and
shattered my mirrors.

Your El Altiplano project also has a desert

as its main subject, in this case at 12,000

feet above sea level in the arid highlands of

southern Bolivia. What was it about this

particular area that interested you?

It has long been a tourist destination due to
its otherworldly geography, and now lithium
deposits have been discovered beneath the
salt flats, so there has recently been a surge

in mining activity in the area. I’ve long been
interested in the interaction between
humans and the environment and I wanted
to catch a glimpse of a place that was once
virtually untouched but where industry and
human settlements are now proliferating.

Tell us a little about the equipment you

use.

I use a beaten-up old Hasselblad and a
Canon EOS 5D Mark II for most of my work,
and I often use Adobe Lightroom and
Photoshop to give my images a final polish.

(keh)
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Echo Rock, Joshua Tree National Park, 2012



Little San Bernadino Mountains, Joshua Tree National Park, 2012

Cholla Cactus Garden, Joshua Tree National Park, 2012

12



Keys View, Joshua Tree National Park, 2012
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Portfolio | Daniel Kukla

El Altiplano, Bolivia, 2010
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Portfolio | Daniel Kukla

El Altiplano, Bolivia, 2009
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For his Captive Landscapes project, Daniel
Kukla captured images in 12 zoos located
in Europe and the USA





Sophia Sieber 

Micro Four Thirds
Lens Review
Since the introduction of the Micro Four Thirds system, Panasonic and
Olympus have presented a wide range of high-quality lenses to go with their
diminutive camera bodies, and photographers who want to use high-end
lenses are no longer limited to using a DSLR system from one of the major
manufacturers. This article reviews the lenses currently on offer and puts eight
selected models through a comprehensive c’t Digital Photography test. 

Market Overview 20

Lens Test 28

In this article
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M icro is the Greek word for ‘small’, but
the only thing small about today’s

Micro Four Thirds (MFT) lenses is their physical
size. MFT camera bodies are available in a
wide range of prices with varying feature sets
and the range of lenses offered for the format
is enormous. The much-vaunted collaboration
between Olympus and Panasonic has borne
interesting fruit, while other system camera
manufacturers are still developing their own
proprietary systems. 

Twelve manufacturers, including Carl Zeiss,
Sigma, Leica, Tokina and Tamron, have joined
the MFT fold since Olympus and Panasonic

agreed on the Micro Four Thirds specifications
in 2008. Some of these already produce MFT
lenses, while others, having agreed on the
principles, have yet to introduce any
real-world products. The official compatibility
lists now cover a range of more than 30
lenses – from bright, fixed-focal-length
models to telephoto zooms and just about
everything in between. The tables beginning
on page 22 summarize the basic technical
details and price data for all of these.

In addition to the approved lenses, there is
an almost endless range of manual special-use
lenses made by ‘unofficial’ manufacturers,

such as Samyang and SLR Magic. Although
their names include the MFT moniker in their
names, these lenses can often only be used
with MFT cameras with the help of an adapter
(see the box on page 24 for more details). 

But does this huge range of light, compact
lenses offer quality too? We took four
fixed-focal-length and four zoom lenses
manufactured by Panasonic, Olympus and
Sigma, and performed stringent lab tests and
a range of real-world shooting tests to find out
just how good these lenses really are. You can
find the results of our investigations starting
on page 28, and our test images are included
on this issue’s free DVD. 

Zoom Lenses

The MFT market offers do-it-all kit telephoto
and wide-angle zooms, covering just about
every application imaginable. However, these
lenses don’t yet match the quality offered by
the established DSLR market, and there are
still very few high-quality third-party zooms to
choose from, so for now, the Olympus and
Panasonic offerings are the best choice in this
segment.

Lenses like the M.Zuiko Digital ED
14-150mm f/4.0–5.6 (for about US$600) and
the Lumix G X Vario PZ 45-175mm f/4.0-5.6
(for US$350) are great all-rounders. The Lumix
G Vario 7-14mm f/4.0 ASPH and 100-300mm
f/4.0-5.6 OIS (or the M.Zuiko Digital ED
9-18mm f/4.0-5.6) round out the focal length
range offered by the two main manufacturers.

The current range of MFT zooms all have
mediocre brightness in common, and

20 c’t Digital Photography 11 (2013)

Micro Four Thirds Lenses | Market Overview

Many compact MFT zooms cover a broad range of focal lengths. The Lumix
G X Vario PZ 45-175mm shown here has a maximum wide-angle aperture
of f/4 and f/5.6 at the telephoto end of the range.

The M.Zuiko MSC ED 12-50mm is the real
multi-purpose tool among today’s kit

lenses and includes the macro
functionality lacking in most other lenses

in its class. It is also weatherproof, just
like the OM-D camera bodies.

The MFT lenses offered by
Voigtländer/Cosina are some of
the heaviest around, but are also
among the brightest 
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maximum wide-angle apertures larger than
f/3.5 are a rarity. Many zooms start at f/4.0 and
a focal length between 12 and 14 mm (i.e.,
24-28|mm full-frame equivalent). At the long
end of the range, normal values range between
42 and 50 mm (100 mm equivalent) and
maximum apertures of around f5.6. The
Olympus OM-D 12-50mm kit lens has a
typically small maximum aperture of just f6.3 at
the telephoto end of the scale. Forging ahead
into telephoto zoom territory often entails
putting up with even smaller apertures. 

Large maximum apertures do, of course,
help to minimize exposure times and reduce
the risk of camera shake, especially at
telephoto focal lengths. They also make it
easier to shoot in low light and give you more
creative leeway when it comes to controlling
depth of field – for example, to separate a
portrait subject from the background. On the
positive side, most MFT zooms are relatively
inexpensive, and good-quality models start at
less than US$400. 

New, Brighter Zooms

Things have begun to change in the MFT
zoom market, and Panasonic introduced its
Lumix G X Vario 35-100mm f/2.8 Power OIS
and Lumix G X Vario 12-35mm f/2.8 ASPH
lenses to an expectant public in 2012. Both

lenses have a constant and unusually bright
maximum aperture throughout the zoom
range. Check out our test results for the
12-35mm model later in this article.

The downside of this extra performance is
increased size. The 35-100mm measures
67 mm (2.7”) in diameter and is 100 mm ( 3.9”)
long, while the 12-35mm measures
68 x 73 mm (2.66 x 2.91“). Both weigh more
than 300 grams (about 11 ounces), making
them heavyweights among the current crop
of MFT zooms. Used with the diminutive
Olympus OM-D body, lenses like this make the
camera much more difficult to handle
because they shift its center of gravity a long
way forward. This is simply the price MFT
photographers have to pay for improved
performance. 

These new lenses are nevertheless small in
comparison to equivalent full-frame lenses –
for example, the Canon EF 70-200mm f/2.8L IS
II USM is nearly 200 mm (8”) long and weighs
1.5 kg (3.4 lb). These new-breed of MFT zooms
are also less expensive than their full-frame
counterparts. 

Fixed Focal Length Lenses

The market for MFT lenses with fixed focal
lengths is more varied than the zoom
segment. Third-party manufacturers such as

21c’t Digital Photography 11 (2013)

Micro Four Thirds Lenses | Market Overview

The Micro Four Thirds system is a further
development of the older Four Thirds
system and is designed specfically for use
with mirrorless cameras. The sensor size in
both systems is the same (13.5 x 18 mm),
giving them a 26.63mm diagonal (i.e., half
that of a full-frame sensor). 

Micro Four Thirds cameras therefore have a
crop factor of 2 and a standard focal length
of 25 mm. 

Unlike standard 3:2 full-frame sensors, MFT
sensors have an aspect ratio of 4:3. If you
prefer looking at 3:2 images, you will have
to crop your MFT images. 

At 20mm, Micro Four Thirds has a shallower
flange focal length than Four Thirds, which
comes in at 38.85mm. The MFT bayonet is
also 6mm narrower than its cousin. These
dimensions, combined with the lack of a
mirror box and reflex mirror, make it possible
to build MFT cameras that are much smaller
than their Four Thirds counterparts. 

The Micro Four Thirds Standard Explained

Micro Four Thirds is the latest,
mirrorless iteration of the Four Thirds
system developed jointly by Olympus
and Kodak. Its specifications include
a smaller bayonet and a shallower
flange depth than its predecessor.Im
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Fixed focus, fixed aperture. 
The tiny size of the 15mm f/8.0 Olympus
Body Cap Lens makes up for its lack of
user-controlled settings, allowing you to use
it in a range of unusual creative situations. 
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Micro Four Thirds Lenses | Market Overview

MICRO FOUR THIRDS LENS OVERVIEW
Lens Type Fixed Focal Lengths
Manufacturer Olympus
Image

Model M.Zuiko Digital ED 75mm f/1.8 M.Zuiko Digital ED 60mm 
f/2.8 Macro

M.Zuiko Digital 45mm f/1.8 M.Zuiko Digital 17mm 
f/2.8 Pancake

M.Zuiko Digital 12mm f/2.0 Body Cap Lens 15mm f/8.0

URL www.olympus.com
Focal Length
Absolute 75 mm 60 mm 45 mm 17 mm 12 mm 15 mm
Full-frame 
equivalent

150 mm 120 mm 90 mm 34 mm 24 mm 30 mm

Aperture
Maximum f/1.8 f/2.8 f/1.8 f/2.8 f/2.0 f/8
Minimum f/22 f/22 f/22 f/22 f/22 f/8
# of blades 9 7 7 5 7 1
Construction
Elements 10 / 9 groups 13 / 10 groups 9 / 8 groups 6 / 4 groups 11 / 8 groups 3 / 3 groups
Angle of view 16 degrees 20 degrees 27 degrees 65 degrees 84 degrees 72 degrees
Minimum focus 
distance

0.84 m 0.19 m 0.5 m 0.2 m 0.2 m 0.03 m

Maximum 
magnification

0.1 x 1 x 0.11 x 0.11 x 0.08 x 0.06 x

Dimensions
Filter thread 58 mm 46 mm 37 mm 37 mm 46 mm n/a
Breadth x Length 64 mm x 69 mm 56 mm x 82 mm 56 mm x 46 mm 57 mm x 22 mm 56 mm x 43 mm 56 mm x 9 mm
Weight 305 g 185 g 116 g 71 g 130 g 22 g
Street price (US$) 899 499 399 299 799 49
1 Only as part of a kit with Lumix G3/2/G10/GF2/3/GH2            2 Not yet available at the time of going to press                n/a = not applicable

Which of these two lenses would you rather
take on a hiking trip? 
The MFT lens has the same (constant)
maximum aperture, weighs a whole kilogram
less and is half the size of its full-frame
equivalent.
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Sigma, Cosina (Voigtländer) and Tokina, as
well as niche manufacturers such as Samyang
and SLR Magic have joined the party, and
there are already quite a few bright, high-end
fixed focal length lenses available. 

Sigma’s 19mm f/2.8 EX DN and 30mm f/2.8
EX DN both have reasonably large maximum
apertures and cost less than US$200. These
light, compact, fully automatic lenses are a
useful addition to the available range of MFT
lenses. Cosina’s two MFT prime lenses (offered
under the Voigtländer brand) are rather more
exotic and offer a huge maximum aperture of
f0.95 at prices starting at US$1,200. 

The lenses manufactured by Olympus and
Panasonic cover the market segment
between these two extremes. The Panasonic
Lumix G 20mm f/1.7 ASPH and Leica 
DG Summilux 25mm f/1.4 ASPH are two
bright classic focal length lenses with 
built-in aspherical elements that ensure
high-contrast results. Olympus has not yet
entered this segment of the market but has
some aces up its sleeve with the solid
M.Zuiko Digital 45mm f/1.8 portrait lens and
the interesting M.Zuiko Digital 12mm f/2.0
medium wide-angle. 

Other unusual lenses include the
M.Zuiko Digital ED 75mm f/1.8, with its 
all-metal body and engraved “Made in
Japan” emblem that give it a seriously
high-end look and feel. The Panasonic range
includes a 3D lens and an f/3.5 8mm (16mm
full-frame equivalent) fisheye. The cheapest
MFT lens currently available is the equally
unusual Olympus Body Cap Lens for US$49.
This fixed-focus, fixed aperture lens could
almost be classified as a toy, although its
15mm f/8.0 specifications and extremely
unobtrousive 9mm depth make it an
interesting alternative standard lens for
street photographers. 

There are also macro-equipped primes
on offer. One of the best of the current crop
is the Panasonic Leica DG Macro-Elmarit
45mm f/2.8, an excellent lens capable of
capturing reproduction ratios of up to 1:1 
at subject distances as close as 15 cm 
(6 inches). Olympus recently introduced the
M.Zuiko Digital ED 60mm f/2.8 Macro, which
is also capable of 1:1 reproduction and has a
close focus distance of 19 cm (7½ inches).
Both lenses have built-in focus range
limitation – the Leica offers a setting from
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The M.Zuiko Digital ED 60mm f/2.8 is a fixed
focal length lens with macro capabilities

Panasonic

3D Lumix G 12.5mm f/12 Lumix G 14mm f/2.5 ASPH Lumix G 20mm f/1.7 ASPH Leica DG Summilux 25mm
f/1.4 ASPH

Leica DG Macro-Elmarit 45mm
f/2.8 ASPH MEGA O.I.S.

Lumix G Fisheye 8mm f/3.5 

www.panasonic.com

12.5 mm 14 mm 20 mm 25 mm 45 mm 8 mm
65 mm (16:9) 28 mm 40 mm 50 mm 90 mm 16 mm

f/12 f/2.5 f/1.7 f/1.4 f/2.8 f/3.5
f/12 f/22 f/16 f/16 f/22 f/22
fixed 7 7 7 7 7

4 / 3 groups 6 / 5 groups 7 / 5 groups 9 / 7 groups 14 / 10 groups 10 / 9 groups
37 degrees 75 degrees 57 degrees 47 degrees 27 degrees 180 degrees
0.6 m 0.18 m 0.2 m 0.3 m 0.15 m 0.10 m

0.02 x 0.10 x 0.13 x 0.11 x 1 x 0.2 x

n/a 46 mm 46 mm 46 mm 46 mm n/a
57.5 mm x 20.5 mm 55.5 mm x 20.5 mm 63 mm x 25.5 mm 63 mm x 54.5 mm 63 mm x 62.5 mm 60.7 mm x 51.7 mm
45 g 55 g 100 g 200 g 225 g 165 g 
65 299 350 499 720 600
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The Micro Four Thirds design has an
inherently shallow flange focal length that,
with the use of an appropriate adapter,
makes it theoretically possible to use just
about any full-frame lens with an MFT
camera body.

Olympus and Panasonic both sell various
adapters for Four Thirds lenses. These can
be quite expensive (US$150 and more), but
enable you to use all the automatic Four
Thirds lens functionality with an MFT
camera. 

Olympus also offers the MF-2 adapter
(US$165) for use with the OM series of
lenses, and Panasonic includes the
DMW-MA2M and DMW-MA3R adapters 
for Leica M and R series lenses (US$160) 
in its range. These enable you to use the
viewfinder magnifier function to focus
manually.

Novoflex offers an extremely wide range of
adapters, including models for Canon FD,
Exakta 66, Hasselblad 6x6, Leica M and R,
M39 and M42 screw mounts, Mamiya 645,
Minolta AF, Sony Alpha, Minolta MD,
Nikon, Pentax 6x7, Pentax K and T2. The
possibilities are virtually endless, and
prices start from around US$120. 

There are also many no-name adapters
available online for as little as US$25,
although you need to take care when
using cheap gear with your favorite (and
often irreplaceable) lenses. Many photo
dealers offer good value own-brand
adapters in their online stores. 

Using Lens Adapters

MICRO FOUR THIRDS LENS OVERVIEW
Lens Type Fixed Focal Length

Manufacturer Sigma Voigtlaender Tokina

Image

Model 19 mm f/2.8 EX DN 30 mm f/2.8 EX DN 17.5 mm f/0.95 Nokton 25 mm f/0.95 Nokton Tokina 300 mm f/6.3 Reflex Macro

URL www.sigmaphoto.com www.voigtlaender.com www.tokinalens.com

Focal Length
Absolute 19 mm 30 mm 17.5 mm 25 mm 300 mm

Full-frame 
equivalent

38 mm 60 mm 35 mm 50 mm 600 mm

Aperture
Maximum f/2.8 f/2.8 f/0.95 f/0.95 f/6.3  n/a

Minimum f/22 f/22 f/16 f/16 f/6.3

No. of blades 7 7 10 10 n/a

Construction
Elements 8 / 6 groups 7 / 5 groups 13 / 9 groups 11 / 8 groups 13 / 11 groups

Angle of view 59.3 degrees 39.6 degrees 64.6 degrees 47.3 degrees 4.8 degrees

Minimum focus 
distance

0.2 m 0.3 m 0.15 m 0.17 m 0.8 m

Maximum 
magnification

0.13 x 0.12 x 0.23 x 0.3 x 0.5 x

Dimensions
Filter thread 46 mm 46 mm 58 mm 52 mm 55 mm   

Breadth x Length 60.6 mm x 45.7 mm 60.6 mm x 38.6 mm 63.4 mm x 80.0 mm 58.4 mm x 70 mm 55 mm x 66 mm

Weight 140 g 135 g 540 g 410 g 298 g

Street price (US$) 200 200 1,300 1,200 370
1 Only as part of a kit with Lumix G3/2/G10/GF2/3/GH2            2 Not yet available at the time of going to press                n/a = not applicable

This adapter makes it
possible to mount Leica M
series lenses on Micro Four
Thirds camera bodiesIm
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50 cm to infinity, while the Olympus offers a
choice of ranges that cover 19-40 cm, 19 cm
to infinity or 40 cm to infinity. Prices for this
type of lens start at around US$500. At the
lower end of the price range, MFT
enthusiasts have to reckon with spending at
least US$200 for a usable prime lens, while
DSLR users are still spoiled for choice, with
good quality primes starting at around
US$90. 

Limited Choice

The Micro Four Thirds system is highly
developed in comparison with other
mirrorless systems. The high-end Olympus
OM-D range and Panasonic’s Lumix DMC-GH3
are weatherpoof and offer robust lenses 
to match. In Olympus’ case, these are the
12-50mm zoom and the 60mm macro, while
both Panasonic f/2.8 zooms are
weather-beaters. 

However, weatherproof cameras and
lenses are well established in the DSLR world
and are correspondingly cheaper to buy. 

As far as super-telephoto lenses are
concerned, the only current MFT offering is
the Tokina 300mm f/6.3, and MFT macro
photographers, too, have a relatively limited
choice of options. 

The other side of this particular coin is
represented by a wide range of MFT screw-on
accessory lenses that include fisheye,
wide-angle, telephoto and macro converters.
Original converters by Panasonic and
Olympus cost US$100-150, but third-party
accessory lenses can be significantly cheaper.
However, compatibility is not universal, so
make sure that the converter you are
considering works with your particular lens
before making a purchase. 

More to Come

The range of available lenses is constantly
expanding  and new manufacturers are
joining the race all the time. At the 2012
Photokina trade show, Schneider-Kreuznach
announced three new lenses that are due to
hit the market in 2013. These are the

Super-Angulon 14mm f/2.8 wide-angle, the
Xenon 30mm f/1.4 standard lens and the
60mm f/2.4 Makro-Symmar. All offer ‘Made in
Germany’ build quality and, although the
prices for these high-end optics have not yet
been officially announced, our enquiries have
revealed a guide price of approximately
US$1,500 for the 14mm. 

Although Carl Zeiss is a member of the
MFT consortium, it has yet to release any 
MFT lenses, and its stated intention is to
concentrate on producing APS-C lenses for
the Sony E-mount and the Fujifilm X-mount
for the time being. Olympus has already
pre-announced a 17mm f/1.8 and Panasonic
is sure to come up with more bright telephoto
models in the near future.  

It is, of course, difficult to predict exactly
where the MFT market is headed, but as 
long as MFT cameras continue to gain in
popularity, an increasingly large range of
lenses is sure to follow. Industry observers
are predicting increasing MFT sales and
market growth of 40 percent for the coming
year. 
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Zooms

Olympus

M.Zuiko Digital ED 9-18mm 
f/4.0-5.6

M.Zuiko Digital ED 12-50mm 
f/3.5-6.3 EZ

M.Zuiko Digital 14-42mm 
f/3.5-5.6 II R

M.Zuiko Digital ED 14-150mm 
f/4.0-5.6

M.Zuiko Digital ED 40-150mm 
f/4.0-5.6 R

M.Zuiko Digital ED 75-300mm 
f/4.8-6.7 

www.olympus.com

9-18 mm 12-50 mm 14-42 mm 14-150 mm 40-150 mm 75-300 mm 

18-36 mm 24-100 mm 28-84 mm 28-300 mm 80-300 mm 150-600 mm

f/4 (wide-angle); f/5.6 (telephoto) f/3.5 (wide-angle); f/6.3
(telephoto) 

f/3.5 (wide-angle); f/5.6
(telephoto)

f/4.0 (wide-angle); f/5.6 (telephoto) f/4.0 (wide-angle); f/5.6 (telephoto) f/4.8 (wide-angle); f/6.7 (telephoto) 

f/22 f/22 f/22 f/22 f/22 f/22

7 5 7 7 7 7

12 / 8 groups 10 / 9 groups 8 / 7 groups 15 / 11 groups 13 / 10 groups 18 / 13 groups 

100-62 degrees 84-24 degrees 75-29 degrees 75-8.2 degrees 30-8.2 degrees 16-4.1 degrees

0.25 m 0.20 m 0.25 m 0.5 m 0.9 m 0.9 m

0.1 x 0.36 x 0.19 x 0.24 x 0.16 x 0.18 x

52 mm 52 mm 37 mm 58 mm 58 mm 58 mm

56.5 mm x 49.5 mm 57 mm x 83 mm 56.5 mm x 50 mm 63.5 mm x 83 mm 63.5 mm x 83 mm 70 mm x 116 mm

155 g 212 g 113 g 280 g 190 g 430 g

700 500 300 600 300 900
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Take a Chance on Less Well-known Brands 

MICRO FOUR THIRDS LENS OVERVIEW
Lens Type Zooms
Manufacturer Panasonic
Image

Model Lumix G Vario 7-14mm f/4.0 ASPH LumixG X Vario 12-35mm 
f/2.8 ASPH 

Lumix G Vario 14-42mm 
f/3.5-5.6 ASPH MEGA O.I.S.

Lumix G X Vario PZ 14-42mm 
f/3.5-5.6 ASPH Power OIS

LumixG Vario 14-45mm 
f/3.5-5.6 ASPH MEGA O.I.S.

URL www.panasonic.com
Focal Length
Absolute 7-14 mm 12-35 mm 14-42 mm 14-42 mm 14-45 mm
Full-frame equivalent 14-28 mm 24-70 mm 28-84 mm 28-84 mm 28-90 mm
Aperture
Maximum f/4 f/2.8 f/3.5 (wide-angle); f/5.6 (telephoto) f/3.5 (wide-angle); f/5.6 (telephoto) f/3.5 (wide-angle); f/5.6 (telephoto) 

Minimum f/22 f/22 f/22 f/22 f/22
No. of blades 7 7 7 7 7
Construction
Elements 16 / 12 groups 14 / 9 groups 12 / 9 groups 9 / 8 groups 12 / 9 groups

Angle of view 114-75 degrees 84-34 degrees 75-29 degrees 75-29 degrees 75-8.2 degrees
Minimum focus 
distance

0.25 m 0.25 m 0.3 m 0.2 m 0.3 m

Maximum 
magnification

0.08 x 0.17 x 0.16 x 0.17 x 0.17 x

Dimensions
Filter thread n/a 58 mm 52 mm 37 mm 52 mm
Breadth x Length 75 mm x 83.1 mm 67.6 mm x 73.8 mm 60.6 mm x 63.6 mm 61 mm x 26.8 mm 63 mm x 60 mm
Weight 300 g 305 g 165 g 95 g 195 g
Street price (US$) 900 1,300 150 350 270
1 Only as part of a kit with Lumix G3/2/G10/GF2/3/GH2            2 Not yet available at the time of going to press                n/a = not applicable

The lenses detailed in our table are by no
means the only ones around, and there are
many more available from manufacturers
who haven’t actually joined the official 

Micro Four Thirds consortium. It is well 
worth looking beyond the standard names,
especially when it comes to unusual
applications and situations. SLR Magic, for

example, offers everything from a US$80
‘Toy Lens’ to a bright, high-end 50mm
‘Hyperprime’ lens for around US$1,000.

Samyang, too, offers a range of good-quality
lenses that include a 7.5mm f/3.5 fisheye for
about US$300. We were given one to test and
found the results to be extremely good. There
were no significant handling bugs, and only
the Panasonic G5 required us to use the
camera’s firmware-based ‘Shoot w/o Lens’
setting to get the fisheye to work. Focusing
and aperture settings are manual, and the
camera sets the appropriate exposure time
automatically. 

Always read the manufacturer’s specifications
carefully before making a purchase, as some

Photos of our test subject shot
using the Samyang fisheye are
sharp and highly detailed 
ISO 200 | Tripod-mounted | 7.5mm | f8 | 1/160s



Overall, the Micro Four Thirds standard has
a strong base with a wide range of camera
bodies and lenses in a variety of price segments.
On the buyer side, Micro Four Thirds offers
guaranteed compatibility between just about
every camera/lens combination you care to try
out, and 2011 statistics confirm the success of
the format, with more than half of the system
cameras sold coming from the MFT camp.

The financial scandals that have recently
plagued Olympus may have tarnished MFT’s

public image, but the recent announcement
that Sony (hitherto one of Olympus’ strongest
competitors) has purchased a minority stake
in Olympus is sure to calm the market. The
two companies are now cooperating more
closely, and Olympus will in future produce
lenses and mirrors for Sony, while Sony will be
producing image sensors for Olympus.
Meanwhile, Sony is happy to let Olympus
continue developing the OM-D and Pen
products independently. 
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The Samyang fisheye is well built and,
unlike some of its competitors, doesn’t
require the use of an adapter

Lumix G Vario HD 14-140mm 
f/4.0-5.8 ASPH MEGA O.I.S.

Lumix G Vario 35-100mm 
f/2.8

Lumix G Vario 45-150mm ASPH
f/4.0-5.6 ASPH

Lumix G X Vario PZ 45-175mm 
f/4.0-5.6 O.I.S.

Lumix G Vario 45-200mm f/4.0–5.6
MEGA O.I.S.

Lumix G Vario 100-300 mm O.I.S.

14-140 mm 35-100 mm 45-150 mm 45-175 mm 45-200 mm 100-300 mm 
28-280 mm 70-200 mm 90-300 mm 90-350 mm 90-400 mm 200-600 mm 

f/4.0 (wide-angle); f/5.8 (telephoto) f/2.8 f/4 (wide-angle); f/5.6 (telephoto) f/4 (wide-angle); f/5.6 (telephoto) f/4 (wide-angle); f/5.6 (telephoto) f/4.0 (wide-angle); f/5.6 (telephoto) 

f/22 f/22 f/22 f/22 f/22 f/22
7 7 7 7 7 7

17 / 13 groups 18 / 13 groups 12 / 9 groups 14 / 10 groups 16 / 13 groups 17 / 12 groups 

75-8.8 degrees 34-12 degrees 27-8.2 degrees 27-7 degrees 27-6.2 degrees 12-4.1 degrees
0.5 m 0.85 m 0.9 m 0.9 m 1 m 1.5 m 

0.2 x 0.17 x 0.17 x 0.2 x 0.19 x 0.21 x

62 mm 58 mm 52 mm 46 mm 52 mm 67 mm 
70 mm x 84 mm 67.4 mm x 99.9 mm 62 mm x 73 mm 61.6 mm x 90 mm 70 mm x 100 mm 73.6 mm x 126 mm 
460 g 360 g 200 g 210 g 380 g 520 g 
620 1,500 2 300 370 230 500

lenses that are labeled as MFT-compatible
require an adapter that is often (but not
always) included with the lens. 

In addition to conventional lenses, many
online stores also offer great value pinhole
and shaped bokeh attachments for as little
as US$40. 

Schneider-Kreuznach has
joined the MFT fold, and

the Super-Angulon 14mm
f/2.8 is due for release in

the second half of 2013
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Micro Four Thirds Lens Test

Our studio test shot was set up to fill the 4:3
frame. The most telling details are outlined

in yellow, the line chart in the center was
used to determine overall resolution, the
chart at bottom right served to highlight 

any fall-off in edge/corner resolution 
and the shiny frame of the sieve at top left

revealed any fringing and color errors.

We chose the highly detailed façade 
of the Town Hall in Hanover as our 
outdoor test subject. 
We located the camera in front of the
building for our wide-angle test shots,
which meant that our test lenses had to
deal with backlight too. We inspected
center and edge details (outlined in yellow)
for 12mm, 14mm and 20mm shots. 

20mm

12-14mm
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We took our eight selected MFT lenses on a
trip to the town hall in Hanover to find out
how they perform when used in real-world
photographic situations.  

Our test field included four fixed focal
length lenses (from wide-angle to telephoto),
and four zooms. The zooms were mostly kit
lenses, but we also tested the high-end
Panasonic 12-35mm f/2.8 as a comparison. 

We captured all of our test shots using
tripod-mounted Panasonic Lumix DMC-G5
and Olympus OM-D E-M5 cameras, using a
two-second self-timer for all exposures. To
keep things as fair and comparable as
possible, we focused manually throughout
the test. 

Focusing wasn’t always easy. Although
both cameras have viewfinder and monitor
zoom functionality, details that were
apparently in focus didn’t always turn out
sharp in the images themselves. This behavior
was more evident in the G5 than the OM-D,
which generally delivered a clear, high-
contrast live view image. This is where the
difference in quality between the OM-D’s
OLED and the Panasonic’s LCD monitor
became particularly evident. Focusing our test
zooms was trickier than focusing the primes,
not least because most of the focusing rings
had too much play.

Because outdoor lighting conditions are
not always consistent, we also took a series of

indoor, lab-based shots to give us the greatest
possible range of test material. In addition, we
measured the basic characteristics of each
lens using precision lab tools. The results are
listed on the following pages.

We took test shots using both cameras for
the prime lenses, but only using the lens
manufacturer’s own camera for the zooms.
The details reproduced here have been
upsized to 200%, but all the test images are
included at their original size on this issue’s
free DVD.
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We photographed the back of the building to
test focal lengths of 30mm and longer, and
again analyzed center and edge details. We

photographed the same detail in the central
clock tower with each of our test lenses. All the
test shots are included on this issue’s free DVD. 

75mm

30-42mm

50mm
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M.ZUIKO DIGITAL ED 12MM F/2.0
Focal length (full-frame equivalent) 12 mm (24 mm)
Aperture range f/2.0-f/22
Test apertures wide open / f8
Resolution (center) 97.1%/ 96.2%
Resolution (corner) 81.7% / 88.7%
Chromatic aberration (in pixels) 1.95 / 1.1
Distortion (in percent) –0.33 / –0.33

M.Zuiko Digital 12mm f/2.0
This lens is extremely well built. The focus ring can be shifted to give you
quick access to distance and depth of field indicators, and manual focus is
quick and precise.
Image quality: Resolution is great in the center – even wide open – but
drops off (tolerably) towards the corners of the frame. Edge detail and
overall texture are clearer and more three-dimensional stopped down. On
the downside, the ‘12’ produces obvious chromatic aberrations.

OM-D E-M5 | wide open | f2

Lumix DMC-G5 | stopped down | f8

OM-D E-M5 | stopped down | f8

Lumix DMC-G5 | wide open | f2

ISO 200 | 12mm | f2 | 1/400s
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M.Zuiko Digital ED 12-50mm f/3.5–6.3 EZ
With its weatherproof body and macro capability, this is one of the most
versatile kit zooms available. Build quality is acceptable, but the plastic finish
gives it a rather cheap feel. The manual focus ring has too much play. 
Image quality: Resolution is good in the center and remains so right into the
corners of the frame. It produces its best results at its 25mm (normal) setting
and its worst at the far telephoto end of the range, where images lack contrast
and appear flatter. The lens produces obvious chromatic aberrations wide open
and stopped down. 

Normal | stopped down | f8

Wide-angle | wide open | f3.5

Wide-angle | stopped down | f8

Telephoto | wide open | f6.3

Telephoto | stopped down | f8

Normal | wide open | f5.1

M.ZUIKO DIGITAL ED 12-50MM F/3.5–6.3 EZ
Focal length (full-frame equivalent) 12-50 mm (24-100 mm)
Aperture range f/3.5-f/22
Test apertures wide open / f8
Resolution (center) 97.4% / 93.2%
Resolution (corner) 92.4% / 92.6%
Chromatic aberration (in pixels) 1.1 / 0.9
Distortion (in percent) 0.05 / 0.04
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Lumix G X Vario 12-35mm f/2.8 Asph.
With this lens, Panasonic fills a gap in the Olympus range. The 12-35mm is a
high-quality zoom with a constant maximum aperture of f2.8. This lens is
extremely well built and oozes quality. Its only drawback is the rubberized focus
ring, which is a real dust magnet. 
Image quality: Results are consistently good in all three focal length zones and
pleasingly sharp, even at maximum aperture. All images have a neutral, nicely
three-dimensional look. Edge detail is very good, especially in our outdoor test
shots. 

Normal | stopped down | f8

Wide-angle | wide open | f2.8

Wide-angle | stopped down | f8

Telephoto | wide open | f2.8

Telephoto | stopped down | f8

Normal | wide open | f2.8

LUMIX G X VARIO 12-35MM F/2.8 ASPH.
Focal length (full-frame equivalent) 12-35 mm (24-70 mm)
Aperture range f/2.8-f/22
Test apertures wide open / f8
Resolution (center) 90.7% / 90.9%
Resolution (corner) 76.9% / 82.8%
Chromatic aberration (in pixels) 0.28 / 0.12
Distortion (in percent) 0.09 / 0.08
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M.ZUIKO DIGITAL 14-42MM F/3.5-5.6 II R

M.Zuiko Digital 14-42mm f/3.5-5.6 II R
This is another of the Olympus kit lenses with a plastic body and bayonet,
making it very lightweight. The focus ring has very little play, which makes
manual focusing easy and precise.
Image quality: For a relatively cheap kit lens, this model produces very good
central resolution, although sharpness drops off noticeably toward the corners
of the frame. It delivered its weakest overall performance at the telephoto end,
with acceptable sharpness, but an obvious lack of contrast and weak detail
rendition, even at f8. Chromatic aberration is visible throughout the range. 

Normal | stopped down | f8

Wide-angle | wide open | f3.5

Wide-angle | stopped down | f8

Telephoto | wide open | f5.6

Telephoto | stopped down | f8

Normal | wide open | f4.4

Focal length (full-frame equivalent) 14-42 mm (28-84 mm)
Aperture range f/3.5-f/22
Test apertures wide open / f8
Resolution (center) 94.6% / 91.5%
Resolution (corner) 73.2% / 81.4%
Chromatic aberration (in pixels) 0.92 / 0.84
Distortion (in percent) 0.07 / 0.07
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Lumix G Vario 14-42mm f/3.5-5.6 Asph. O.I.S.
This is the standard kit lens sold with the G5 camera. Build quality is good, even
though the lens is made almost entirely of plastic.
Image quality: Here too, the telephoto end of the range is the weak point of
the lens. Central sharpness is otherwise good, with obvious weakness at the
edges of the frame at maximum aperture. Stopping down doesn’t improve
things very much. Images have a slightly rough overall look, with only fair detail
rendition. Depth and contrast are better at standard focal lengths, with less
obvious chromatic aberration than at wide-angle settings.

Normal | stopped down | f8

Wide-angle | wide open | f3.5

Wide-angle | stopped down | f8

Telephoto | wide open | f5.6

Telephoto | stopped down | f8

Normal | wide open | f4.7

LUMIX G VARIO 14-42MM F/3.5-5.6 ASPH. O.I.S.
Focal length (full-frame equivalent) 14-42 mm (28-84 mm)
Aperture range f/3.5-f/22
Test apertures wide open / f8
Resolution (center) 87.9% / 90.5%
Resolution (corner) 79.8% / 87.1%
Chromatic aberration (in pixels) 0.79 / 0.52
Distortion (in percent) –0.17 / –0.17
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OM-D E-M5 | wide open | f1.7

Lumix DMC-G5 | stopped down | f8

This was one of the first Lumix prime lenses to appear on the market. Build and
image quality are excellent. 
Image quality: Central sharpness is very good wide open and excellent
stopped down. There is some visible fringing at f1.7, particularly in outdoor
shots, but the effects are less obvious at smaller apertures. There is almost no
detectable distortion and results are consistently sharp and three-dimensional.

Lumix G 20mm f/1.7 Aspheric

ISO 200 | 20mm | f1.8 | 1/500s

Lumix DMC-G5 | wide open | f1.7

OM-D E-M5 | stopped down | f8

LUMIX G 20MM F/1.7 ASPHERIC
Focal length (full-frame equivalent) 20 mm (40 mm)
Aperture range f/1.7-f/16
Test apertures wide open / f8
Resolution (center) 84.2% / 90.3%
Resolution (corner) 74.8% / 82.9%
Chromatic aberration (in pixels) 0.63 / 0.4
Distortion (in percent) –0.05 / –0.05
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SIGMA 30MM F/2.8 EX DN
Focal length (full-frame equivalent) 30 mm (60 mm)
Aperture range f/2.8-f/22
Test apertures wide open / f8
Resolution (center) 93.9% / 95%
Resolution (corner) 70.8% / 90.7%
Chromatic aberration (in pixels) 1.42 / 1.47
Distortion (in percent) -0.36 / -0.36

Sigma 30mm f/2.8 EX DN
This is a reasonably bright, solidly built prime. 
Image quality: Results are of consistently high quality across the board,
with good central sharpness at maximum aperture. Edge definition is,
however, less precise wide open. The chromatic aberration values we
measured are quite high, although in visual tests, color errors caused only
minor fall-off in the quality of fine details. In general, the results are clear
and well balanced. 

OM-D E-M5| wide open | f2.8

Lumix DMC-G5| stopped down | f8

OM-D E-M5 | stopped down | f8

Lumix DMC-G5 | wide open | f2.8

ISO 200 | 30mm | f2.8 | 1/250s
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OM-D E-M5 | wide open | f1.8

Lumix DMC-G5 | stopped down | f8

A lens with a full-frame equivalent focal length of 150 mm is not necessarily a
first-choice prime lens, but this particular model deserves a longer look. It is
very well built and produces consistently high-quality results. 
Image quality: Fine textures are well defined, even wide open, and our test
images have a nice vivid look. Sharpness is consistently excellent and the
wonderful detail contrast at smaller apertures gives the results a feeling of great
depth.  

M.Zuiko Digital ED 75mm f/1.8

ISO 200 | 75mm | f1.8 | 1/640s

Lumix DMC-G5 | wide open | f1.8

OM-D E-M5 | stopped down | f8

M.ZUIKO DIGITAL ED 75MM F/1.8
Focal length (full-frame equivalent) 75 mm (150 mm)
Aperture range f/1.8-f/22
Test apertures wide open / f8
Resolution (center) 99.6% / 95.8%
Resolution (corner) 92.6%/ 100%
Chromatic aberration (in pixels) 0.28 / 0.13
Distortion (in percent) 0.1 / 0.1



OM-D vs. G5: 
The Odd Couple

We captured our test shots using two of each
type of camera. The Olympus OM-D E-M5 and
the Panasonic Lumix DMC-G5 are very
different beasts that produce quite different
results. Our controlled test showed just how
different the basic concepts behind the two
cameras are.

The Olympus credo is clearly based on
achieving maximum image sharpness – an
approach that yields obvious dividends in 
the lab. In contrast,  Panasonic applies much
more lenient in-camera image processing,
producing softer-looking indoor test images.
It is important to take this difference into
account when judging the test results.
However, this doesn’t mean that the Olympus
camera is ‘better’ than the Panasonic, or that
the lenses tested on the G5 were at any kind
of disadvantage. In the end, the viewer has to
decide which is more pleasing: the Olympus’
sharp details or the Panasonic’s softer, more
realistic-looking results. 

Accessories

The accessories supplied with a lens can make
a difference when it comes to deciding which
to buy. For example, the 30mm Sigma lens we
tested is supplied in a padded, zip-fastened
case, whereas Panasonic supplies just a soft
drawstring bag. 

Both Panasonic zooms are supplied with a
sunshade, making a separate purchase
unnecessary. Olympus charges extra for
sunshades, which we think should always be

included, especially with more expensive
lenses. 

Fixed Focal Lengths

Established camera manufacturers and
third-party suppliers offer a complete range of
consistently high-quality fixed focal length
lenses for the Micro Four Thirds system. 
The lenses we tested underscored the 
ever-increasing quality in this segment. For
example, the Olympus M.Zuiko Digital 
ED 75mm f/1.8 is an exceptional lens with 
no discernible weaknesses. This is a
ground-breaking piece of kit that definitely
raises the bar for other manufacturers. 

Generally speaking, all the prime lenses
we tested delivered good or very good
central sharpness, even at maximum
aperture, although some showed obvious
quality fall-off toward the edges of the frame.
Chromatic aberrations were generally more
of an issue at wide apertures, but we
achieved consistently satisfactory contrast
and detail rendition at all apertures between
f1.7 and f2.8. 

In this segment, you can get a
good-quality, usable lens for around US$200. 

Zooms

Overall, we were very impressed with our test
zooms. Even the kit lenses delivered
high-quality results, and show that MFT
beginners aren’t forced to make sacrifices or
squander their camera bodies’ qualities right
from the start. However, all of the zooms we
tested showed obvious image quality fall-off

at the edges of the frame and visible fringing.
There were quite a lot of weak, low-contrast
examples among our test shots, especially at
telephoto settings.  

Currently, photography enthusiasts have
little choice in the field of MFT zooms, although
Panasonic’s 12-35mm lens is a sign that things
are beginning to improve. This particular lens
is more balanced than the others we tested
and produced consistently high contrast and
highly detailed results across the entire range
of focal lengths. A lens such as this is capable
of adding value to cheaper cameras. The
drawbacks still inherent in MFT zoom lenses
are underscored by our – admittedly unfair –
comparison with the full-frame
zoom-equipped Nikon D600 (see below). 

The Bottom Line

Above all, our test proves that experienced
photographers can achieve high-quality
results using MFT equipment. The MFT system
is particularly appealing to anyone who
spends a lot of time on the road and needs to
save space and weight. None of our test lenses
really disappointed us, and all delivered
results that were worthy of their prices. 

Lenses such as the M.Zuiko Digital ED
75mm f/1.8 and the Lumix G X Vario 12-35mm
f/2.8 show the enormous potential of the
format. However, if Micro Four Thirds is to
establish itself as a true alternative to
mid-range and high-end DSLR systems,
manufacturers have no choice but to get their
zoom act together. One final word: it has to be
said that we never once missed having a
larger sensor during the entire test. (ssi)
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Conclusions 

OM-D E-M5 | ISO 200 | tripod-mounted | 25mm | f8 | 1/15s | magnified Nikon D600 | ISO 100 | tripod-mounted | 50mm | f8 | 1/10s

The difference in quality is not particularly evident at first glance but, on closer inspection, the 
D600’s superior resolution is obvious – the images look more natural and have greater depth c







Michael Jordan

Small Flash,
Big Effect

Even if a standard accessory flash isn’t powerful enough to completely
illuminate a large subject or a roomy interior in a single shot, you still
don’t have to invest in expensive lighting gear to produce well-lit images.
Using conventional flash and a couple of simple software workarounds,
you too can shoot big-time flash photos.



Many digital cameras have built-in flash
units that are not particularly powerful

and that switch on automatically when they
are needed. For subjects that are close
enough to the camera, such systems produce
photos that are – technically at least –
correctly exposed, with all the relevant
elements showing sufficient detail. There are
no washed-out highlights or swamped
shadows.

Unfortunately, most built-in flashes have a
guide number (GN) of 14 or less, making it
impossible to adequately light large or distant
subjects. The guide number of a flash is
calculated as follows:

GNˇ=ˇApertureˇxˇDistance 

At an aperture of f4.5 and with a guide
number of 14, the maximum usable subject
distance is about three meters. If you want to
use a smaller aperture or capture a more
distant subject, you will need more flash
power. The next obvious choice is a dedicated
accessory flash that receives its exposure
information (ISO setting, aperture, exposure
time, focal length, focus setting etc.) directly
from the camera’s electronics via the contacts
in the hot shoe. Dedicated flash is just as

automatic as built-in flash, but with a larger
guide number and more power. 

An accessory flash is usually attached to
the camera’s hot shoe with its head pointed
either directly at the subject or reflected from
a wall, a ceiling or a portable reflector. 

The correct exposure settings for an
accessory flash are determined by the
camera’s automatic flash metering system
(called ETTL-II in Canon DSLRs and iTTL in
Nikon cameras). These systems are effective
and simple to use, producing consistently lit
photos. The only problem is that the position
of the flash directly above the lens often
produces uninteresting, ‘flat’ looking images
that lack depth. Additionally, objects in the
foreground tend to get lit more brightly than
the subject itself. A reflector used to light the
subject indirectly can reduce this effect but
doesn’t cancel it out altogether. The other
major disadvantage of using a reflector is that
it diffuses the light from the flash, thus
‘swallowing’ a large part of the illumination
power produced by the flash and extending
the time required for the flash battery to
recycle.

Even if you use reflectors, bounce heads or
other light-shaping tools to soften or shape

the light emanating from your flash, the
results will still look relatively ‘flat’. This type
of technique can be sufficient, and even
flattering, when used to shoot portraits, but
quickly runs out of steam when it comes to
lighting large objects. 

Targeted Lighting

You can achieve much more exciting effects if
you target your light. The easiest way to do tis
is to use a long flash cable to free up the flash
unit from its fixed position on top of the
camera. This is where things start to get really
interesting. If you are shooting in the dark, you
can now select your camera’s Bulb (B) long
exposure setting and trigger multiple flashes
manually while the shutter is open. This way,
you can use a single flash unit to produce light
from multiple directions in a single image.
This is a reliable method as long as all the
flashes light the subject in a similar way and
don’t shine directly into the lens. If your first
attempt doesn’t produce the effect you were
looking for, you will simply have to repeat the
shot until everything works out as you
planned. 

Flash Workshop | Lighting Large Subjects

This shot of a digger shows
how effective a single flash
unit can be, even when
used with extremely large
subjects



If you don’t have the opportunity to shoot
outdoors in the dark or in a darkened studio,
there is an alternative technique you can use
to achieve similar results. All you have to do is
shoot multiple images with the flash in a
different position in each and merge the
resulting sequence into a single image using
a computer.

This is the technique we used to shoot the
title photo for this article. For this particular
shot, we used a single flash to light all the
parts of the trike that were facing the camera.
The individual source images were all shot
from the same viewpoint using the same
perspective, and we used a tripod to ensure
that they were identically framed, making
merging a relatively simple task. 

Using this technique, you can use the
ambient light to illuminate the surroundings
and combine it with multiple flash images of
individual parts of the subject. It is important
to get the proportion of natural to flash light
just right. If you want the background to
appear brightly lit, you have to meter it as
you would a normal shot and then set up
your flash to fit in with the exposure values
that this entails. If, however, you want 
to produce a final image with a dark
background, like the one in our trike shot,
you have to deliberately underexpose your
base shot (see the illustrations above). In this
case, the camera’s meter read 1/100 s at f10
and ISO 100. We captured the flash shots at
ISO 100 too, using exposure settings of
1/200 s and f20. This means that we exposed
the background three stops darker than we
would normally – an effect that was
exacerbated by the fact that the late
afternoon sun was fading while we were
shooting.

As well as a high-quality tripod, you should
also use a remote shutter release for this type
of shot if you want to be sure of preventing
camera shake. Because the flash is released
manually, you don’t necessarily need a
dedicated unit built for use with your
particular camera, and a simple device with a
built-in flash release socket is perfectly
adequate. To give ourselves sufficient room
for maneuver, we used two 10-meter flash
cables connected in series to capture the trike
shot. This extra length even enabled us to take
an additional backlit shot as an accent.  If you
do a lot of remote flash photography, you
might consider investing in a wireless flash
trigger of some sort.

An assistant is virtually indispensable when
you are shooting large subjects, and should
ideally be someone who understands
photography and shares your enthusiasm for
this kind of shoot. Their job is to position and
trigger the flash shot by shot – a role that
requires imagination and stamina if the
finished sequence is to turn out just right.

Preparing for a Shoot

The overall effect of the finished image
depends very much on the nature of the
subject’s  surroundings. In our shot of the
trike, we deliberately used the horizon as a
stylistic element to give the image depth and
prevent the background from appearing like
an indeterminate dark surface. Once you have
found the right location and the correct
position for the subject, make sure your
camera is fixed firmly to its tripod so that 
the resulting images remain perfectly
superimposable. 

Be sure to leave plenty of space around the
subject when framing an image like this, as
the merged image will look very different
from the base image shot in natural light. You
will need plenty of leeway during processing. 

The next step is to meter your exposure.
Because we are using flash as the main light,
you should set the exposure time to 1/60 or
1/125 s, or to your camera’s own flash sync
speed if it is different. 

If you have access to one, a flash meter is
the best tool to use to determine the right
aperture and ISO settings. Start by selecting
an aperture that brings the entire subject
within the field of focus of your lens and set
the flash to full power with its zoom reflector
set to 50 mm. Now take a test shot with the
flash positioned about one meter away from
the subject. If you are shooting a subject that
is larger than our trike, increase the distance
between the flash and the subject and/or
adjust the zoom reflector to its 35 or 28mm
setting.

You can now use an exposure meter to
calculate the correct combination of ISO and
aperture settings. If you don’t have a meter to
hand, the camera’s histogram will help you
find the right settings. Make sure that you
don’t overexpose the image (i.e., with the
histogram peaking at the right-hand end of
the scale). If your flash gives off too much
light, you can increase the distance between
the flash and the subject, reduce flash power,
select a lower ISO value or use a smaller
aperture. 

If your test shot ends up underexposed,
the best solution is to move the flash closer to
the subject. Reducing the subject distance
does, however, mean that you will have to
capture a larger number of source images to
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The low horizon gives this trike a powerful look. The shot on the left was taken at ISO100 using 1/100s at f10. The shot
on the right is three stops darker. We used this one as the basis for our trial flashes, which helped us to find just the right
lighting angle and distance.



cover the entire subject. If all else fails, you can
always increase the ISO value, although doing
so usually increases image noise. If you set
your camera to record images in JPEG format,
processing will be much faster, although
using RAW will provide higher-quality results. 

The Shoot

Once you have made all the necessary
preparations, you can start to shoot in earnest.
The photographer’s job is not only to press
the shutter release but, more importantly, to
give the person positioning the flash clear
instructions. To ensure that the final flash

effect is as evenly balanced as possible, make
sure that each individual flash is fired at the
same distance from the subject as you used
when calculating your other exposure
settings.

It helps to work systematically, shooting
either in rows from left to right or vertical
strips from top to bottom if you want to be
certain of catching all the relevant details.
Check your shots at regular intervals during
the shoot to make sure that you haven’t
missed any important details and that all of
your shots are evenly lit. If you are not sure, it
is always better to shoot a couple of extra
images than to end up missing a crucial detail. 

The photographer should stick behind the
camera and check each shot immediately
after shooting in order to maintain the flow
and give the rest of the team appropriate
directions. 

We chose a low camera position for 
our trike shot to make the subject look 
more powerful, and the photographer used 
a camping mat to make shooting as
comfortable as possible. We were all
concentrating hard during the shoot and were
surprised to find that we had captured more
than 100 images by the time we were finished.
Setup and shooting took about three hours in
total.
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The low camera position underscored the
powerful appearance of the trike



Image Processing

The processing stage of the project involves
turning this enormous stack of photos into a
single, perfectly-lit image. Photoshop is a good
choice of software for this type of job, as it is
capable of working with layers and can also
record Actions to automate sets of processing
steps that are repeated regularly. 

Load your images using the File > Scripts
> Load Files into Stack command. The dialog
that then appears is called Load Layers, which
is a good description of what this function
actually does. Clicking ‘OK’ loads the files you
select (or the entire contents of a folder) into
a single file made up of a stack of layers. The
tool works with both JPEG and RAW files. 

If you are not sure whether all your source
images are precisely aligned, check the
Attempt to Automatically Align Source Images
option in the Load Layers dialog. This option
is extremely effective, but appreciably
lengthens the time it takes to load a set of
images, so only use it if you really have to. 

If you shoot your source images in RAW
format, it is worth taking the trouble to apply
the same preprocessing settings to all of them
using a RAW converter. If you are using a
wide-angle lens, you will probably need to
remove some chromatic aberrations from
your images, and it is always a good idea to
check that the colors match when you are
merging a series of photos. Whichever
adjustments you apply, be sure to use the
same settings for every shot so that the
finished image looks consistent. 

Working with an Image Stack

Once you have loaded your prepared images
as a stack, they will appear in the Photoshop
interface as a single file with multiple layers.
Personally, I feel a little out of my comfort
zone when I see a file with 100 layers, so for
this project we separated our source images
into four sets of 25 shots that we turned into
four composite source images before
performing the final merge. 

The results will look the same, no matter
how many groups of images you decide to use.
The process involves merging the illuminated
parts of each source image (i.e., each layer) to
form a single evenly-lit ‘master’ image. The best
way to approach this task is using either a white
mask in which you ‘paint over’ the parts of the
image you don’t need or a black mask in which
you ‘paint in’ the required details.

To minimize the effort involved in
processing so many layers, it is worth
recording recurring steps in a Photoshop
Action. To record an Action, activate the
uppermost layer and open the Actions panel
(Window > Actions). Click the menu icon at
the top right-hand corner of the panel, select
New Action and add an appropriate name in
the dialog that follows. The dialog also
enables you to assign your new action to one
of the function keys (F1 - F12), with or without
additional use of the Shift or Command keys.
Once you click the ‘Record’ button, every
processing step you perform will be recorded
in your new Action.
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Layer masks – in our case set to Lighten blending
mode – are used to hide unwanted details in the
individual layers

Photoshop Actions can
be used to automate
sequences of
processing steps that
you use frequently.
This is a really useful
tool when you are
working with large
numbers of layers.

The Load Layers
dialog enables
you to load
large numbers
of source
images into a
layer stack and
align them
automatically
if necessary
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Use a black brush in the active layer mask to
mask the details you wish to hide 

Each ‘quarter’ image
of our trike was

constructed using 25
separate source

images. To prevent
the blurred clouds in

the first three
images from

appearing in the
final montage, we
used only the sky
from the last one.

We flattened each of our four 25-layer stacks
before merging them to make the final image 
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Click the mask icon to add a white mask to
each layer (see the illustration on the previous
page), which you can then use to mask
unwanted details such as flash cables,
assistants or blurred clouds using a black
brush.

To allow you to see the remaining details
clearly, set the layer mask blending mode to
Lighten using either the drop-down menu at
the top left-hand corner of the Layers panel or
the Shift+Alt/Option+G keystroke. 

Lighten mode compares the data in the
two immediately adjacent layers and uses the
lighter of the two. In our case, the background
is virtually identical in every shot, but the
foreground varies slightly due to the differing
intensity of the flash reflected from the
various parts of the subject. This process
merges each pair of photos into a single
image. The final step in the Action involves
switching to the next layer down using the
Alt+Comma keystroke. Now click the ‘Stop’
button in the Actions panel to finish
recording.

You can now use the Action you have just
recorded on each layer in turn (except for the
background). Now press the Alt key and click
the eye icon next to the bottom layer to hide
all the layers above it. Clicking the box next to

the second layer from the bottom makes it
visible and makes the subject look brighter,
making it easier to locate and mask any
elements that you don’t want in the final
image. 

To mask details, use the Brush tool and
select black as its color. Click the mask icon in
the Layers panel to activate the layer mask
you wish to work on – the black corners
surrounding the mask icon in the Layers panel
indicate the active mask. Now paint the details
you wish to hide black. If you make a mistake
or accidentally mask a detail that you wish to
preserve, simply switch the brush color to
white and re-paint it. Repeat the process for
each layer.

Once you are done, save your processed
multi-layer image as a PSD or TIFF file and
flatten the result using the Layer > Flatten
Image command. Give the new file an
appropriate name (in our example,
‘Part_1_of_4_flattened’). We then repeated
the steps described for each of the other three
‘quarter’ images.

In our case, all that remained was to merge
the four partial images into one using the
same steps as before. In other words, we
loaded them into a stack and set the upper
three to Lighten blending mode before

painting out any unwanted details and
flattening the result.

Any discrepancies in brightness between
the layers can be ironed out by adjusting their
opacity settings. For our final montage, we
used the sky from just one of the source
images to keep it looking balanced and to
remove the clouds that were present in the
other shots. To use a separate sky, simply load
the image with the sky you wish to use on top
of the image stack, set its blending mode to
Normal and paint out the parts of the image
you don’t need in its layer mask.

To finish up, we flattened the complete
image and tweaked the contrast using the
Curves tool (Image > Adjustments > Curves).
We then sharpened the entire image a little
before outputting it.

Other Uses

This technique can be used to illuminate any
object that is within range of the flash cables
you have to hand. It is not limited to
photographing large objects – small subjects
like toys, or even the interiors of buildings can
be effectively and creatively lit using this
method too. (pen) c

We adjusted the opacity of our ‘quarter’
images to make sure they produced a
consistent-looking final montage

Four into one! To give the merged image a final polish, we tweaked the
contrast slightly and sharpened the entire frame for output
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Photographing

Children
Children make wonderful photographic models. Maybe you are one of those
dedicated photographers who puts great effort into photographing a variety of
themes and successfully captures the most beautiful subjects, but when it comes
to your own children, you’ve only ever taken snapshots. The ideas and tips on the
next few pages will give you some extra incentive and pave the way for you to
take extraordinary photos of children. And, using a simple underlying concept,
you can turn your photos of children into wonderful photo sequences.
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Telling a Story in Pictures                                   64
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Good photos of children should seem
natural, capture the viewer's eye and,

ideally, express something of the personality
of the child being photographed. Every child
is unique; we are most acutely aware of this
with our own children, and want to portray
them that way. So it’s not about ‘pointing the
camera at the child now and then’ but rather
working carefully, with commitment. It’s time
to say goodbye to posed pictures of children,
which are usually an unpleasant trial for all
involved instead of a triumph. The daily
routine is full of photo opportunities: relaxed
moments of contemplation, quarrels, or just
munching on a snack between times.

Capturing Everyday Life

How about photographing short sequences
from day-to-day family life, including
playtime, using the multitude of topics 
that already surround you. Be a step ahead,
camera in hand, and you'll be halfway to
documenting a little home story, perhaps for
later inclusion in a photo book.

If you allow time in your life for taking
photos of your children, you’ll be able to set
things up a little, tidying up a bit and getting
the surroundings right in advance. Make sure
that the patterns and colors on your children's
clothes aren’t too loud – unless of course your

children are old enough to dress themselves
and choose their own clothes, in which case
wacky combinations and wild colors are
totally authentic.

That’s not the only time when you have to
avoid playing the role of director. Let the
children determine what happens in a situation;
you are just the observer. I have a camera with
me so often when I'm with my children that
they are usually very relaxed about me looking
at them through the viewfinder. When they've
had enough, they let me know in no uncertain
terms. If you respect what they tell you, even
shy children will be happy to have you and your
camera around on a regular basis.
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Since I became a mother I have
photographed my children more often
than any other subject. At first I just
wanted to compile albums full of
memories. Not surprisingly, ordinary
snapshots weren’t enough and I quickly
went back to my usual way of taking
photographs: very much determined by
the situation, and using very basic
equipment. I almost always photograph
scenes from everyday family life that occur
naturally as part of our life together.

ISO800 | 50mm | f2 | 1/500s

Children as a Photographic Subject



When working with children you will
usually find that your camera creates great
interest to begin with. Some children find it so
exciting that they pull faces. Do your children
a favor and photograph them when they do –
this is part of who they are too.

If your subjects are very young, you may
have to protect your lens from curious fingers.
Before long, however, children are sure to
enjoy the shoot too, especially if you let them
take a photo of themselves from time to time.
And don't worry about the camera – most
children take great care. Maybe you could
even give your son or daughter a camera of
their own that they can use to document their

daily life. My daughter loves the camera she
received for her fifth birthday and is
enthusiastically compiling her own album of
special moments.

Empathy and Observation

As long as there are still children swarming
around you and your camera, only
centimeters away from the lens, there's no
hope of getting good quality photos. But
patience brings its own reward – as soon as
their interest in the camera and being
photographed fades, the situation will

generate fabulous photos. You will get some
wonderful uncontrived shots of children
absorbed in play. Whether they are being
princesses, monsters, wildcats or race cars,
they make wonderful subjects.

On the other hand, taking photos with the
goal of simply capturing a smiling child is a
recipe for mediocrity, producing endless
snaps that all look similar to one another.
Children are individuals and the challenge for
a photographer is to convey that visually. No
child is happy all the time. Sometimes they
look dreamy and they are often sad or in a
rage. For me, photos of such emotionally
intense moments are all part of the package.
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Patience brings rewards: I was sitting in the kitchen with my children and my camera and, for a while, nothing
out of the ordinary happened. We were all taking a snack when a small altercation arose over nothing. I watched
it unfold through the viewfinder for several minutes, uncertain whether an opportunity for a good photo would
arise or not, when suddenly my daughter ended the argument in this gentle way. The resulting photo captures a
completely unrehearsed, loving, intimate moment between the two siblings. This is an image that I could never
have captured as a snapshot on the fly.

ISO400 | 30mm | f2.8 | 1/200s



However, many children reel back if a
camera suddenly looms up in front of them at
moments like these. It's best to photograph
children who are sad or angry only if you and
your camera were already present as the
situation developed.

If you have been there taking photos for
a while, children are more likely to accept
being photographed in a moment of
weakness. And in any case, the only way to
be able to tell the whole story and capture
the mood in such a way that the child
recognizes him or herself in the photo is to
observe the situation closely.

The Right Camera

You don't need a studio or loads of expensive
equipment to take great photos of children. A
compact camera is quite sufficient, and I
sometimes even take photos of my children
using my smartphone. Even though this limits
your creativity and you can only adjust the
framing and set the aperture and focus, the
photos can still turn out well.

The key is not so much the technical quality
of the camera as how well you manage to let the
viewer into the child's world. Many of the
examples on the following pages could also

have been taken with a simple camera, and even
though it wouldn’t be possible to use them to
make really big prints without considerable loss
of quality, many photos taken on a smartphone
can be enlarged up to a width of seven or eight
inches without any problems. A delightful little
summer series like the one at right would work
well as a mosaic on the wall or in a photo album,
but is also ideal for a small-format photo book.

Of course it doesn't hurt if you can make
use of the superior options provided by a DSLR,
and this is still your best option, particularly if
you like working with the depth-of-field effects
offered by a wide aperture.

52 c’t Digital Photography 11 (2013)

Photographing Children | Children as a Subject

Instead of using it to clean his
teeth, my son wanted to use his
toothbrush to scrub the bath. He
was completely devastated over
not being allowed to do so.
Expressions of strong feelings are
part of life with small children
and can also be recorded with
the camera – but only if you have
your camera handy at all times.

ISO 1000 | 70 mm | f2.8 | 1/125 s

This particular evening, my daughter was feeling really
miserable and hid her face in her hands. It was a very

poignant moment for me, and one that I also had the
privilege of capturing discreetly on camera. 

Even now, she has no problem with photos that depict
her experiencing emotional fragility. In fact, she

welcomes them as an opportunity to talk with me about
what happened during the day and why 

she was sad, angry or happy.

ISO400 | 50mm | f1.4 | 1/125s
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This mosaic was created from a short summer series about my daughter. To create unusual
lighting moods, I often work with backlight and extreme light/dark contrast. I also desaturated the
colors a little during processing so that the photos would blend together better. I framed the
original shots tightly to keep unimportant detail out of the frame, and the additional square
cropping emphasizes the subject while underscoring the strict formal arrangement of the tableau.



Ultimately, all your decisions as you shoot,
process and present your photo have one thing
in mind – directing the viewer’s gaze in order
to influence the way the child in the photo is
perceived. Your vantage point, the aperture,
the light and the other elements in the frame
as well as cropping, post-processing and giving
each image a context are all part of the process.

If you go ahead and experiment
extensively with the options presented here,
you will be able to use them well when the
right moment comes.

The number one rule to remember when
photographing children is: always put yourself
at eye level with them and don't look down on
them from above. If you are photographing
toddlers or kids who are still crawling, this
means getting down on the floor with them.
This way, the viewer is drawn directly into
what is happening and experiences things
from the child's perspective rather than
observing from a distance.

If you photograph a child from slightly
below eye level, you will produce a ‘heroic’
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On a windy summer day on the island of Öland, my daughter bravely crawled alone, on all fours,
to the end of a jetty at the beach and then stood, holding her father's hand, calmly surveying
the scene. Photographed at eye level, the picture captures the moment from the child's point of
view. In contrast, shots taken from above like the one shown above right, portray things from an
adult point of view and keep the viewer at a distance from the child’s world.

Analog medium format (6x6) | Kodak Portra 400 | 80mm | f8 | 1/250s

ISO200 | 85mm | f8 | 1/200s

Directing the Viewer’s Gaze



look, which is a great way to produce
wonderful portrait shots.

Of course, the subject itself is not the only
thing you have to think about to achieve a
successful photo of a child. If you concentrate
so hard on observing the child that you
neglect the surroundings in your composition,
the background can easily become distracting.
The right combination of aperture, focal length
and viewpoint helps to steer the viewer's gaze
to the subject and sometimes helps us see
things from a completely fresh angle.

Fast Prime Lenses 

I often like to photograph children using a
fixed focal length lens. This is the ideal tool
for preserving formal cohesion within a
sequence and requires the photographer to
play a more active role in the compositon of
the images, which I find leads to better
pictures. Instead of just reaching for a zoom
lens, I prefer to use a standard 50mm lens
and an 85mm telephoto.

Using a Wide Aperture

Wide apertures offer the creative advantage
of using deliberate blur to separate the
foreground and background. Blurring the
background makes some visual elements less
dominating and the reduced depth of field
directs the viewer’s eye to the main subject. If
you use a camera with a full-frame sensor, you
will be able to produce particularly attractive
bokeh effects.
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You don’t need to resort to a heroic pose every time. This shot is effective because it
breaks away from the standard approach. The combination of a wide aperture and the
view from above makes the child’s body and the water disappear into the misty blur of
the background. Our gaze is completely captured by the face even though the subject
is located at the edge of the frame.

ISO800 | 50mm | f2 | 1/30s



Using a Telephoto Lens for
Portraits

For portraits, you can steer the viewer’s gaze
even more effectively by using focal lengths
of 70 mm or more. In this case, wide
apertures blur the background particularly

effectively and make the background
generally ‘flatter’, while the small angle of
view almost fades out the background
altogether. At the same time, a short
telephoto lens reproduces proportions
harmoniously – a tremendous advantage for
this type of shot.

Wide-angle Shots

On the other hand, if you want to capture a
rough-and-tumble feeling or the exuberance
of a whole group of children, or if the
surroundings are important to the photo, you
are better off using a wide-angle lens. Since
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For portraits like this one, I particularly
like using a short telephoto lens. This
enables me to keep my distance so
that the kids are not disturbed by my
presence and remain immersed in
their own world. The wide aperture
puts the focus entirely on the child,
leaving the tree, which is really not far
away at all, an indistinct part of the
background.

ISO400 |105mm | f3.2 | 1/500s
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these lenses have the effect of apparently
increasing distance and making distant
objects look very small, you will need to get
very close to the action.

Be careful, though: short focal lengths
make objects that are close to the lens look
unnaturally large – an effect that can easily

distort faces. At the same time, objects and
people at a distance look disproportionately
small. Sometimes, as in the image of a girl on
the beach at the beginning of this article (for
which I stood just three meters from the
subject), you can use this effect deliberately to
give an image more impact. 

Frames and Foregrounds

If, instead of shooting portraits, you would
rather take photos of children in a particular
situation, but still want guide the viewer’s eye
to the main action, you can often use the
foreground to frame the subject. This
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I shot the start of this running race using a 
wide-angle lens really close up and from an unusual
viewpoint. If you don’t get close enough, a  
wide-angle shot can end up being a boring ‘spot the
action’ affair, like the image at right, which is more of
the rocks than of the children climbing.

ISO400 | 24mm | f5.6 | 1/125s

ISO250 | 24mm I f18 | 1/200s 



approach also elegantly disguises clutter that
can otherwise be distracting. As a side-effect,
additional foreground detail makes a photo
more three-dimensional and gives the viewer
the feeling of being directly involved in the
scene. Get as close to the foreground as
possible and use the widest possible aperture
if you want it to get the most out of this
technique and completely dissolve the
foreground into blur.

When using the foreground as a creative
image element, make sure you don’t allow it
to become too solid. Because they are often
lit differently from the main subject,

foregrounds are often rendered too dark or
too light. In these situations, it helps to include
only a small portion of the foreground in the
photo.

Play around with unusual shooting
positions and angles to include the
foreground as ingeniously as possible. Try
crouching or getting nearer to the wall. Lead
the viewer’s eye along the floor, crawl under
bushes or leap into ditches, and see what
lends itself to being used as foreground or a
frame. Shooting into a room from outside, or
vice versa (including from cars), is a great way
to find a spontaneous frame for a subject.
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This early-morning shot shows Levin in a bad mood, standing at the
kitchen table and wailing loudly. This is all part of the rich tapestry
of life with small children. To steer the viewer’s eye into the picture
and directly to the fractious child, I crouched low in front of the
table so that the lens was only just above its edge. The viewer then

sees the breakfast table from the same perspective as the child 
who can only just see over it. Without this extreme perspective, 
the photo would lose a great deal of its intensity.

ISO800 | 40mm | f2.8 | 1/50s

Where we live, in the country, there
are a lot of fires in autumn, as

people burn their organic rubbish in
the fields or in their gardens. My son

was absolutely fascinated and I
couldn’t drag him away from the

fire. To capture his fascination, I
used the fire in the foreground,

together with the smoke, to form a
frame that puts the focus on the
child, even though he is actually

standing in the background.

ISO400 | 105mm | f7.1 | 1/250s
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Black-and-White and
Monochrome Tints

Colors can detract from the impression you
intended to create. Sometimes, a loud color
diverts attention from the main subject to
something irrelevant. Or a photo of a child
feels chaotic and unsettled because the
brightly colored clothing clashes with that of
other children or, worst of all, with the colors
in the background.

But don’t let any of this put you off. Take
the photo anyway and see what happens if
you convert it to black and white or give it a
monochrome tint at the image processing
stage. Digital manipulation not only rescues
photographs that didn’t turn out right; it can
also transform an average snap into a superb
image.

It is not a good idea to do this type of
conversion in-camera, as this gives you no
control over the process and sacrifices a great

deal of image quality. To make the most of the
tonal range of your subject, shoot in RAW
format and convert your images to to black
and white later on. This approach gives you
the maximum possible range of shades to
play with, and you still have the color version
of the image available if you change your
mind later.

To prevent the colorful pattern on the baby’s pajamas from drawing
attention away from her face, I converted this photo to black and
white. This technique also had a positive effect on the photo of a
little boy who had fallen asleep next to his father on the couch. 

While the different shades of the clothing and the couch made the
scene look too busy in color, the monochrome sepia tone I added is
the perfect way to enhance the restfulness of the image.

ISO200 | 85mm | f1.4 | 1/50s ISO1600 | 70mm | f2.8 | 1/60s



We usually find photos with razor-sharp
definition particularly pleasing, but children
are so full of energy, so fast moving, that
autofocus doesn’t always produce the result
we were hoping for. There may well be blur
caused by movement or camera shake
because the exposure time was a fraction too
long or the focus was ever so slightly out. Yet
it is these very moments, overflowing with lust
for life, that we all love to capture with our
cameras.

Manual focus is often best for
photographing children at play, but if it
doesn’t work out, then the only thing to do is
to set autofocus to focus priority mode and
shoot multiple images in continuous shooting

mode. This way, at least you will end up with
some in-focus photographs of fast-moving
scenes. And anyway, since when has it been
possible to achieve a perfect composition
when photographing boisterous children?

If the noise characteristics of your camera
allow it, you can also increase the ISO value to
shorten the required exposure time. Always
take some test shots in advance so that you
know how high you can go before there is too
much noise for your taste. If your camera has
it, activate auto noise reduction at high ISO
values.

If your goal is to capture the right
moment, precise focus doesn’t always have
to be the priority. Quite the contrary: to my

mind, slight movement and loss of focus are
not a problem when photographing
children in high spirits. I embrace these
types of visual imperfection as part of the
creative process, because they convey the
bubbly enjoyment that children so naturally
express.

In the action-packed world of children, feel
free to leave your flash switched off, and don’t
turn the ISO value right up, so that the
exposure lasts a little longer. Sometimes the
slight blur this creates is not only excusable
but can give the image the energy it needs to
be convincing. It’s not worth missing that
beautiful memory or funny moment for the
sake of a small compromise on focus.
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Pure delight: children just love playing
with water in the summer. My children

can play for hours running under a small
garden sprinkler. To convey this childlike
joy, I deliberately used slight motion blur

as a compositional tool, rather than
capturing the scene in sharp focus using

a short exposure time or flash.

ISO400 | 105mm | f8 | 1/200s

Capturing Movement



Technically speaking, it is simplest to
photograph a child’s face in diffuse light that
illuminates it evenly from the front. However,
the light is not always going to be exactly the
way we want it when we find an exciting
subject to photograph. And in any case,
shots like this often turn out looking run-of-
the-mill.

The idea of photographing in bright
sunlight or into the light may scare you, but I
encourage you to try working in this kind of
situation, and you can often end up
producing very evocative images.

Backlit shots are more difficult, it’s true, but
they are often very distinctive. I consciously
look for backlight or lateral light, because I
really like its unique radiance.

If you shoot in backlight, make sure that
you overexpose your shots accordingly,

otherwise you will end up underexposing
important details in your subject’s face or
body. Spot metering is the method of choice,
measured directly for the face or other,
equally bright details.

Using Flash

It’s best to photograph children using natural
light whenever possible. They will be more
willing to model for you and will tolerate
having the camera around if they are not
constantly disturbed by flash. My daughter is
quite happy to be photographed for hours on
end, but, if I use flash, she has had enough
after three shots at most.

However, some lighting conditions 
make flash a necessity if you don’t want 

your subject to end up out of focus or
portrayed as a silhouette. Blur and backlight
can be used deliberately as compositional
tools, but in general, people prefer to be able
to recognize children in photos.

If you find you have to use a flash, it should
only be used to enhance the existing light. If
possible, keep it down to a level at which it
isn’t too bright and harsh, but rather as
discreet fill-in flash. When flash is used well,
portraits of children seem natural and the
viewer won’t be aware of the flash at all.

If there is simply too little light overall, it is
better to push the ISO value up a bit. If your
flash output cannot be adjusted, this is a good
technique to try indoors as well. Automatic
flash quickly makes backgrounds disappear
into blackness, which is rarely a good way to
emphasize the main subject.
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Dealing with Difficult Lighting Situations

The carefree mood of this beautiful sunny day
really comes to the fore when captured using a
small amount of fill flash

ISO 400 | 105mm | f6.3 | 1/250s with fill flash
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What makes this photo so appealing is the subtle backlight. To ensure
that there was sufficient light for the face, I overexposed the shot
slightly, and the wide aperture I used also created the attractive blur
you can see in the background.

To be able to find the right settings quickly in a situation like this, you
need to be very familiar with your camera.

Analog medium format | Kodak Portra 400 | 80mm | f2.8 | 1/30s | +1.3EV



As with other types of images, with photos of
children, too, we normally try to achieve the
best possible effect for each image using
standard processing techniques. But as we
saw above in the smartphone shots, the effect
comes not only from the technical quality of
the images. Sometimes it does not become
apparent until we combine several images to
create a greater whole.

Pairing Images

First, try finding pairs of images that work
together on a double page in an album or

hung on a wall as a diptych. If you took
multiple photos of a particular scene, you can
select a pair or even a sequence from the
available material.

A more sophisticated variation on this
approach is to combine photos from different
sequences taken on different days and in
different situations. The easiest way to link
photos is to select ones with the same theme,
such as ‘summer’ in the example below.
Formal commonalities such as focal length,
perspective, colors or lighting conditions also
help create a sense of unity. If you have a good
feel for combining images, however, you can

combine photos from a range of themes. If
you have a knack for finding images that
complement each other, a pair of images
presented together like this can have more
vitality than a lone photo. Extra energy comes
from strong contrasts that generate a new
‘message’ that was not apparent in the
individual photos.

Using Photos to Tell a Story

Over the course of a year, as well as taking
individual photos, I also shoot short
sequences of images of my children.
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Telling a Story in Pictures

I took these cute portraits on vacation at the beach. Even though
they were taken on different days, they work as a set. I shot them in
similar situations against the sky, looking up from below. Yet they
are not quite the same, and the energy of the pairing comes from

the contrast between the children’s expressions. Because of the
wide aperture, the background is only hinted at and the viewer’s
attention is fully focused on the children. To achieve the pastel-like
summery look, I used one f-stop of positive exposure compensation.

ISO200 | 105mm | f3.2 | 1/8000s | +1EVISO200 | 50mm | f2.8 | 1/2500s | +1EV



Sometimes, when I notice a connection
between some of the photos, I start
deliberately taking more photos for the
same series. I often already have an idea of
how I want to present these sequences,
perhaps as a wall-mounted tableau or in a
photo book.

A series of photos that tells a story makes
a fun project that can be displayed on its own,
perhaps in a photo frame with mulitple
mounts for the individual images.

Telling a story with photos involves
principles much like those introduced in the
section on pairing photos, except that with
more photos, you have more options for
combining them. For example, placing 
three photos taken at the same focal length
in a row creates the impression of a film
sequence.

In a picture story, the narrative holds the
sequence together, giving you more freedom
to play with the formal elements of your
sequence. You can use different camera
orientations and crops, or emphasize one of
the photos a little more than the others. Just
make sure that, overall, you find a unifying
visual theme that tells the story the way you
intended when the sequence is complete.

The best way to arrange your photos will
be determined not only by the nature of the
images themselves, but also by how you plan
to present them. If you are telling a story using
multiple images in a single picture frame, the
effect will be determined by more than just
which photos you select. The size and position
of the individual images within the defining
shape of the mount play a role too. Another
major difference is that, in a wall-mounted
tableau, all the images are visible at once,
whereas in a photo book they appear one by
one as you turn the pages. 

Revealing Details

Photos of children don’t always have to show
their faces. It’s not always as easy as it was in
the sequence on the right to tell a story using
only portraits. Besides, a series can become
boring if the same child appears in every
photo, so bear in mind that other details can
also tell stories of their own. You can, of
course, use obvious things like hands and feet,
although footprints, drawings, handprints,
toys, a child’s room and many other details
can provide wonderful additional material
that – perhaps in combination with a portrait
and an overview of the setting – tells us more
about the child than just a portrait ever could
(see the example overleaf).
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A typical interaction between siblings, this story doesn’t need words. It may not
be what grandma wants for Christmas, but it’s still worth capturing for the record.
I focused manually, and the slight motion blur enhances the energy of the scene.

ISO400 | 50mm | f5.6 | 1/40s
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While she was busy transforming herself into an elf, my daughter was
so absorbed that I had almost an hour to shoot this sequence. I love
the mood that backlight creates. I had to overexpose slightly to
prevent her face from being too dark, but the bright, pastel feel 

of the images fits the theme perfectly. Portraits alternate with details
to avoid monotony and create a narrative.

ISO640 | 105mm | f3 | 1/60s
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Putting a Photo Book Together

Your best photo sequences not only look
great on the wall. You can now also present
them in photo books that you design and lay
out yourself. These days, virtually every online
lab and bricks-and-mortar photo service
provider offers photo books in all manner of
shapes, sizes and prices. All you have to do is
choose which format suits you best – from a
24-page booklet to a 100-page book with a
fine linen binding.

Just as in a photo album, you can create a
photo book by simply choosing a selection of
your best images and putting them together
in sequence. However, a unifying theme with
a cohesive design that runs through the entire
book makes for really classy results. The
theme can be anything from a detailed report

on a family vacation, a collection of little
stories from daily life, with all its highs and
lows, or your child’s first year at school.

Don’t make every page the same, like
people used to in their family albums. A single
photo can look good on a double page, and
some photos need more white space
surrounding them before they really shine. If
you develop a kind of script that fits with the
story, it will help you to create a sense of
harmony between the content and form of
your book. The experience of combining pairs
of photos and creating sequences will help
you plan each spread and the order in which
the photos should appear. You can include
some pairs of photos and perhaps a mosaic,
combining photos with similar content.

For inspiration, see the sample books at
your photo book provider’s website or check

out Create Your Own Photo Book, by Petra Vogt
(published by Rocky Nook, US$39.95). For
additional insight, study the work of
photographic artists, including those
mentioned in the box below. (anm) c

Inspirational photo books on the
themes of children and childhood:

Sally Mann: Immediate Family

Thekla Ehling: Summer Heart

Loretta Lux: Imaginary Portraits

More Literature

Photo books not only make a
treasured souvenir for parent and
child, they are also fun to look at for
other people too. This one, which is
all about life as a small child, is a
pot-pourri of everyday scenes,
portraits of children and other
interlinking details.
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Fine Art
Print Workshop
Quality, reproducibility and durability are the key
elements of a high-quality print. Whether you use your
own inkjet printer or a third-party print service will
depend on your personal preference, as well as on the
format and number of prints you wish to produce. This
article gives you a detailed overview of what to watch
out for when producing high-end prints, whether at
home or using a commercial service.



Although digital picture frames have
become commonplace, a really good

photo still deserves to be printed, framed and
hung on a wall. There are three main points to
consider when deciding whether to produce
your own prints or use a high-end lab:
• Print Size: Generally, if you want to

produce prints up to A3+ (329 x 483 mm,
13 x 19 inches), a good quality printer will
cost less than US$1,000. Printers that can
handle A2 (420 x594 mm, 16.5 x23.4 inches)
and larger paper are a lot more expensive
and often take up more space than most
people have available at home.

• Number of Prints per Month: If you only
make prints occasionally, you will use up
more ink cleaning your machine’s nozzles
and print head than you would producing
actual prints. Unless you print at least 10
A3+ prints per month, it is probably cheaper
to use a lab.

• Your Level of Experience: Modern inkjet
printers require a lot more setting up than
an office laser printer and the print process
itself is more complex. If you want to be sure
of producing first-class prints, you will need
to do a lot of testing first.

Many experienced photographers take a
two-pronged approach, producing their own
smaller-format prints at home and using a lab
for large-format work.
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Drugstores, specialist labs and online stores
offer photo prints in a wide range of qualities
and price points. They all use one of the two
major print processes:

Digital Prints on Photo Paper: This method
uses either a laser beam or an LED unit to
expose photo paper that is then developed
using a conventional RA4 chemical process.
This is the type of process used for  the mass-
market printing offered by drugstores and
electronics stores, and is completely
automatic. This approach doesn’t generally
cater for individual custom print settings or
special requests. 

The process usually includes automatic
optimization steps that you should ask to
have deactivated when ordering if you don’t
want any adjustments you have made to your
image files to be comopounded ad absurdum.
In contrast, pro photo labs are generally
capable of fulfilling any special printing
requests you may have, but charge from four
and eight times as much. 
Inkjet Prints: Inkjet printers produce  prints
by spraying microscopically small drops of
colored ink onto paper.  Conventional home
and office printers usually use cyan, magenta,
yellow and black ink cartridges, but photo
printers use additional ink cartridges to enable
them to produce more finely differentiated

intermediate color tones. Most printer
manufacturers now also provide gray ink for
producing the grayscale tones necessary for
effective black-and-white printing. 

It is possible to produce adequate fine art
prints using both processes, although inkjet
printers are still the device of choice in the
high-end print market. To find out which print
service produces the best results, simply send
a single image file to each of your potential
candidates and see which comes up with the
best looking results.

Preparing Your Files for
Printing
To ensure that you make the right settings, it
is essential to use a color-profiled monitor (see
the in-depth article on color management in
Issue 8 of c’t Digital Photography for more
details). Brightness and color have to be
consistent for reliable results, but neither is
guaranteed unless you use a high-quality
monitor. 

The first thing to do is to adjust the size and
resolution of your image. The safest way to
make any adjustments is to make a copy of
your original image and work on that. You will
achieve the best possible print results if you
set your image to either 300 or 360 dpi, even
if the manufacturer of your particular printer

claims that higher resolution is possible. This
is because each pixel in your image is printed
using multiple dots of ink, and the optical
density (i.e., brightness) of the resulting color
depends on the number of dots per unit area
(or ‘raster cell’) your particular model can
print. For this reason, we have to divide the
nominal resolution of an everyday household
printer (for example, 1440 dpi) by at least four
in order to arrive at the real dot resolution it
can produce. High-quality printers designed
for professional graphics applications use
varying droplet sizes and multiple inks to
produce greater real resolution. The digital
print process described above isn’t subject to
these limitations because the machine uses an
RGB light source to ‘print’ complete pixels on
light-sensitive photo paper at a fixed
resolution of  300 or 400 ppi.

Your print service provider will tell you
which color system (CMYK, RGB or grayscale),
and which color space (sRGB, Adobe RGB,
CMYK ISO Coated v2 or Gray Gamma 2.2) is
best for use with the available machines.
Whichever method is used, it is important to
save the appropriate color profile with your
file. 

You also have to make sure that you use
the correct file format. Most print services
support TIFF, and some also support PSD and
PDF-X3. It is usually possible to use JPEG as
well, but the quality of the results will depend
directly on the compression rate used to store
the files.
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Some print service
providers recommend
excluding extreme tonal
values from your image
files, and suggest that you
only use values between
10 and 245. If you are in
any doubt, ask before
ordering.

Prints From a Lab

The first thing to do is set the correct size
and resolution for your particular image.
Generally, you will achieve the best results
if you set things up to print your chosen
format at 300 or 360dpi.



If your image is layer-based, merge it to a
single layer before sending it for printing – if
you don’t, you might find that some layers get
lost during data transfer and that your print
contains only some of the original data. Leave
some space at both ends of the image
histogram, and only use tonal values between
10 and 245. Ask the lab you have chosen
whether lightening or darkening midtones is
likely to produce the best results, although
ultimately, of course, it is up to you how you
prefer your images to look. If you are
considering adding a border, you must add

the extra width this produces to the final
dimensions of your image.

Check image size and resolution using the
Image Size dialog. Remember that altering
these settings involves resampling the image
data. If you are enlarging your image, the
best resampling method to use is Bicubic
Smoother, whereas Bicubic Sharper is
preferable if you are reducing image size.
Only resize your image if you want to print
using an unusual format or paper size. Avoid
making significant enlargements (even using
dedicated software), as this always reduces

the quality of an image and the prints you
can make from it. 

The subject itself and your personal
preferences will determine whether you
need to sharpen your image globally before
printing. The simple fact is, over-sharpened
images look terrible, so if you are in any
doubt, remember that in this case, ‘less is
more’. And please note that the oft-quoted
maxim that sharpening is the last step you
should perform is actually bad advice! The
sharpening process can cause new artifacts
to appear, so you should always sharpen

71c’t Digital Photography 11 (2013)

Print Workshop | Using a Lab

The Unsharp Mask filter offers a range
of settings for precise additional
sharpening of images that have
already been processed

Soft proofing helps you to further optimize your
print settings. Use either the Perceptual or

Relative Colorimetric rendering intent and be sure
to activate the Black Point Compensation and

Simulate Paper Color options



your images before performing any final
retouching steps.

The popular Unsharp Mask filter offers a
range of useful sharpening settings. Using the
tool requires practice, and the sharpening you
apply to an image for printing on an inkjet
device will be quite different from that
required for digital photo printing. Unsharp
masking only actually  increases edge
contrast, but the overall effect is one of
increased visual sharpness.

In order to properly judge the effect you
are applying, select the tool’s 100% view. If
you check the Preview option in the filter
dialog, Photoshop displays the results of the
current settings in real time. The available
settings are:
• Amount: a percentage value that

determines the amount by which edge
contrast is increased.

• Radius: determines the breadth of the edge
to be sharpened (in pixels).

• Threshold: determines the degree of
contrast between pixels that is necessary in
order for them to be included in the
sharpening process.

If you are not sure which values to use, an

Amount setting of 140%, a Radius of 1.5 and
a Threshold value of 0 are a good starting
point for an initial inkjet test print. The best
way to visualize the relationships between
sharpening settings and the look of the results
they produce is simply to order  a batch of test
prints using a range of different settings.

The last step you will need to take before
sending your images off for printing is manual
dust and scratch removal. Set the preview
image to its 100% view and use a grid to
divide the frame into easily identifiable
sections. Use the Photoshop Dust & Scratches
filter (in the Filter > Noise sub-menu) – but
only on preselected image areas, not the
whole image. 

The Clone Stamp and the Healing Brush
are Photoshop’s most flexible manual
retouching tools. Once you have finalized
your corrections, save your image under a
new name as a TIFF file. If you use additional
layers on top of the original background layer
to perform your retouching steps, be sure to
save the layer-based image as a TIFF or PSD
file so that you can fine-tune your corrections
later if necessary.

If you prefer to save bandwidth by sending

JPEG files to your print service provider, make
sure that you make any alterations to the
original Photoshop or Lightroom file and only
save it to JPEG for transfer once you have
finalized your adjustments. The Lightroom print
dialog has a dedicated Print to: JPEG File option,
with a simplified set of options that don’t have
to account for individual printer driver settings.
You can still select the output profile for your
printer or your print service provider (if
available), which Lightroom then embeds in the
resulting JPEG file, thus ensuring that the colors
are unambiguously defined. 

Clicking the ‘Print to File’ button then saves
the image to your chosen location. All in all,
the Lightroom approach makes it quick and
easy to produce batches of print-ready JPEG
image files.

Soft Proofing

Soft proofing helps you to optimize your
image for output, especially if you are printing
on matte paper, which has a smaller range of
contrast than glossy paper and thus produces
images with less immediate ‘bite’. When
creating a soft proof, Photoshop first converts
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High-end inkjet printers can produce excellent black and white prints too. Additional gray ink
cartridges have helped to give this image a finely balanced range of tones.

Image: Grisha Georgiev, Fotolia.com



the image using the appropriate output
profile and then re-converts it using the
current monitor profile. You need to have
access to your printer’s ICC color profile in
order to make successful use of a soft proof
during printing.

Setting up a custom soft proof is simple.
Navigate to View > Proof Setup and select the
Custom option in the Custom Proof Condition
drop-down menu. Select the Perceptual or
Relative Colorimetric rendering intent option
and the appropriate profile in the Device to
Simulate drop-down, and be sure to check the
Simulate Paper Color option. Once you have

made all your settings, click ‘OK’ to see the
results. The difference in the monitor image
will be obvious, especially if you are
simulating the appearance of a fine art paper. 

You can further fine-tune the proofing
view if you wish. A slight increase in contrast
often improves the look of black-and-white
images, while color prints can benefit from
greater color saturation. If you switch on the
Gamut Warning option in the View menu, the
preview will immediately show which colors
will not be adequately reproduced by the
current output color space.

The real value of a soft proof depends on

its configuration parameters and on the
overall quality of your color management
system. The appearance of a soft proof will
only ever be an approximation of a physical
print, and it is preferable to have your service
provider print some test strips using your
selected paper before you go ahead and order
large prints. This type of ‘real’ proof shows
either a life-size detail of the final image or a
reduced-size test print of the entire frame, and
helps you to precisely judge the effects of
your settings before going ahead with a print
run.
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The color space of a
high-gloss paper (on the
left) is much larger than
that of a matte paper.
The paper color space

(the inner shape in these
diagrams) is shown

compared to the RGB
color space.

The Photoshop Shadows/Highlights tool can be used to
brighten selected pixels relative to their surroundings



Making fine art prints at home will usually
involve the use of an A3-format printer. These
devices are popular for home use because
they can produce exhibition-size (12 x 16-inch)
prints with a reasonably sized border while
retaining a relatively small desktop footprint
of around 25 x 30 inches. A2 printers are much
larger and heavier. Popular printers for fine art
use are the Pixma Pro-1 and Pro9500 Mark II
models from Canon, or the Epson Stylus Photo
R2880 and R3000 models. The current
generation of fine art printers use eight or
more ink cartridges and offer extremely good
color permanence when used with
appropriate paper. The widely used Wilhelm
Imaging Research durability benchmarks
(http://www.wilhelm-research.com) specify
permanence of more than 50 years for color
and more than 100 years for monochrome
prints. The manufacturers of such high-end
printers always supply appropriate ICC
profiles, either on a CD provided with their
products or online.

Ink Types

The printer model you choose will determine
whether you use pigment or dye-based inks. 
• Pigment inks are generally more durable

than dye-based inks. Their large particles
don’t sink as far into the surface of the paper
and are distributed in the upper layers of its
structure. The large size of the individual
droplets also makes them less susceptible
to the effects of humidity and light, making
them more appropriate for use in
problematic environments. The range of
colors that pigment inks can reproduce is
only slightly narrower than the one covered
by dye-based inks, but the larger size of the
individual particles means that they are
more likely to block the nozzles in the print
head.

• In dye-based inks, the color molecules are
suspended in liquid (usually water), which is
why they are not waterproof. However, the
much smaller size of the individual color
particles gives them the edge as far as
image quality, detail rendition and color
brilliance are concerned. They are also
capable of reproducing a broader range of
colors. The price for all this increased luster
is less permanence. Light and
environmental factors have a much greater
effect on dye particles than they do on the
larger pigment particles and makes
dye-based inks unusable for outdoor
applications.

Manufacturers’ original ink cartridges are often
quite expensive and trail a thriving third-party
ink industry in their wake. In spite of recent
improvements in quality and cartridge
compatibility, third-party inks often provide

inferior print quality and durability in
comparison to printer manufacturers’ own
products. 

The wealth of technical information on
printer manufacturers’ ink products to be
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High-end paper manufacturers like Hahnemühle offer fine art papers with a wide range of
surfaces and textures. The right paper to choose will depend on the subject of a print.

Comparing the Optical Density of Matte and Glossy Paper 
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Glossy papers have much higher maximum optical density values than matte papers,
although absolute values don’t tell you much about how a print will actually look

Making Your Own Fine Art Prints



found at www.wilhelm-research.com is a
reliable source of data if you need to convince
potential customers of the quality of your
prints. We have also found that the
compounds used in the manufacturers’ own
inks remain consistent over long periods of
time, whereas third-party manufacturers tend
to switch materials and suppliers, thus
increasing the risk of producing inconsistent
colors. We have never had to alter a color
profile when swapping out an original ink
cartridge – just one of the reasons we never
use after-market inks.

Choosing a Paper

The standard-grade 20lb office printer paper
that you can find in most stores for US$6.99
for 500 sheets is completely unsuited for
photo printing applications. The ink will bleed
because it cannot dry fast enough and, even
if the paper doesn’t wrinkle when large
amounts of ink are applied, the colors seep
into the paper, producing diffuse detail and
dull-looking prints. 

Only special-purpose papers are capable of
reproducing each individual ink dot with sharp,
well-defined edges. Manufacturers produce
these effects by applying a special protective
ink-bearing coating to the surface of the paper
that makes it more smear-resistant and
prevents colors from fading. This coating is full
of very fine capillaries that allow the liquid
component of the ink to evaporate, leaving just
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The Photoshop
Soft Proof tool is
particularly
useful when you
are printing on
matte paper,
which often
lacks sufficient
‘bite’ due to its
narrower range
of reproducible
contrast

High-end paper is a sensitive medium and needs to be stored and
handled appropriately. Storage temperatures should be between
15 and 25 degrees and relative humidity between 40 and 60
percent. While these conditions can be found in many homes and
offices, you still need to take care not to store paper too close to
radiators or other sources of heat.

Careless packaging can also damage paper.  Fifty sheets of heavy,
art-grade 13 x 19-inch paper weigh more than 10 pounds. Packaged
in a carton with too much space, the sheets can slip around and the

corners will get damaged. We recommend keeping unused paper in
its original packaging if you are not planning to use it for a while.

You will often find crumbs of paper between individual sheets of
matte hand-made and rag papers, making it necessary to clean each
sheet before placing it in the printer. Invisible grease and sweat on
your fingers can seriously damage sensitive stock and alter the
behavior of the ink as it sinks into the paper, causing visible
inconsistencies in colors and details. Always use lint-free cotton
gloves when handling high-end paper.

Storing and Handling Paper

Poor packaging can damage the corners of your
paper, and, if your printer doesn’t keep the paper
perfectly flat, smudging and blotting can result



a precisely shaped colored dot on the paper.
An additional barrier layer also prevents the ink
from seeping further into the paper, thus
ensuring even color saturation throughout
each sheet.

Fine art papers which belong to this
category not only have superior ink-bearing
qualities, but are also extremely durable. The
term ‘museum quality’ is often used in
connection with high-end papers. Any fine art
paper worth its name should be acid and
lignin-free and should have a pH value
between 7 and 9. Everyone has their own
personal priorities, but we expect fine art
paper to provide precise tone and detail

rendition within as large a color space as
possible. High-end paper should also be
capable of reproducing consistently neutral
but well-differentiated grayscale tones with
discernible shadow and highlight detail.

The coatings used for fine art papers are
often porous and lack a barrier layer between
the lower layers of the paper and the
ink-bearing layer. In this case, the liquid
component of the ink droplets is absorbed by
silica crystals in the ink-bearing layer before
evaporating. The color particles are bound
chemically and form  precisely rendered
image details with well-saturated colors. If you
use uncoated paper, the ink will sink further

into the lower, carrier layers, making the
resulting image look more like a watercolor
painting. This type of paper is unsuited for
printing highly detailed images. 

Piezo-electric print heads used with large
pigment ink molecules produce better results
when used with ‘micropore’ paper, whereas
thermal print heads and smaller color
molecules are more suited to use with
polymer-coated paper. When you are starting
out, always use the paper and ink types
recommended by the printer manufacturer.
This increases the chance of producing
satisfactory results within a relatively small
number of attempts. If you want to
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Monochrome images converted from color can be given a neutral, warm or cool look, either
during conversion (as shown here), or later using your printer’s settings dialog

If you use a third-party print service, be
sure to check that your chosen provider
can provide precise information on the
following aspects of the process:

– Color management: The service
provider should provide either a
downloadable print profile or precise
details of the settings you need to make.

– Paper quality: A good print service
should offer a range of papers, including 
standard (250 g/m2) and a choice of

premium papers (Hahnemühle, for
example). Always request paper samples
or test prints in advance.

– Image processing: Does your provider
allow you to switch automatic image
optimization off? Automatic image
correction does more harm than good
when applied to high-end prints.

You will also need to finalize the following
points before placing an order:

Print Service Checklist

Precise paper
format

For example, DIN A3+, 329 x 483 mm,
13 x 19 inches

Paper type For example, Hahnemühle 
Fine Art Pearl 285

Image file 
resolution

For example, print resolution of 360 dpi

Color depth 16-bit
File format TIFF or PSD, JPEG only if really necessary
Color space Usually RGB, but always check before

ordering
Automatic image
optimization

Provide print-ready files – no further 
optimization necessary

Borders If present, sized appropriately for the
image. For example, 25 mm on  all sides,
centered.



experiment with other consumables, only
alter one component at a time – otherwise,
you won’t be able to work out which change
produced which result.

Fine art papers are usually 0.26-0.56 mm
(0.01-0.02 inches) thick. Only a few paper
manufacturers actually quote paper thickness
in their data sheets, but values correspond
directly to the weight of each paper type
(usually quoted in g/m2). Most papers weigh
between 160 and 350 g/m2. Heavier papers
give a print a high-end look and feel, although
the weight of the paper is less relevant when
a print is framed.

You can enhance the effect of a print by
selecting a specific paper finish or texture. The
types of paper finishes available today include
high gloss, glossy, matte, silk matte, pearl,
luster, photo rag and baryta, and also cover a
wide range of special textures. Prints made on
glossy paper always appear more vivid and
sharper than those printed on matte paper,
with better differentiation between the
individual tones.

High-end glossy paper is quite tricky to
handle. Its surface is extremely sensitive and
shouldn’t be touchd at all, even if you are
wearing gloves. If you do handle gloss prints,
be sure to hold them only by their very edges.
Glossy paper also increases the risk of the
‘bronzing’ effects that occur in dark image
areas where excess dark pigments remain on
the surface rather than actually sinking into
the paper. In spite of their drawbacks, glossy
papers produce sharp prints with more punch
and are the first choice for most everyday
printing purposes.

Luster, pearl, smooth, satin and silk 
finishes can be difficult to distinguish from one 
another. They all have a textured surface, but
manufacturers rarely publish details of exactly
what type of texture is used. The major
advantage of all these paper types is that they
are relatively robust and are not overly sensitive
to fine scratches, fingerprints or rubbing.

Matte finishes have much lower optical
density values (usually about 1.6) and
therefore show less overall contrast than gloss
finishes. However, they can still be used with
carefully calibrated color profiles and suitably
processed images to create really impressive
prints. Always use matte inks when printing
on matte paper.

The color of the paper itself is also relevant.
A pure white gloss surface and the soft natural
color of a hand-made silk finish paper are
worlds apart. However, the color of a particular
paper type is purely a matter of taste and not
an indication of quality. Paper tone is virtually
irrelevant when you are dealing with color, but
plays a significant role in the look of a
black-and-white print. The bleaches some

manufacturers use to give paper a bright white
touch can fade, causing the white parts of an
image to become darker with time.

Practical Details 

During printing, color management is
controlled either by the image processing
application (Photoshop, for example) or by the
printer driver. In order to avoid conflicts, use
only one or the other, and deactivate the one
you are not using. Check too, that the printer
driver and the application print settings are
the same. If possible, use the color profile
provided by your printer and/or paper
manufacturer. These are usually available
online and produce much better results than
the default settings used by the application or
the printer driver. Check either the profile
provider’s instructions or the help files for
your operating system for details on how to
install downloaded profiles. 

Manufacturers’ color profiles are helpful,
but making your own can be really
interesting. See our in-depth article on 
color management in Issue 8 of c’t Digital
Photography for more details on how. 

If you end up with sub-standard results
despite using custom profiles, this is probably
because you have omitted to deactivate the
printer driver’s built-in color management
functionality. 

Make sure that you select the correct paper
type when printing, as this controls important
print parameters such as the amount of ink
and the size of the droplets applied by the
printer, as well as the distance between the
print head and the paper.

To see just how desctructive incorrect
driver settings can be, set your printer to
expect matte paper and then use glossy stock
to make a print. The result will be an unusable
print swimming in pools of expensive ink. 

If possible, check your print speed settings.
Bidirectional printing is faster, but produces
lower quality prints. We recommend
switching this particular function off.

Printing from Photoshop

In Photoshop, print settings can be adjusted in
the dialog revealed by the File > Print
command. Select your printer and click the
‘Print Settings’ button to reveal detailed
printer settings, and check that the settings
are the same as the ones made for the printer
driver. We can’t stress enough how important
it is to use matching printer and print settings,
as any discrepancies can cause unpredictable
results and unnecessary error messages. If 
you want to produce prints of the highest
possible quality, deactivate the Scale to Fit

Media option, as this involves automatic
reinterpolation of the image data.

The Color Handling drop-down in the
Color Management section of the Print
Settings dialog is where you can select
whether Photoshop or the printer takes
control of color management. If you want to
use custom print profiles, select the Photoshop
Manages Colors option and then select the
appropriate printer profile for the print you
are working on. The Relative Colorimetric or
Perceptual options are usually the best to use
for photo prints, and you should follow your
paper manufacturer’s instructions regarding
use of the Black Point Compensation option.
Once you have made and checked all the
appropriate settings, click the ‘Print’ button to
show the preview (if activated) and proceed
with printing. The preview image often looks
quite different from the monitor image and
can be a surprise to inexperienced users.
However, it is still useful for checking print and
paper size, as well as the position of the print
on the paper. 

If Match Print Colors is activated, the
preview shows the actual colors that you will
be printing. Activating the Show Paper White
option also helps to create an accurate
preview, as this then simulates the paper color
included in the current printer profile in the
monitor  preview. 

And finally, the only way to judge your
results reliably is to view them in constant
light with a color temperature between 5500
and 6500 Kelvin (i.e., daylight). Electric
daylight lamps are available in various forms,
including fluorescent tubes and energy-
saving bulbs.

If, in spite of careful preparation, you are
not satisfied with your results, there are
various factors you can check and, if
necessary, adjust. The most common cause of
sub-standard prints is a seldom-used printer.
If it is not used regularly, the ink in the print
head will sooner or later dry up and block
some or all of the nozzles. Print experts
recommend that you use your printer at least
once a week. Many printers periodically wake
themselves from standby to clean the print
head. According to the manufacturers, this
uses very little ink, and it certainly saves time
and prevents frustration.

If you are using your printer for the first
time in a while, make a test print and start the
nozzle cleaning routine manually if necessary.
Clean your paper before starting a print run.
Dust and tiny paper fragments that adhere to
the paper can get stuck to the printer’s ink
nozzles, especially if you are using matte
paper. Dust particles that stick to the paper
are ugly too and can spoil a print. Always let
your prints dry thoroughly before handling or
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framing them. This takes longer than you
might think – wait at least overnight. 

Printing in Black and White

The lack of color in black and white images
accentuates the interplay of light and shade
in the subject, making monochrome an
important mode of photographic expression.
For more details on converting color images
to black and white, see our black-and-white
workshop in Issue 6 of c’t Digital Photography.  

If you print your own monochrome
images, leave them in RGB mode rather than
converting them to grayscale, especially if you
already have a proven, color-neutral profile

that suits the printer/paper/ink combination
you are using. If you are having your image
printed, either convert it to grayscale or ask
your service provider which settings to use.

To get excellent monochrome print
results, use multiple black and gray inks.
Older printers can be equipped with special
grayscale ink cartridge sets, although these
can be tricky to handle and require the use
of dedicated drivers. Custom RIP (Raster
Image Processing) software such as
QuadTone has virtually disappeared from
the market since  printers with two or three
different black inks and dedicated black-
and-white printing modes have become
commonplace.

Our Epson printer’s print preferences
dialog includes an Advanced B&W Photo color
setting that lets you select only black inks for
printing. You can then only adjust gamma
brightness and contrast before printing. If
you select the Neutral, Warm, Cool or Sepia
setting, the printer adds colored inks to the
mix, enabling you to alter the colors in your
print without actually editing the image data.
You can also adjust the white of the paper
you are using as an additional creative
element. These types of settings are
particularly useful if you are using an image
processing program that cannot load
individual color profiles or if you don’t have a
suitable profile to hand. (keh) c
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If your prints don’t turn out looking the way you had hoped, this
can be due to errors and inconsistencies in your files or in the
printing process itself. Sometimes, file transfer can be the cause of
discrepancies. If the service provider you have chosen is local,
always review your images at the lab together with the lab’s
personnel. Discussing the details that are important to you before
going ahead with a job always increases the quality of the results.

Always see if you can find the cause of any inconsistencies yourself
before making a complaint to your printer.

The print isn’t sharp enough
Sharpness is virtually impossible to influence during printing.
Check your image at 100% magnification – we often work with
reduced-size monitor images, especially for large-format prints,
and this artificially increases visual sharpness. A lack of sharpness
is nearly always due to inadequacies in the image file.

The print is too dark or too light
If all the images in a batch have the same issue, color
management is probably at fault. If individual monochrome
images show reduced detail, check the Photoshop clipping
warnings. The cause is most probably clipped tonal values.

The print has a color cast
If all the images in a series show the same cast, check that both
your files and the printer are using the correct color management
settings. Individual images with color casts indicate incorrect
white balance settings during shooting or processing.

There are dots or blotches on the print
Blotches are usually due to an erroneous print process and occur
more often when printing on glossy paper. If the blotches are not
present in the original image (check to be sure), ask your printer to
repeat the order.

What to Do if Things Don’t Turn Out as Planned

High-end paper should never be rolled or folded. One
of our test papers arrived with a kink in it, so always
select flat packaging if you can.

Pro-grade print service providers often deliver high-end
prints with a protective covering and lightly glued to a piece
of stiff card to prevent bends or breaks.
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Recent versions of Photoshop include a number of changes to the
procedure for making test prints to create color profiles. Here are
the details of the process for older and more recent versions of the
program:

Photoshop CS Versions up to CS4

–ˇDo not assign a profile to your test file
–ˇDeactivate all automatic print functionality
–ˇDeactivate any color correction settings in the printer driver
–ˇAlways print at 100% image size
–ˇDo not scale your file to the media size
–ˇSelect the No Color Management color handling option

CS5 and Later

–ˇAssign the Adobe RGB profile to your test file 
(Edit > Assign Profile > Adobe RGB 1998)

–ˇDeactivate all automatic print functionality
–ˇDeactivate any printer driver color correction settings
–ˇAlways print at 100% image size
–ˇDo not scale your file to the media size
–ˇSelect the Photoshop Manages Colors color handling

option
–ˇSelect the Adobe RGB (1998) print profile
–ˇSelect the Relative Colorimetric rendering intent 
–ˇDeactivate the Black Point Compensation option

Making Test Prints for Profile Creation

The lack of color in a monochrome image helps to
emphasize the interplay between light and shade,
giving the resulting print a highly three-dimensional
feel. Many photographers use this effect deliberately
as an additional compositional tool.
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Photo Fun with

Home-made Gear
Building your own tilt/shift lens not only saves a lot of money, but also
gives you a free entry ticket to the wonderful world of fake miniature
photography. And why not convert your telephoto and macro lenses into
telescopes and microscopes? This simple modification takes you deeper
into the world of macro viewing than a conventional lens ever can. For
high-speed photography fans, our easy-to-follow guide shows you how to
use a simple photoelectric cell to capture fantastic microsecond images. 
All three of these projects are cheap to make and open up a whole new
world of creative vistas. Let us inspire you!
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Tilting a photographic lens allows you to
change the orientation of the plane of focus
in such a way that you can simultaneously
capture close and distant objects in sharp
focus – an effect known as the Scheimpflug
Principle. The technique is often used in
product photography to keep large objects
completely in focus, but you can also use it
creatively in conjunction with a wide aperture
to strategically place objects and individual
image elements on the plane of focus. The
resulting images often have a painterly
quality and use the appeal of deliberate
blur to achieve their effects. 

This effect is especially
noticeable for distant objects,
and the extremely shallow
depth of field makes real
landscapes look like
miniature models. This
unusual depth of field
behavior causes the brain
to interpret what it sees as
a macro photo and,
because the evidence
appears to be conclusive
(and because we like what
we are seeing), we accept
the false impression as real.

These types of effects are
usually produced using
specialized tilt/shift lenses,  which
start at about US$300 for the
Lensbaby Edge 80, but there are also
other, much cheaper ways of achieving
similar results. You will need a DSLR (which we
are not going to modify!) and a medium-

format bellows camera from the 1950s or 60s
that you are happy to take apart. You should
be able to pick one up at auction for just a few
dollars. An old camera is fine as long as the
shutter works and the bellows are light tight.

We need to use a larger-format lens in order
to illuminate the entire sensor while tilting the
lens. 

Modifying the Lens

We first have to separate the lens/bellows unit
from the camera and glue it to a 6 x 6 cm piece
of plastic with a 44mm hole cut in its center.
This assembly is then attached to the camera
using an appropriate T2 adapter. You can also

use a spacer ring or an old, low-power
teleconverter that allows the lens to

focus to infinity.
Another cheap option is to

cut  a hole of the appropriate
size in the lens cap of your

DSLR and use that as a
mount for the bellows
lens. Check that the ‘new’
lens unit fits your camera
properly before gluing it
together. A piece of wire
covered with foam
rubber helps fix the lens
unit to the camera and

prevents it from tipping
forward. 

These measurements
apply to the Adox Golf

bellows shown in the photo
on the left and a Nikon-

compatible T2 adapter, but may
vary for other cameras and lenses. A

standard two-component adhesive is
best for gluing the parts together. The final

step involves fixing the shutter in an open

Build Your Own Tilt/Shift Lens
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2 Glue the lens/bellows 
assembly (in this case taken from an
old Adox Golf) to the front of your
plastic mount, making sure that the

seam is light tight.

1 Cut a 44mm hole in a 6x6cm piece of plastic and
smooth the edges using fine sandpaper.

Home-build Photography | Tilt/Shift Lens



position by inserting a small screw into the
cable release mount on the lens. 

Shoot Intuitively

You can adjust focus by moving the lens back
and forth, and the unit is even macro capable
at its full bellows extension. If your camera is
capable of metering with non-electronic
lenses, you can usually use the exposure
values it calculates in aperture-priority mode.
Usually, automatic metering only becomes
unreliable when you use extreme tilt
movements. If your camera only supports
electronic lenses, you will have to use manual
(M) mode and select the shutter speed
yourself. This is a little less convenient, but you
will quickly learn to judge the required
exposure time. 

You will also quickly learn to estimate the
partial focus effects caused by different
degrees of lens tilt, which are immediately
visible in the viewfinder anyway. The degree
of softness in your image can be regulated by
adjusting the aperture in the lens, although
closing the aperture right down would cancel
out the narrow focus effects we are trying to
achieve. There is no way to select specific
settings in the lens, so you have to work

intuitively. Due to the imprecise metering,
most uncorrected tilt/shift images look
rather dull and have to be sharpened
and color-corrected on a computer
anyway.

Cleaning the Lens

The adapter side of a
home-made lens unit is
open to the air, and 
the regular ‘pump’
movements of the
bellows tend to blow a
fair amount of dust onto
the camera’s sensor. I
recommend using a
blower brush to clean the
inside of the bellows
before mounting it on your
camera, and cleaning the
sensor again before mounting a
regular lens. 

This type of home-made camera
often attracts attention, usually from
people who are genuinely interested in
offbeat photography. I wish you happy travels
in the wonderful world of selective focus
photography – enjoy the view!

Home-build Photography | Tilt/Shift Lens
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4 Inserting a thin screw into the cable
release socket enables you to fix the
shutter in its open position

5 More than 50 years of photographic history
combined in a single unit. The lens attached to
this modern DSLR comes from an Adox Golf
camera manufactured in the 1950s.

3 Attach a T2 adapter to the rear of
the plastic mounting plate
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Here, the plane of focus covers
the foreground, the actual
subject and the background



A fake miniature landscape created using tilt/shift effects. With a little practice,
you will learn to recognize suitable fake miniature subjects.



Nearly every SLR owner owns either a
telephoto or a macro lens (or both). With  a
little technical know-how and at little extra
cost, these types of lenses can also be
converted for use as high quality telescopes
or microscopes. Don’t worry – your lens can
still be used normally afterwards!

Telescopes

Let’s start with the long lenses. It doesn’t
matter whether you have a zoom or a fixed
focal length telephoto, but you do need a lens
with a built-in tripod mount so that you can
affix it to a stable base. You can build a
compact telescope that is powerful enough
for observing details on the surface of the
Moon using a mirror telephoto with a 2x
teleconverter and a 20mm eyepiece. The
relatively small maximum aperture of most
mirror lenses is not a significant disadvantage,
especially at full moon, but if you want to
observe clusters of stars, fixed focal length
lenses are a better alternative. The image
quality and brightness of many camera lenses

is directly comparable with that of even the
most expensive telescopes.

The type of eyepiece you use and the focal
length of your lens influence the
magnification you can achieve. To calculate
the exact magnification, divide the focal
length of your lens by the focal length of the
eyepiece. For example: a 300mm lens used
with a 25mm eyepiece results in a 12x
(=300/25) magnification, and a 10mm
eyepiece would result in a 30x magnification
if used with the same lens. If you are using a
zoom lens, you can calculate the zoom range
of your improvised telescope by inserting the
limits of the zoom range into the same
formula. You can also use a zoom eyepiece
(7-21mm is a common range) in conjunction
with fixed focal length lenses to produce a
range of magnifications. 

Converting Your Lens

The simplest type of conversion involves a
modified lens cap, a T2-to-eyepiece adapter
and a special mount for the eyepiece. The

adapter and mount are available at most
specialist astronomy stores
(www.buytelescopes.com, for example). The
custom lens cap forms the join between the
lens and the eyepiece mount and you will
need to make a hole in it that can
accommodate the T2 thread end of the
mount. First cut a rough hole using a metal
drill or a fretsaw, then smooth the edges of
your hole using a semi-circular file until the T2
thread just fits into the opening. The final step
involves cementing the eyepiece mount to
the lens cap using two-component epoxy or
superglue. The join has to be stable, especially
if you are planning to mount a camera on the
eyepiece later. Now all you have to do is fix the
modified lens cap to the lens and mount the
eyepiece in its holder.

Focus your lens to infinity and adjust the
eyepiece until you can see a sharp image.
Now, you can fix this setting using the blind
set screws in the eyepiece mount. This
method works for most lenses, so if you are
unable to focus a sharp image, it is probably
because your lens doesn’t have sufficient back
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A suitable adapter and
eyepiece turn a
telephoto lens into a
bright, high-quality
telescope

Using Telephoto and Macro Lenses 
as Telescopes and Microscopes

Home-build Photography | Telescopes and Microscopes

Old lenses, macro bellows and spacer rings are the basic components
for converting lenses into telescopes and microscopes



focus range. To work around this problem,
shorten the eyepiece mount by a couple of
millimeters using a hacksaw.

The refractor telescope you have just built
produces an inverted mirror image and is
ideal for observing the Moon or the stars. 

If you want to use your telescope for
nature observation, you will need to insert a
roof prism or a diagonal prism between the
lens and the eyepiece. A roof prism produces
an upright, non-mirror image while a diagonal
prism produces an upright mirror image of
the subject. 

However, attaching a prism lengthens the
light path within the telescope and can
prevent your lens from forming a sharp image
at infinity. You can often work around this
problem by shortening the eyepiece and/or
the prism. 

If you own an old telephoto lens with a
built-in T2 thread (such as a 500mm Beroflex)
you can even screw your eyepiece mount

directly to the lens without modifying the lens
cap first – there is no simpler way to turn a lens
into a telescope!

Digiscoping

The idea of using a compact digital camera to
take photos through your home-made

telescope may seem an odd one at first, but
the technique does have some distinct
advantages. Compact cameras generally
produce less camera shake than their larger
SLR counterparts, and the live view on the
camera’s monitor helps you to compose your
shot before releasing the shutter. This
arrangement is easier to set up and allows
other people – including children – to see
what’s going on.

Another advantage is the large
magnification factor provided by the
combination of lens and eyepiece, which
often allows you to shoot highly magnified
details of your subject, such as the surface of
the Moon. Most specialist astronomy stores
carry a range of adapters for attaching
compact cameras to various types of
eyepiece. You can also use a camcorder or a
webcam to record moving images at extreme
(and otherwise unobtainable) focal lengths.

Using this technique can produce vignette
effects, and even fully circular images with
black borders. It is therefore advisable to use
an eyepiece with the widest possible aperture
and largest possible field of view (i.e., with the
shortest possible focal length).

87c’t Digital Photography 11 (2013)

Home-build Photography | Telescopes and Microscopes

The eyepiece is
fixed to its mount
using blind set
screws.
Magnifications vary
depending on the
focal length of the
eyepiece.

A diagonal prism
gives you an upright

image and a
comfortable viewing

position above the
main body of your

telescope, which is
particularly useful in

outdoor situations

DANGER AHEAD: To prevent severe
damage to your eyes, it is essential to
mount a special glare reduction filter
on the front of your telescope before
observing the Sun.

Quick Tip

The conversion job requires an eyepiece (A),
a T2-to-eyepiece thread adapter (B) and a
customized lens cap (C)

A

B

C
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If you want to shoot shake-free stills or
video through a telescope, it is important to
use a stable tripod and, if possible, a cable or
infrared shutter release (or the camera’s
built-in self-timer). This way, any vibrations
caused by adjustments you make to the
telescope can dissipate before the shutter is
released. If you own more than one telephoto
lens, you can use one with your home-made
eyepiexce adapter for observation purposes,
while you use another for taking photos. This
comes in handy during long, timed exposures
of astronomical subjects – extra observations
area a great way to pass the time. 

A Simple Microscope

Instead of a telephoto lens, you can use a
macro lens with your eyepiece adapter to
create an improvised microscope. Depending
on the focal length of the lens and the type of
eyepiece you use, this can give you a highly
magnified view of the fascinating macro
world. You can use a macro lens microscope
handheld for focal lengths right down to
50mm (for example, for outdoor plant or
insect observation). An improvised portable
microscope can also help you find elusive dirt
and dust when you are cleaning your DSLR’s
image sensor.

It is best to use a lens with a focal length of
at least 150 mm for the stand-mounted
version of our microscope, as these usually
have a tripod mount built in. You can also use
a telephoto lens with a bunch of spacer rings
to achieve similar effects. If the automatic
aperture built into your lens cannot be

controlled manually, you might have to put it
out of action yourself. This can usually be
achieved by carefully inserting a small piece
of plastic between the spring-mounted
aperture tab and the lens mount (see
illustration above).  

You can build a simple stand for your
microscope using a clip with a tripod thread,
a baseboard (a kitchen cutting board, for
example), and a piece of square tubing.
Longer macro lenses allow you to use greater
subject distances to observe larger objects
(such as a whole tree branch) and to adjust the
lighting individually for your chosen subject.
You can use a simple reading lamp at home or
a pocket flashlight when you are out and
about.

Here too, you can use different eyepieces
to achieve different magnifications, or attach
a compact camera to the eyepiece to shoot
macro images that you would not otherwise
be able to  capture.

If your lens doesn’t have a manually adjustable aperture ring,
you will need to deactivate the aperture mechanism yourself.
Here, I used a small piece of plastic to wedge it in position.

You can use an adapter to attach a compact camera to your
home-made telescope

A 150mm f2.8 macro lens that has been
converted into a powerful microscope using
just a tripod mount and a simple stand
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Don’t be Afraid to Experiment
You can use your home-made eyepiece
mount to experiment with other lenses from
your collection. You are not limited to
modern, autofocus lenses, and you can
achieve striking effects using close-up lenses,
extension tubes, or teleconverters with your
new accessory. Try using a reversed standard
lens, or an old bellows unit, or a telezoom with
an extension tube, or a wide-angle lens. Many
‘retired’ lenses can be given a new lease of life
if used creatively. 

Depending on the eyepiece you use, you can
achieve magnifications of 1:1 and more 
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A macro photo captured using
our home-made microscope
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Some things are invisible to the human eye
because they happen too quickly, such as the
beat of an insect’s wing, a raindrop hitting the
ground or a bursting balloon. Such events are
normally beyond the image capture
capabilities of most cameras too, and mark the
point at which specialized high-speed
photography begins. 

Equipment

As with other photographic specialties, you
can achieve a certain degree of success by
using expensive accessories, but this
article aims to show you an easier way to
capture spectacular photos.

Apart from your camera, you will
need one or more flash units and a
photoelectric cell. We used the battery-
powered infrared ‘Jokie’ cell and reflector
manufactured by Eltima Electronic. This model
costs about US$180 and is small, light and
compatible with most popular DSLR cameras. 

Accessory flash units for mounting on the
camera’s hot shoe are better than studio flash

units for this type of shot, as studio units have
flash durations of between 1/500 and
1/1500 second, which is too long for our
purposes. Accessory flash is not as powerful,
but much faster, with flash durations as short
as 1/10 000 second. The table on the next page
lists the flash durations for a Nikon SB-26

Speedlight. You can also use softboxes or
other accessories to modulate the light from
your flash units. If your flash has a standby
mode, make sure it is ‘awake’ before you start
shooting.

High-speed Photography 
using a Photoelectric Shutter Release 

One of our first attempts to photograph
a falling water droplet 

The individual parts of the photoelectric release (from left to right): connector cable,
reflector, photoelectric cell, release cable and battery pack
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The Basic Setup

The electronic release we used consists of a
transmitter with a built-in receiver and a
reflector. These two components have to be
set up so that the transmitter beam is
reflected back to the receiver. The check light
switches off when contact has been made and
the camera can then be connected to the
transmitter using the special cable provided.
Now, when an object passes through the light
beam, the camera’s shutter and the attached
flash unit(s) will fire. 

The Jokie has a reaction time of
approximately 0.013 s, and most modern
DSLRs have a shutter lag of between 0.01 and
0.04 s, so you will need to allow for the
combined lag when planning your shot. This
means that once an object has passed
through the light beam, it will move a certain
additional distance before the camera’s
shutter releases. In order to calculate this
distance you would need to know the exact
speed of your object, so it is actually simpler
to set up the light beam a short distance from
the subject and make test shots to determine
exactly how far away it needs to be. 

Placing a ruler next to your setup can help
you to judge the required distance more
precisely, and you can mark your exact
shooting position on a strip of wood placed at
right angles to the ruler. 

Choosing a Subject and
Planning Your Shot
This type of release mechanism can be used
to photograph falling objects, timid animals
or flying insects. Photographing animals in the
wild always requires some luck as well as
patience. 

Whatever you decide to photograph, you
will need to plan your shoot carefully. The
more precisely you can predict your subject’s
movements, the better your chances of
capturing a unique photo. Your chances of
success are, of course, better in a controlled
home or studio environment where you can
reproduce the same conditions for every shot.
In order to make your efforts worthwhile,
remember to light your background properly

too. If you are working with liquids, a sheet of
glass placed in front of the lens (but outside
the field of focus) is a practical way to prevent
your gear from getting splashed. If that is too
complicated, a clear glass filter attached to the
lens is a good second best. It is difficult to
remove drops of water or milk from a lens
without damaging it, and you will be
surprised how far drops of liquid can fly! 

You can use an eyedropper attached to a
tripod to release individual drops of water and
you can use a soup plate or a plastic bowl as a
target. There are no limits to what you can

photograph, and a sugar lump falling into
coffee, or an olive falling into a cocktail glass,
or even strawberries hitting yoghurt all make
great subjects. Basically, you can drop
anything into any liquid – the results are
guaranteed to be interesting.

If you want to photograph larger objects
falling into water, try using an aquarium as
your target. A piece of a windshield wiper will
help you to get rid of the air bubbles that form
on the sides every time you drop a new object.

Make sure your object is not heavy enough
to beak the aquarium, although you can
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The final image. You simply have to accept slight deviations in the point of impact.

This setup is designed to capture a plum falling into a saucer of milk. We marked the precise
horizontal position and release height using the metal ruler and the dowel you can see in the
image above. The two parts of the photoelectric release can be seen flanking the saucer.
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Full power 1/1000 s
1/2 power 1/1100 s
1/4 power 1/2500 s
1/8 power 1/5000 s
1/16 power 1/8700 s
1/32 power 1/12 000 s
1/64 power 1/23 000 s



protect the bottom by taping or gluing a
piece of foam rubber to the glass before you
fill your ‘pool’ with water.

Shooting an Egg

The photo of the breaking egg shown below
was slightly more complicated to capture
than our falling objects. The basic element of
the setup was a sheet of wood with the
photoelectric transmitter and an improvised
crossbow attached. For this type of shot, you
have to be able to adjust the  camera position
to the left or the right. You can create a

background by placing black or white card, or
a large print of clouds, a sunset or other
landscapes behind the subject. 

I built the crossbow from a piece of
aluminum rail, a length of spring steel and
some string. This arrangement was powerful
enough to break the egg, but couldn’t
produce enough kinetic energy to shoot up
apples, strawberries or tomatoes. The egg was
placed in line with the aluminum rail and I
positioned the light beam to catch the bolt as
soon as it left the crossbow. Pebbles, a
sharpened pencil or a metal screw make
suitable ‘ammunition’, and a cushion placed

behind the stage prevents the bolt from
damaging anything. I wore protective
goggles, and I attached a clear filter to the lens
and covered the camera body with a plastic
sheet for added protection.

Once my setup was complete, I used a
balloon filled with sand to make some test
shots. I marked the positions of my sand ‘egg’
and the crossbow string with a pencil in order
to be able to reproduce them later for the
grand finale. Once I had adjusted the
crossbow to the right tension, had found the
right distance and direction and was happy
with the lighting, it was time to shoot for real.
It can take some time to find just the right
setup, but it is worth taking the trouble to get
a complex shot like this just right.

I glued the egg down with a one or two
spots of hot-melt adhesive to prevent it from
falling over or being hurled out of the frame
by the impact of the bolt. Nearly every shot
was a hit, and it was fascinating to see just
how different the results were, depending on
the consistency of the egg and the type of
projectile I used. Other variations include
shifting the launch position so that the
camera captures the projectile before,
during, or after its flight through the egg.
You can vary the composition of the overall
image too – for example, by using a picture
of a complete breakfast instead of a plain
background! 

If you are interested in reading more 
about high-speed photography, I recommend
Stopping Time by Harold Edgerton or Caught
in Motion by Stephen Dalton. (jr)  c
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Gluing your egg down
prevents it from shooting
out of the frame on impact

Strike!Make test shots using
a sand-filled balloon

The setup consists of several pieces of wood, the photoelectric transmitter and receiver, a
background picture and a home-made crossbow. A cushion behind the subject catches the
bolt. Remember to wear goggles and cover your furniture with some kind of protective
sheeting when you are shooting photos like this.
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You are sure to have seen time-lapse films
of a flower bud opening, the stars

traversing the night sky or a tree changing its
leaves during the course of the seasons, but
did you know such ‘passage of time‘
sequences can be recorded in a single image?

The technique is called synchroballistic
photography, which may sound complicated,
but is, in fact, quite easy to get to grips with.
Born at a time when analog photography was
still the norm, it basically involves fixing a
camera to a support and recording the motion
of an object as it passes in front of the lens.
The film is transported behind a vertical slit
aperture during the exposure, producing a
series of strip-shaped images on the celluloid
surface, which is why the technique is also
known as streak or stripe photography.

The idea was first used to analyze  missile
and projectile ballistics during the Cold War.
If you know the speed at which the film is
transported and the length of the moving
object, you can calculate the speed the object
is traveling using its length on film as a
reference. You can also use markings behind
the flight path to calculate the angular
momentum of a projectile (i.e., its rotation
around its longitudinal axis) or to detect any
wobble during flight.

British photographer Angus Leadley
Brown (www.serratedimage.com) has
developed this almost-forgotten technique
into an art form. There are no purpose-built
cameras available, so Leadley Brown built his
own by custom converting a hideously
expensive analog panorama camera. If 

the timing is right, his setup produces
phenomenal visual results, although the
special camera’s shutter lag of two seconds
makes it very easy to mis-time a shot,
especially if the subject involves any kind of
sports. The film has to be transported at
approximately the speed at which the subject
is moving.

Professor Andrew Davidhazy from the
Rochester Institute of Technology has
developed an alternative (and cheaper)
system that consists of a simple camera with
a motor-driven film transport mechanism
attached (see  http://people.rit.edu/andpph).
Although this approach also suffers from
timing difficulties, the major advantage of
using an analog device to capture stripe
images is that you can precisely adapt the
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Oliver Lau

Synchroballistic Photography

Alongside an arsenal of monstrous weapons, the Cold War gave rise to an
interesting image capture technique called synchroballistic photography.
Originally intended for studying the behavior of missiles and other projectiles in
flight, this clever idea can also be used to create fascinating collages from digital
video footage. Our custom VStripe software (included on this issue’s free DVD)
will help you make your own synchroballistic images.



speed of the film transport (i.e., the exposure
time) to fit the duration of the movement you
wish to capture.

The approach that we are about to
describe doesn’t have this advantage, but
does away with all the other disadvantages of
using an analog sysetm. Instead of an analog
stills camera, our method uses a digital video
camera to capture stripe images, although
you can also use video mode in a digital stills
camera to achieve similar results. The only
other gear you need is a tripod and, if
available, a motor-driven turntable. 

Once you have captured your images, you
can use our unique VSTripe software to
convert your video file into a single time-lapse
photo. The software’s four modes allow you
to produce varied effects that are often
surprising. The software is included on this
issue’s free DVD as a 64-bit binary for Mac and
a 32-bit binary for Windows. You can also
compile the source files yourself (see the
install.txt file included with the archive for
details). The DVD also contains the video
sequences used to produce the images
printed here as well as some other sample

sequences for you to experiment with, and we
have included a video tutorial to help you get
to grips with the software. The following
sections explain how it all works.

What Actually Happens

To simulate the stripe-based form used to
record synchroballistic images, the software
extracts a vertical or horizontal one-pixel
stripe from each frame of the video sequence
and merges these together (again, either
vertically or horizontally) to form the finished
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This stripe photo was captured
on celluloid in the 1980s

Stripe photography techniques can 
be used to calculate the effective viewing

angle of an LCD monitor. This image shows
the result of panning a video camera 

around a stationary monitor.
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Stripe photography techniques can also
be used to create panorama images. This

sequence was captured using an old
digital compact set to shoot at 240 frames

per second and attached to the turntable
of a disused microwave.

In this sequence, our model sat on a
swivel chair and rotated once around
his own axis. Depending on which
mode you use, the results produced by
VStripe are quite different and can be
really weird. If the face is captured
using a fixed stripe in its center
(above), it appears to be ‘rolled’ onto
the virtual film, similar to the way
fingerprints are taken. If, however, we
let the stripe move through the frame,
the finished image captures some of
the rotational movement of the chair.
Fixing the stripe at the tip of the
model’s nose produced the odd,
sausage-like effect shown on the left.

Video Stripe image

A schematic overview of the four
modes offered by the VStripe

software. As you can see, the faster
an object moves, the more

compressed it appears.



image. In its default mode, the software leaves
the central stripe ‘standing’ in a fixed position
just as the equivalent analog process does. Its
other modes allow the central stripe to drift
from left to right (or top to bottom).

Use the File > Open Video File command
or drag your clip to the program window to
open it. The first frame of your clip will be
displayed and the program will open an
additional window with the same dimensions
as your video frame. The size of this window
determines the size of the rendered image.
You can alter the width of the image if you use
a vertical stripe, or its height if you use a
horizontal one.

To position the stripe, simply hold the
mouse button down and move the cursor to
your desired location within the main
window, using the Ctrl key to switch between
vertical and horizontal orientation. If you drag
the stripe out of the top or the left-hand end
of the frame, it will move through the image
during rendering.

If you only want to process part of your
video clip, you can set start and finish points
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A stripe fixed at the position of the railroad crossing was used to capture the
movement of the train and a cyclist crossing the tracks. The lower image was
rendered with luminance correction, the one above without.

VStripe’s main program window includes controls
for navigating around your video clip, setting start

and finish markers, setting the position of the
stripe and choosing the position for the reference

frame that determines the level of luminance
correction in the finished stripe image



using the [A and B] buttons. To completely 
fill the preview window, the program
automatically drops frames or records stripes
that are wider than one pixel where necessary.

The ‘Mark’ button enables you to mark
interesting places in a clip,that can be saved,
along with the path to the source video, to a
project file (File > Save Project As), which you
can reload (File > Open Project) and edit later.
The Edit > Clear Marks command deletes all
current marks.

The other buttons beneath the video
window enable you to move to the next mark
or back and forward by a single frame or in
50-frame jumps. Click on the ‘Start rendering’
button and the program begins importing
stripes according to the settings you have
made. If the preview doesn’t turn out the way
you expected, click ‘Stop rendering’ and start
over.

Once you are satisfied with the results, you
can save your rendered image as a JPEG or

PNG file using the File > Save Picture As
command.

H.264 AVI files are the best source material
for use with VStripe. It can handle other codecs
and container formats, but clip navigation
doesn’t always work as smoothly with these
as it does with AVI. If you need to recode, edit
or scale video footage, we recommend using
the free Avidemux software package (see
avidemux.org). 

Luminance Correction

Variances caused by automatic exposure
metering or other unexpected changes in
brightness during a clip can cause  luminance
to vary from stripe to stripe – an effect that
produces flicker in conventional time-lapse
films.

VStripe includes functionality that can
compensate for these discrepancies. The
software automatically records the average

red, green and blue values aa well as
average luminance for each rendered frame.
You can then use the R, G, B and L sliders in
the preview frame to adjust any drift to
match the average values as closely as
possible.

The effectiveness of this retroactive
correction is, of course, limited, and it is always
preferable to avoid changes in brightness
while you are filming by using manual
exposure and white balance settings. Using  a
tripod also helps to avoid the wave-shaped
anomalies that creep into the finished image
if the camera is not held completely still
during the shoot.

If we have whetted your appetite and you
want to see more of this type of image, search
for ‘Slitscan’ on flickr, where you will find a
wide-ranging collection of stripe images that
even includes videos made from
chronological sequences of finished stripe
photos. Have fun experimenting! (ola) c
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Once the stripe reaches the end of the clip,
it jumps back to the beginning. In this
example, a render frame that was twice as
wide as the video frame produced a double
image of this tree through the seasons.

Whether the subject is a 24-hour London skyline or a revolving windmill, the effects

produced by stripe photo techniques are always interesting and unusual
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Sascha Steinhoff

Open Source
Workflow Tools



Anyone returning from a photo trip with
hundreds of images will usually want to

sort and process their haul as efficiently as
possible.

A conventional RAW processing workflow
requires the use of a RAW converter to convert
the image data to a universal format and an
editor to give the resulting images their final
polish. The editing features in most RAW
converters are  not usually sophisticated
enough for advanced photographers.
Photoshop and GIMP, for example, use an
additional RAW conversion module that
converts image data before handing it over to
the main editing module. 

This approach is fine for photographers
who occasionally process a RAW file or two,
but too clumsy if you need to process large
batches of files. The new breed of all-in-one
photo workflow tools like Apple Aperture or
Adobe Lightroom offer a complete data
conversion, editing and management
solution in a single interface, so experienced
Lightroom and Aperture users rarely have to
resort to using a separate image editor at all. 

This trend has taken hold in the open
source space too, so we decided to take a
clook at the latest generation of free all-in-one
tools to find out how they compare with
today’s commercial offerings.

Our Test Candidates

There is no shortage of RAW-compatible
editing programs in the open source world,
but genuinely useful all-in-one workflow tools
are less common. This test only covers RAW
editors that offer comprehensive image
editing functionality and are aimed at
experienced users. Due to their lack of
additional functionality, widely used and
user-friendly programs like Shotwell didn’t
make the cut. 

We ended up testing seven programs,
ranging from the ultra-lightweight Rawstudio
to feature-rich digiKam, which – on paper at
least – is just as powerful as Lightroom. We
tested each program’s RAW conversion,
image editing and archive management
capabilities to find out which is the best at
performing each of these major tasks.

While most commercial workflow
packages are not available in a Linux version,
many open source packages are available for
Linux, Windows and Mac. The best-known
universal open source tool is the mature GIMP
package. In cases where the developers of our
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Dedicated RAW converters, image editors and databases are no
longer the tools of choice for digital photographers. All-in-one
tools such as Adobe Lightroom currently rule the market, but the
open source community isn’t far behind, offering a whole range of
photo workflow tools of its own. We took a closer look at the
latest generation of free image management software packages.



test candidates offer Mac and/or Windows
versions, we tested these too, using either
OS X 10.7 or Windows 7. 

The Mac versions on offer quickly proved
quite disappointing, so we decided not to
subject them to the same comprehensive test
as the other versions. Photivo was the only
program we found that offered a smooth
dmg-based installation on a Mac. However,
even this package crashed regularly while
importing a relatively small batch of error-free
NEF files to our Mac Mini testbed.

Windows users have a much wider choice
than Apple fans, and we were able to test a
much broader range of features using
Windows-based test software. 

A direct comparison of all our test
candidates was only possible using Linux,
because it is the only operating system
supported by all of our selected programs. We
tested the latest (stable, non-experimental)
release of each on a Ubuntu 12.04 system and
also performed some random tests using the
older versions listed in Ubuntu’s built-in
Software Center. 

The Linux versions of most of our test
programs are better developed than their
Windows counterparts, making it tricky to
compare the results directly. However, our
Linux tests still gave us a good overview of the
strengths and weaknesses of each program’s
overall concept.

Our Test System

We used a 3.3 GHz dual-core Intel Sandy
Bridge system with 16 GB of RAM. Instead of
risking the bottlenecks often produced by
conventional hard disks, we used a Sandforce-
based SATA3 SSD to perform our read/write
tests. This setup is more than sufficient to
master most conventional 2D image editing
tasks. We used a dedicated Radeon HD 7750
graphics card to ensure that the test software
had access to contemporary graphics
accelerator technology (such as Open CL) if
necessary, and we used the latest AMD drivers
on our WIndows and Linux test systems. RAW
converters are known to use a lot of resources,
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We only tested tools that are capable of importing
(top) and editing (center) RAW image data. These
illustrations show the modules incorporated into
digiKam. Import automation functionality (right) is a
bonus feature offered by some of our test candidates.



so, to ensure stable testing conditions, we
used the 64-bit versions of both operating
systems.

The Pros and Cons 
of Image Databases
The first step in any photo workflow involves
importing and sorting image files. Some
programs have their own built-in databases,
others give the user direct access to the image
files, and some offer both approaches. An
advanced file manager or image viewer is
usually sufficient to effectively move or delete
files, and most workflow tools have one or
other of these tools built in. Simple filename
searches can usually be performed using
file-based systems too, although these quickly
reach their limits if you want to search
through large numbers of images. Searching
an entire archive can involve several minutes
of apparent inactivity while the program does
its job, severely limiting the complexity of the
searches you can perform.

If you need to perform complex searches
on your images, the best approach is to
keyword them and use a program with a
built-in database. Even users who don’t

particularly like using metadata can benefit
from the Exif search or geolocation features
offered by a database. However, databases
have their limitations and make the entire
photo workflow technically more complex.
For more on the strengths and weaknesses of
database systems, see our article on the
subject in Issue 9 of c’t Digital Photography. 

Generally speaking, it’S not a good idea to
use a database if you regularly access your
files via your computer’s file system or edit
them using multiple programs. Workflow
tools with built-in databases work best if you
stick to using the single built-in interface for
all your photo workflow tasks. 

Our test candidates cover the entire
gamut, from the sophisticated database
functionality offered by digiKam to the simple
file-based approach offered by RawTherapee.
Hybrid programs such as Fotoxx and
GTKRawgallery offer both modes of operation.

Data Management and
Compatibility
Any image management software worth its
salt must be capable of sorting, moving and
deleting not only image thumbnails, but also

the actual image files stored on your system’s
hard disk. 

Whichever system you opt for, it is
essential for your program to create and
display thumbnails of each image. In the
course of our test, we used three different
groups of image files. The first was a mixed
batch of 150 RAW files captured between
1996 and 2012 that presented a serious data
compatibility challenge, while the other two
comprised 28 images each, saved in a wide
variety of formats using GIMP and Photoshop.
These included conventional formats such as
JPEG and PSD, as well as various compressed
TIFF formats and exotic formats such as
ScitexCT and Targa. A good program should
at least recognize the existence of all these
images, even it is not capable of displaying a
thumbnail of the less conventional types. If
your program doesn’t acknowledge the
existence of files it doesn’t recognize, you run
the risk of deleting folders that still contain
data.

In order to process a file, a program has to
fully support its format. We assumed that this
was the case for all the images our test
programs were able to open and didn’t class
errors such as incorrect white balance or
gamma correction as knockout criteria, as
these can usually be corrected later using a
custom profile. On the other hand, programs
that produced visible artifacts or severe color
errors were disqualified. To produce
consistent test results, we opened every
image in a 100% view using each program,
thus ensuring that the software accessed the
actual images files and not just thumbnails
that were created and stored separately. 

Subjective and Objective
Performance
Adequate performance is a must – these days,
no-one is prepared to let batch conversion
processes run overnight the way they used to
in the early days of digital image processing.
To judge batch conversion speed, we
converted two different batches of images to
JPEG using each program’s default settings.
The first batch consisted of NEF files shot
using a Nikon D7000, a widely used DSLR that
we expect most contemporary software to
support. This test was designed to help us
judge processing speed for an ideal batch of
well-sorted images stored in an
easy-to-recognize format. The results (timed
using a stopwatch) were thus directly
comparable. 

For our second performance test, we
converted the same batch of mixed RAW files
that we used for our data compatibility test.
This particular test was designed to test each
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Only a few open source projects offer usable Mac support. The Mac version of darktable is
highly experimental and is not intended for everyday productive use.

RawTherapee (shown here in its Windows version) accesses the computer’s file system
directly without importing any data at all. This approach is less prone to errors than program
architecture that uses a dedicated image database.



program’s robustness when switching
between supported and unsupported
formats. The results are not directly
comparable because the various programs
have different recognition rates, but any
program that finished this task without
crashing and produced usable results in the
process can be considered stable enough for
daily use. We performed both performance
tests for Windows 7 and Linux using the same
hardware, making the results a useful
indicator of the comparative speed and
robustness of the Windows and Linux versions
of each package. 

We edited images manually to get a feel
for the subjective performance of our test
software – in other words, how fast it ‘felt’
during real-world use. Because it is impossible
to measure this type of performance
empirically, we were unable to compare the
various programs directly. Some of our test
packages also use clever workarounds (such
as reduced-size thumbnails) to improve their
subjective performance. This might make

things feel quicker, but actually hinders image
fine-tuning by making it more difficult to
access the 100% view of the actual image file.
This type of software should be capable of
operating smoothly at all magnifications,
including 1:1. We only addressed this
particular aspect of each program’s
performance during our test if it produced
detectable anomalies.

Long Live the Workflow!

Every photographer has his or her own
particular methods and standards, so the
question of exactly which factors comprise a
‘good’ workflow cannot be answered
objectively. Those in a hurry will often convert
whole batches of images using a program’s
default settings or a custom profile, often
producing perfectly acceptable results quite
quickly. All of our test programs have batch
modes that deliver varying results, but the real
yardstick of any workflow tool’s quality is its
editing functionality. To get the very best out

of each individual image, you will have to
invest time and effort reviewing and adjusting
each file separately according to its particular
needs. No-one has yet come up with a reliable
way to automate color corrections in digital
images. 

Our declared aim while testing the core
workflow capabilities of our open source tools
was to achieve the best possible image
quality. With this in mind, we checked out the
manual editing capabilities of each very
carefully. The underlying software
architecture played a crucial role in the quality
of the results, and many programs still use a
conventional layout with separate windows
for the file manager (or album view), the RAW
converter and image editing.

A more contemporary approach saves the
user the trouble of constantly switching
between windows by providing a single
window with separate tabs for each of the
major functions. This degree of integration is
particularly important when it comes to
smoothing the path between RAW conversion
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digiKam reliably converts
mixed RAW files, and doesn’t
falter if it comes across a
format it doesn’t recognize.
Most of the other test
candidates crashed or
produced faulty conversions
and/or black thumbnails when
performing similar tasks.

Database functionality like that built
into digiKam allows you to efficiently
apply varied search criteria to large
numbers of images



and image editing. If these two essential
functions are separate, the workflow is
unnecessarily clunky and it is much more
difficult to fine-tune images effectively.

It’s Not Lightroom for Free, but
it’s Closeˇ…

The good and the extremely average often
exist in close proximity in the world of open
source photo workflow software, as shown by

our table of results and the individual tests
detailed below. The basic functionality of this
type of program has improved enormously in
the last few years, and packages like digiKam
and RawTherapee are – visually at least – a far
cry from some of the earlier Linux-based 
RAW converters. Many of today’s programs
have well-thought-out interfaces too, and are
just as easy to use as their commercial
counterparts. In spite of all these
improvements, there is still no open source

all-in-one that can genuinely compete with
Adobe Lightroom. To achieve that particular
milestone, someone would have to combine
the best parts of digiKam and RawTherapee
and tweak the interface of the resulting hybrid
too. 

Quality control is obviously still quite low
on the list of priorities for many open source
developers and we experienced a surprisingly
high incidence of crashes during installation
and use of our test programs, in spite of the
reputation Linux has for robustness and
reliability. The overall reliability level of the
Linux system in our particular scenario felt like
that of early Windows 9x versions – a verdict
that doesn’t really do justice to an otherwise
excellent system.

If you want to try out these open source
tools in a Windows or Mac environment, you
should be aware that this is never going to be
as pleasant an experience as using them with
their native Linux operating system. The
comprehensive compatibility information
provided in many project wikis often
produces a false sense of security.

Only digiKam, Photivo and RawTherapee
offer usable Windows versions, and even
these require some quite time-consuming
troubleshooting during installation if they are
to work properly. Commercial Windows
all-in-ones are simply more robust and reliable
than the programs we tested. Our tests
showed that batch processing and other
performance benchmarks under Windows
were significantly slower than under Linux.
The Windows versions were also noticeably
less stable.

Although the basic architecture of
Apple’s operating system is very similar to
that of Linux, Windows users have much
more choice when it comes to selecting an
open source photo workflow tool. The few
open source projects that do support Mac
are often tricky to install and only support
older versions of the OS. RawTherapee 
has killed all Mac support and the last
version that it is compatible with is Snow
Leopard. If you install it in Lion, it simply
doesn’t start. 

In conclusion, we have to advise against
using Windows or Mac versions of open
source workflow tools in an everyday
computing environment. GIMP is an
exception as far as reliability and stability are
concerned, but its RAW converter still requires
more development if it is to compete in this
space. 

All the tools tested here are only really
reliable if used in a Linux environment, where,
in spite of their various shortcomings, they
offer an exciting alternative to many
commercial tools. Most of these tools have
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GTKRawgallery and RawTherapee both use the Dcraw RAW development module, although
RawTherapee is obviously much better at utilizing multiple processor cores (top), and does
so measurably faster than GTKRawgallery (bottom)

RawTherapee supports an impressive range of Linux and Windows operating systems,
although the performance of the Windows ports lags way behind that of the Linux originals.
Mac support is poor and only covers legacy versions of the OS. 



much more comprehensive RAW conversion
functionality than their commercial
counterparts, and they all allow you much
more control over the entire process, from
installation to image fine-tuning. Most
commercial applications take many of your
processing decisions for you, whether you
want them to or not.  

The decision to take the open source
photo processing route is less a technical
one and more one that depends on your
personal philosophy and, of course, your
budget. If reliability  and ease of use are key
to your work, you should probably stick to
using Aperture or Lightroom. If, however, you
like to get stuck in and tweak away to your

heart’s desire, open source tools are a great
place to start. They allow you to get as
creative as you like with no monetary or
other artificial limits. If we have whetted
your appetite, read on! The following pages
offer detailed reports on our selected test
programs and a guide to installing this type
of tool in Linux.
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OPEN SOURCE PHOTO WORKFLOW TOOLS
darktable digiKam Fotoxx GTKRawgallery Photivo Rawstudio RawTherapee

Author/Manufacturer darktable Team digikam Team Kornelix Daniele Isca Michael Munzert,
Bernd Schöler

Rawstudio Team RawTherapee Team

URL www.darktable.org www.digikam.org www.kornelix.com http://gtkrawgallery.
source forge.net

http://photivo.org http://rawstudio.org http://rawtherapee.com

Version tested 1.0.5 2.7.0 12.07 0.9.71 2012-05-22 2.1 4.0.9.3
Version in Ubuntu SW Center 0.9.3 2.5.0 12.01.2 – – 2.0 3.0.0
RAW converter Libraw Libraw Ufraw Dcraw Dcraw Rawspeed/Dcraw Dcraw
Operating System Support
Linux/Windows/Mac v/–/v v/v/v v/–/– v/v/– v/v/v v/–/– v/v/v
Installation notes Linux: also via PPA

Mac: experimental disk
image of version 0.9.2
only

Linux:also via PPA
Windows: using native or
KDE installer,
Mac: using Macports or
Fink

Linux: DEB and RPM 
packages available

Linux, Windows: source
code only

Linux: PPA only; 
Windows, Mac: 
standard

Linux: also via PPA Linux: no PPA, 
Mac: OS X 10.5 and 10.6
only, doesn’t start in 10.7
or 10.8 

Data Compatibility Test Results using 64-bit Ubuntu Linux 12.04 (higher numbers are better)
RAW files, 
thumbnail display

not measurable1 100% 2% 98% not measurable1 99.33% 87.33%

RAW files, processing not measurable1 89.33% 90.67% 89.33% not measurable1 93.33% 84.67%
Photoshop files, 
thumbnail display

39.29% 60.71% 60.71% 71.43% 57.14% 42.86% 7.14%

Photoshop files,
processing

25% 46.43% 28.57% 57.14% 57.14% 32.14% 7.14%

GIMP files, 
thumbnail display

17.86% 42.86% 35.71% 57.14% 28.57% 21.43% 7.14%

GIMP files, processing 17.86% 42.86% 25% 53.57% 28.57% 21.43% 7.14%
Performance Test Results using 64-bit Ubuntu Linux 12.04 (lower numbers are better)
Batch conversion of 
100 NEF files

3:08 min 2:58 min 4:29 min 16:58 min not measurable1 1:36 min 10:03 min

Batch conversion of 
150 mixed RAW files

not measurable1 3:19 min 4:41 min not measurable1 not measurable1 not measurable1 not measurable1

Performance Test Results using 64-bit Windows 7 SP1 (lower numbers are better)
Batch conversion of 
100 NEF files

– 4:47 min – not measurable 3 not measurable1
– 11:58 min

Batch conversion of 
150 mixed RAW files

– not measurable1
– not measurable 3 not measurable1

– not measurable1

Image Management
Direct access to file system – – v v v v v

Import to database v v v v – – –

IPTC/XMP editor v v v v – – v

Search functionality v v v v – v v

Image Processing
Color management v v – v v v v

Geolocation – v v – – – –

Face recognition – v – – – – –

Correction using lens profiles v v – – v v v
2

Tethered shooting v v – – – v –

Red-eye correction – v v v – – –

Spot removal tool v – – – – – –

Cloud export v v – v – – –

Ratings 4

Data compatibility not rated + ± + not rated + -

Batch mode speed + + + -- not rated ++ --

Handling + ± - + + + +

Features + ++ - + + - +

1 Produced regular crashes            2 No profile provided            3 No Windows installer currently available           4 Applies when used with Linux
++ˇexcellent          +ˇgood          ± satisfactory           - poor          -- inadequate                                    vˇavailable           –ˇnotˇavailable



Concept/Installation: darktable is only
available for Linux and Mac. Its attractive
interface is based on the designs of popular
commercial tools, and the project is
sometimes even referred to as the free
alternative to Lightroom. At the time of
testing, version 0.9.3 was available via the
Ubuntu Software Center, although the
upgrade to version 1.0.5 is available as a
user-friendly Launchpad package. 

Compatibility/Performance: Our test
selection of new and legacy RAW files proved
to be an insurmountable hurdle for darktable,
which crashed regularly during an attempted
import. These crashes were caused by a number
of our (admittedly exotic) files, making it
impossible to test the import process properly.
digiKam uses the same RAW converter module
as darktable and didn’t encounter the same
problem, so we can only conclude that the
crashes are due to the program’s architecture

rather than any underlying shortcomings in the
RAW converter itself. Recognition rates for our
GIMP and Photoshop sample files were below
average, but we had no problems importing
our standard-format NEF files captured using a
Nikon D7000.

Handling: We very much liked the darktable
single window design, which sets it apart from
older, multi-window designs like the one used
in digiKam. 

darktable has no built-in file management
functionality, making data management quite
tricky. Deleting an image in the light table
view removes only the thumbnail but not the
image file itself. The sophisticated search
function is very useful for searching through
large numbers of images provided you know
what you are looking for. However, if you are
randomly scanning a collection, the lack of
hierarchically arranged folders makes it quite
difficult to achieve usable results. 

The RAW conversion and image
processing modules left us feeling somewhat
undecided. The range of filters the program
offers is unequalled, and includes artificial film
grain, adjustable gradients and a
sophisticated Ansel Adams-style zone system
for adjusting exposure. On the downside,
curves adjustments are hard work due to the
stodgy response of the control curve, and we
felt the lack of some standard features such as
usable input presets. RawTherapee, for
example, is much better developed in this
respect. 

Conclusion: darktable’s most obvious trump
card  is the design of its interface is , but it has
some catching up to to in the functionality,
stability and compatibility stakes. In its current
form, it is a good choice for tinkerers, but is
not yet sufficiently well developed for those
who don’t want to deal with surprises in the
course of their everyday photo workflow.
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darktable❮❮

darktable crashed fairly regularly during our
test, and RAW formats that it didn’t
recognize killed the process immediately

The darktable project is much younger than most of the software we tested. Its workflow-compatible interface is nice
to look at and easy to work with, and provides the largest selection of filters of all our test programs.
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Concept/Installation: Installing digiKam via
the Ubuntu Software Center is simple, even
for beginners, although there are more
up-to-date versions available from the project
website. If you want to use the most recent
stable release, you either have to compile it
yourself or download a ready-compiled copy
from a third-party source. 

Compatibility/Performance: digiKam was
the only test program that was able to import
and display all 150 of our RAW test files,
although it still left some gaps in our GIMP and
Photoshop test collections. Overall, it put up
one of the best compatibility performances in
our test.  

The well-integrated file manager module
allowed us to manage data directly at file
level, and it was easy to move or delete
unwanted files. The built-in database
functionality makes it a clear choice for
dealing with large collections of images, and
the import module includes settings to help
you import images that are already sorted into
folders and sub-folders. The program is also
capable of using metadata and complex
searches to help you keep your data sorted on
a logical level.

Thanks to its optional MySQL support,
digiKam can – theoretically – be used in
multi-user environments. However, this
functionality is still under development and
we can only really recommend the software
for single-user home use. 

Handling: The program’s rather old-fashioned
design forces the user to switch windows
regularly. RAW conversion and image editing
functionality are both located in the image

editor module, but editing options only
become available once you have finished
importing your data. Generally speaking, 
the all-in-one approach taken by darktable
and GTKRawgallery makes program handling
easier but reduces functionality. For
example, the more complex digiKam offers
no less than 11 different RAW decoder
algorithms. 

There is a huge range of image editing
tools available, although some are quite
tricky to use. For example, filters can only be
opened and applied one at a time, which is
okay when you only have a few images to
process, but too cumbersome if you are
working on a whole collection. Other tools

include geolocation functionality, lens
correction and face recognition. 

Conclusions: Viewed as a whole, digiKam is
the most powerful of the tools we tested. It
works extremely well as a database access
module, but put in an average performance
as a photo workflow application. Its old-school
multi-window interface is clumsy to use and
the more contemporary approaches taken by
darktable, GTKRaw gallery and RawTherapee
are superior when it comes to processing
large numbers of RAW files. Batch processing
is one of digiKam’s strengths and its dedicated
module balances a wide range of options with
user-friendly handling. 

digiKam❮❮

digiKam’s wide-ranging functionality is
distributed across a multi-window interface
that forces you to switch regularly between
the album view, RAW converter and image
editor windows. This architecture is simply
old-fashioned.

digiKam‘s user-friendly batch processing module is easy to use even though it
includes a huge range of options
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Concept/Installation: Fotoxx is a purely Linux
application designed for photo editing and
collection management. It uses the UFRaw
RAW conversion engine, which is based on
the widely used Dcraw technology. Ubuntu’s
Software Center includes a recent version of
the package, making it easy to get Fotoxx up
and running. 

Compatibility/Performance: Fotoxx has a
built-in file manager that gives the user direct
access to the underlying file system, but is
unfortunately incapable of displaying preview
images for most RAW files – a serious
drawback. The only RAW files the program can
‘see’ are older Canon TIFF-based CR2 files. This
and the clunky, non-intuitive interface make
Fotoxx unsuitable for managing mixed-format
collections. Batch performance is average and
recognition rates for GIMP and Photoshop files
are below average.  

Handling: Batch processing is simple and
effective, although RAW conversion and

image editing function completely separately
from one another. Editing steps are
performed on a TIFF or JPEG copy of the
original image. Converted images are
generally of good quality and the program
supports a similar number of camera models
to the competition. The only parameter that
the user can adjust during conversion is the
output format, and there aren’t many of those
to choose from. Exposure, noise
characteristics, white balance and other
fundamental parameters can only be adjusted
at the processing stage, which is far from ideal.

There is a wide range of useful image
editing tools, although these all have to be
opened using menu commands and are
rather clumsy to use as a result. Fotoxx is
modular and uses separate windows for most
major functions. For example, if you want to
alter the distribution of tonal values in an
image, you first have to open the histogram
via the menu, followed by the appropriate
filter. Fotoxx is also capable of managing
metadata and can apply geodata to files, but

here too, the clunky interface requires a lot of
concentration to use effectively. We can only
really recommend the software for processing
small numbers of images. 

Conclusions: Fotoxx offers a number of
interesting tools and artistic filters that are
great for jazzing up an image or two. The ‘Roy
Lichtenstein effect’ filter, for example, gives
images a highly individual appearance and
can be finely adjusted to suit your personal
taste. Various image combination tools allow
you to create HDR, HDF and panorama
images. 

Fotoxx won’t fulfill everyone’s workflow
needs, not least because of the completely
automated RAW conversion process.
However, if you are happy with the results
produced by the program’s preset conversion
profiles, this isn’t a major disadvantage, and
mixed RAW conversion batches don’t seem to
cause it any problems. All in all, this program
is better suited to tweaking individual images
than to managing entire collections.

Fotoxx❮❮

Painting simulation is just one of a number of interesting and useful artistic filter functions included with Fotoxx
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Concept/Installation: GTKRawgallery is
aimed at experienced Linux users. The current
release is an alpha version, and all versions
require you to do your own compiling. If you
are happy with this rather complicated
approach and you don’t mind using a
command line to start the application, you are
in for a pleasant time. The program offers a
clean, modern interface and includes a
RAW-compatible image editor that is belied
by the software’s somewhat misleading name.
The gallery module imports images to albums
or manages them directly via the file system.
The program works very smoothly, even
though the gallery and editor modules reside
in separate windows. 

Compatibility/Performance: The software
performed very well, producing the best GIMP
and Photoshop recognition rates in the entire
test. The package runs quickly and smoothly
using its default settings, although this is

partly due to the use of reduced-size previews.
Working with full-sized images and some of
the more complex filters (Oil Painting, for
example) is a lot slower. In batch mode, it was
the slowest we tested, taking almost 17
minutes to convert 100 files and crashing
during our attempt to convert mixed RAW
files. 

Handling: GTKRawgallery offers comprehensive
metadata functionality, allowing the user to
display complete Exif data sets and build
custom IPTC/XMP keyword sets. On the search
side, the program is only averagely powerful,
and lags way behind some of the others we
tested. 

The RAW conversion module does not
offer any user-controlled settings, and the
available editing functionality is basic but
reliable, although high-end features like
profile-based lens corrections are not part of
the deal. The before/after image view is useful

but cannot be zoomed to display a 1:1
preview. Truly creative photographers will
probably be disappointed with the relatively
small number of editing options, although
you can choose to export images directly to
GIMP for further processing. We did come
across a number of bugs in the course of our
test, but these are early days, and the package
promises a bright future if development
continues the way it has begun. 

Conclusions: This newcomer shows a lot of
promise, although its user-friendliness and
robustness still require some work. It covers all
of the photo workflow basics and scores
points for its slim footprint and elegant
processing module, especially in comparison
with heavyweight competitors like digiKam.
However, as long as the project provides
neither a website nor a usable installer, it is
destined to remain something of an insider
tip. 

GTKRawgallery❮❮

Some of the high-end features
in GTKRawgallery still don’t
work as smoothly as we would
have liked. The zoom function,
for example, doesn’t work in
the before/after view. 

GTKRawgallery can
access an external

image database, but 
offers much less

sophisticated search
functionality than

digiKam and others
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Photivo❮❮

Photivo’s default RGB
curves have just one
user-adjustable handle,
although you can add
more with a simple
right-click

It is quite easy to lose your way amongst the huge number of filters and tools that Photivo
offers. To help you keep track of where you are, the tools are arranged in tabs, and there
is a dedicated filter search tool to help you find the function you are looking for.

Concept/Installation: Unlike digiKam,
Photivo has never tried to fit the all-rounder
bill. It is simply not designed with data
management in mind and instead has a
strong emphasis on RAW conversion and
image editing functionality. The wide range of
tools and somewhat cryptic interface take a
while to learn.  

There is no GUI-based installer stored in
the Ubuntu Software Center, but there is a
PPA package available at the project’s
website. Photivo only works together with the
GraphicsMagick image processing system,
which has to run in 16-bit mode. According to
the project website, the correct version of
GraphicsMagick is automatically installed if
you use the PPA. In our case, we still had to
reconfigure the package to run in 16-bit
instead of 8-bit mode with the help of a guide
published at the Photivo website.

Compatibility/Performance: During our
tests, Photivo crashed regularly for various
reasons, including mixed RAW file import and

batch processing of NEF files, in spite of the
fact that the program is normally capable of
processing them. This explains the lack of test
values in the table of results. On the other
hand, it showed very good compatibility with
our Photoshop collection and produced
average results when handling our GIMP files.
Its default settings deliver brisk (subjective)
performance, but only because it uses
reduced-size preview images. Things slow
down appreciably when processing full-size
images. 

Handling: Once you have got past the
sparsely featured file manager, you get to
play with the image editor with its huge
range of more than 100 filters and tools, all
of which can be customized and saved as
new presets. RAW conversion and image
editing take place in the same window,
making the workflow as easy to master as its
Lightroom counterpart. 

The only real shortcomings we found are
the lack of a before/after view and slow

performance when processing full-size
images, which can make editing quite
tiresome. The lack of preset import profiles
makes life more difficult for novices but more
exciting for experienced users, who can tweak
the conversion and editing settings virtually
endlessly. There is no selective editing
functionality for removing dust marks and the
like, so you will have to use other, more
capable editors for this type of editing step.
The ability to save virtually all the program
and tool settings as presets makes it possible
to build highly customized workflows for use
in a range of different situations. 

Conclusions: Photivo’s mix of high-end
editing functionality and annoying instability
left us with mixed feelings. The quality of the
individual tools and filters is erratic too, so you
need to try each one out to see if it really
produces the effect you are looking for.

This package has great potential, but the
current release is not stable enough for
everyday use.
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Concept/Installation: Rawstudio is great for
converting large numbers of images at high
speed. Unlike most other open source
workflow tools, which use the Dcraw
conversion engine (or its LibRaw and UFRaw
derivatives), Rawstudio is based on its own
proprietary Rawspeed engine. However, it
also includes the Dcraw engine as a fallback
when it doesn’t recognize a particular image
format. 

Compatibility/Performance: The combined
conversion engines produced our best test
results, and Rawstudio recognized and
successfully converted 140 of our 150 test
files. Please note that these figures only take
the ability to convert into consideration and
don’t actually rank the quality of the
converted images. And this is where
Rawstudio disappointed us, producing visible
artifacts, color errors and incorrect white
balance, and even overlooking gamma
corrections for a variety of camera models.

These errors occurred in other programs too,
but not as regularly as they did using
Rawstudio. Check the quality of the results of
using your camera’s specific profile before
processing too many images. If necessary, you
can also use your own custom profiles.

Rawstudio was more sensitive than Fotoxx
and DigiKam to batches of mixed file types,
but produced consistently reliable results
when used with batches of a single file type
captured using just one camera. Once up and
running, it produced the fastest processing
results in our tests, converting 100 RAW files
in just one and a half minutes (compared with
the three to 16 minutes our other test
programs took). On the downside, it fared
poorly when processing our GIMP and
Photoshop test images, although these are not
really part of the program’s RAW-only
philosophy. Using its default settings,
Rawstudio is not capable of displaying
non-RAW files, although you can change this
setting in the viewing options. 

Handling: Rawstudio offers virtually no
image management functionality, with only
a very basic tagging tool for adding
keywords and no IPTC, Exif, XML or
geotagging support. The single-window
interface includes a preview bar and is ideal
for performing manual or automatic
adjustments to large batches of images. The
‘Lensfun’ feature enables the user to correct
distortion once the correct lens profile has
been manually selected. Otherwise, the
toolset includes only basic editing
functionality, so you will need to use an
external editor for fine-tuning. 

Conclusions: Rawstudio is a no-frills RAW
converter designed for the rapid conversion
of large collections of images. Although it
doesn’t provide enough editing functionality
for inclusion among the ‘real’ all-in-one tools,
it is a reliable converter on which to base the
rest of your workflow. 

Rawstudio❮❮

The batch processing module in Rawstudio is set out just as clearly as the rest of the program.
If you need more than just basic editing tools, RawTherapee is probably a better choice.
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RawTherapee❮❮

Concept/Installation: RawTherapee uses the
popular Dcraw engine to extract RAW data for
conversion, but uses its own libraries for the
subsequent demosaicing and interpolation
steps. 

Compatibility/Performance: This package
was the least successful in all our compatibility
tests, recognizing only JPEG and PNG files
among our GIMP and Photoshop test
collections. Its RAW recognition rate of 85
percent was quite low. It is slower than the
other Libraw- and Ufraw-based projects, and
took 10 minutes to process 100 RAW files.
Only GTKRawgallery (also based on Dcraw)
was even slower.

Handling: There is no database support, so
search functionality is rudimentary, although
the program does allow you to search using
whole or partial filenames and metadata
fields. The interface isn’t particularly attractive,
but is functional and intuitive, with all the

major functions grouped in a single window
and accessed via individual tabs. Nice details,
such as the green check marks that show you
which images have already been processed,
round out the program’s look and feel. 

The authors provide a range of preset color
and black-and-white processing profiles, so
even less-experienced users can try out
various effects on their images. You can also
adjust the settings that make up a preset and
save the results as a new preset. RawTherapee
offers extremely fine adjustment options for
virtually all processing parameters, even
including demosaicing, which can be
performed using one of several algorithms.
Such details definitely belong to the ‘extreme
fine-tuning’ category, and we were only able
to spot the difference between the effects of
the various algorithms by zooming right into
our images. 

The before/after view works smoothly and
can be zoomed (unlike in GTKRawgallery),

which is a great aid to adjusting fine details.
As of version 4, RawTherapee supports custom
lens profiles for correcting distortion,
vignetting and chromatic aberration, but it
doesn’t yet provide any profiles of its own.
Most other open source packages with similar
functionality use the profiles provided in the
free Lensfun library. 

Conclusions: RawTherapee is a useful
specialized RAW converter with workable
file system-based image management
functionality. This approach is fine for purists
who don’t require database access or don’t
want to deal with the extra effort it involves.
As a workflow tool, it combines wide-
ranging functionality with an attractive,
functional interface, and is thus ideal for
making manual adjustments to selected
images. Other programs are better and more
reliable when it comes to any form of batch
processing.

The RawTherapee interface
allows you to switch easily
between its file manager,
batch queue and image
editing tabs, making it 
ideal for setting up a
user-controlled workflow 

The zoom function makes 
it easy to visualize 
the results produced 
by the various 
demosaicing algorithms 
(here, Amaze and Hphd) 

Amaze Hphd



Today’s Linux fan can choose from hundreds
of different system flavors, and we plumped
for the beginner-friendly Ubuntu 12.04 for our
tests. The amount of work involved in
installing a workflow tool in Ubuntu depends
primarily on the form in which the software is
made available.  

Ubuntu Software Center

The simplest way to install software in Ubuntu
is using the system’s built-in repository.
darktable, digiKam, Fotoxx, Rawstudio and
RawTherapee can all be downloaded and
installed from the Graphics or Photo
categories using a single click. We were
unable to find Photivo and GTKRawgallery via
this route

Software Center automatically loads the
appropriate packages from known online

sources and automatically creates any
necessary dependencies where other
programs and packages are involved. It also
automatically loads any updates when they
become available. 

In its default configuration, Software
Center uses only ‘official’ Ubuntu sources that
have been through the system’s validation
process. This ensures that all releases are
stable, but the time involved in validation
means that the available packages are not
always the latest versions. 

Third-party PPAs

If you want to use a version of a program that
is not listed in the Software Center, you don’t
necessarily have to compile it yourself. You
can instead use PPAs (Personal Package
Archives), which you can also add to the

Software Center interface as additional
sources.

PPAs are either authorized by the project’s
owners or unauthorized, and the latter type
can be downloaded from wherever you
happen to find them. Ideally, a project will
provide its own PPAs, and most official links
to current  releases for Ubuntu take you
straight to the launchpad.net development
site run by Ubuntu’s parent company,
Canonical. 

The disadvantage of the latest packages is
that they are not always as well tested as the
authorized versions found in the Software
Center. For example, we had to start our
version of RawTherapee using a command line
and the Launchpad icons of some
applications didn’t always work.

Software from third-party sources always
poses a risk to the stability and updatability of
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Installing Photo Workflow Tools in Linux
Ubuntu’s Software Center makes installing the software stored there a simple matter of a single click. 
However, if you want to try out other versions of a program, things can get a bit tricky. This quick guide 
gives you the know-how you need to experiment.

Ubuntu’s Software Center is extremely
user-friendly and includes a broad
choice of RAW conversion and photo
workflow tools 

Websites like launchpad.net are a rich
source of installer packages, but be
warned: many of these are not the

‘original’ packages approved by the
project owners. If you are in any doubt as

to where a package originated, don’t
install it on your main system.
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a Linux system, and unauthorized packages
can even pose a security threat. 

In order to test the latest versions of
darktable, Rawstudio, digiKam and Photivo, we
used packages downloaded either from
authorized PPAs or from sources known to us
personally. The guide below uses darktable to
explain how to add a PAA to the Ubuntu
Software Center.  

Using Third-party Installers 

The Fotoxx website doesn’t provide any PPAs,
but does offer Debian packages for download.
These can be opened using a double click in
the Nautilus file manager. This automatically
opens the Software Center and the rest of the
installation process is self-explanatory. 

If you do use a Debian (.deb) package, be
sure to read the instructions carefully.

Although Ubuntu is generally capable of
handling them, not all Debian applications
are intended for use in the Ubuntu
environment. 

Manually installed packages don’t
automatically receive updates the way
appropriately configured PPAs do. Take the
same precautions with .deb packages that
you would with any other third-party
software. 

Do Your own Compiling

Neither the authors of GTKRawgallery nor
Ubuntu offer precompiled versions of their
software, so if you want to try it out, you have
no option but to compile the source code
yourself.  

The exact compilation procedure depends
on how the software is structured. The
instructions for our version of GTKRawgallery
were located in a readme.txt file included with
the unzipped source code files, whereas we
used a script (buildRT) that we found in the
project website’s forum to compile
RawTherapee.

Conclusion

The precompiled packages found in the
Ubuntu Software Center are the best choice
for beginners and more cautious users.
Advanced users can use software from
third-party sources via PPA, or independent
installer packages. Home compiling is a time-
consuming process that is usually the
preserve of enthusiasts who are keen to keep
their systems right up to date. (anm)

The official Ubuntu 12.04 software repositories contain darktable
0.9.3, although version 1.0.5 had already been released at the time
of our test. To gain automatic access to the latest version, you have
to add the appropriate source to Software Center. The following
steps explain how.

1. Find the right PPA

The Ubuntu Packages section of the Web page at
www.darktable.org/install/ contains a link to ‘darktable Release PPA’,
which takes you directly to the appropriate page at the
launchpad.net site. The Adding this PPA to your system section
includes the line ppa:pmjdebruijn/darktable-release, which you then have
to add to your system’s software sources. The system then
automatically selects the correct package.

Alternatively, use the drop-down menu in the Technical Details
about this PPA section to select a custom source line for your
particular version of Ubuntu.

2. Add the new source

Add your chosen source line to the Other Software list in the
Software Sources dialog in the Edit menu. The package manager
then creates two new entries in the list. 

3. Update the package list

Update the local package manager source list by entering the
following code in a terminal:
sudo apt-get update 

4. Install darktable

The latest version of darktable will now appear in the Software
Center ready for automatic installation. you may have to restart your
system to get new entries to appear in the Software Center interface.

You can also perform all the steps listed above from a terminal
window using the following commands:
sudo add-apt-repository ppa:pmjdebruijn/darktable-release
sudo apt-get update && sudo apt-get install darktable
The same new entries will then appear in the Software Center list.

Installing Packages from Third-party Sources

The system automatically installs
the correct package if you use the
source outlined above left. If you
use the URLs provided in the
drop-down (below left), the
system uses the source specific to
your version of Ubuntu c
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Managing Multiple Cameras with 

Lightroom
Lightroom is a great tool for managing large numbers of photos, but
does present some stumbling blocks if you shoot using multiple
cameras – whether at a party or family get-together, or on a
commissioned shoot. Pitfalls can hinder image export and automated or
manual processing steps, but this article details a range of tips and
tricks that will help you keep your workflow running smoothly, even
when you have your hands full of cameras.



Your cameras are set up, the batteries are
charged and your memory cards are

formatted and ready to roll. When you are
approaching a shoot using multiple cameras,
as well as planning your initial setup, you also
have to consider how to process the results
later. One very important aspect of the
process is synchronizing the date and
timestamps in your cameras. 

This is easy to achieve if you have access to
all the cameras being used, but at events such
as family parties everyone simply shoots away,
usually without adjusting their camera’s time
settings first. If you are the lucky person who
has been appointed ‘court photographer’ for
the event, you will most likely end up with a
huge collection of photos with widely varying
date and time data. In such cases, the best
way to ensure that you can identify when a
photo was taken is to get everyone involved
to take a snap of the same clock at some point
during the proceedings. The actual moment
is unimportant, as you only need to know the
difference between the captured time and the
camera’s own timestamp. You can then use
Lightroom to adjust each photo’s Exif data
accordingly (see overleaf).

Once the shoot is over, you can begin to
import and view your images. At this point, too,
Lightroom can save you a lot of work, as it is
capable of ‘remembering’ appropriate settings
for each camera, which it then applies
automatically during the import process – for
example, to compensate for a particular camera
model’s noise characteristics or ISO setting.

This functionality can be set up in the
Preferences dialog, which you can open using

the Edit > Preferences command or the Ctrl+U
keystroke (in Windows), or the Lightroom >
Preferences command (Cmd+U) on a Mac.
Activate the Make defaults specific to camera
serial number and ISO setting options in the
Presets tab. This enables Lightroom to save
presets for each camera/ISO combination that
was used during the shoot. 

In order to produce meaningful presets,
it is a good idea to shoot an ISO bracketing
sequence with each camera and make
appropriate noise reduction, sharpening

and other settings for each shot, which you
can then save using the Develop > Set
Default Settings command. Then, when a
photo that was shot using camera ‘X’ and
ISO value ‘Y’ is imported, Lightroom
automatically adjusts the import settings
according to your preset values. This allows
you to concentrate on any processing steps
required by individual photos. This method
can also be used to apply  camera profiles
that you have downloaded or made yourself
to your images.
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The simplest (but not
always the most practical)
way to sync cameras is to

synchronize the time
settings in all the cameras

you are using

Using camera-specific
preferences presets

simplifies the process of
editing photos captured
using multiple cameras

A great alternative timing method for family 
get-togethers is to have everyone with a 
camera take a picture of the same clock. 
This way, you can easily compensate for 
any differences between the camera (Exif)
timestamps and the real time.



Importing Images

Once you have made your basic settings, you
can import the contents of one memory card
after another. If you managed to synchronize
all your cameras’ timestamps in advance,
Lightroom automatically saves all your images
in chronological order.

If you are using the ‘clock photo’ method
described above, you will have to compare
the timestamp embedded in your photos
with the time set in the camera’s internal
clock. To do this, enable the Library module’s
filter function by pressing the ‘<’ key or the
View > Show Filter Bar command and use the

camera model or serial number filter to show
only the photos taken with any particular
camera. The serial number filter is particularly
useful if you are using multiple cameras from
a single manufacturer.

To adjust the shooting times to fit the Exif
timestamp, select the photo of the clock and
compare the time it displays with the Exif
timestamp displayed in the Library module’s
Metadata panel. If the times are not identical,
the following technique will help you to re-
synchronize your photos: first, select all the
photos taken with the current camera using
the Ctrl+A/Cmd+A keystroke (in Grid view).
You can then use the Metadata > Edit Capture

Time command or the button located next to
the ‘Time’ metadata field to adjust the
timestamp accordingly.

The resulting dialog contains various
options. In our case, we selected the Adjust to
a specified date and time option. Although this
sounds like it will make the date and time for
all the selected images the same, what it
actually does is overwrite the Exif timestamp
for each individual file using the difference
between the original time and the corrected
time data. All you have to do is enter the time
data recorded in the image of the clock in the
Corrected Time field and click the ‘Change’
button. All your selected images will now have

Lightroom | Managing Multiple Cameras

If the Exif timestamp is different from the time
shown in the photo of the wall clock (see the
previous page), select the appropriate camera in
the library filter dialog, select all its images,
adjust the time appropriately …
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… and the program automatically writes the correct time
to each photo’s Exif data



the correct time offset embedded in their
metadata. 

Renaming Files

Your images are now sorted chronologically
and Lightroom will display them appropriately
if you select the Capture Time view option in
the Library module’s grid view. You can now
begin to make your final selection, add ratings
and perform any necessary editing steps.
Lightroom exports images according to their
filenames (which differ from camera to
camera) and not according to their Exif
timestamp, so if you want to display your

selected images in the order they were shot,
you will have to rename them for export first. 

The Export Files dialog can be opened
using the File > Export command or the
Ctrl+Shift+E keystroke (in Windows) or using
Cmd+Shift+E on a Mac.

In the File Naming section of the dialog,
activate the Rename To option and select 
an appropriate renaming scheme from 
the drop-down menu – for example,
Filename-Sequence.

The scheme we selected starts with a
three-digit number that counts upward
sequentially, followed by an underscore and
the filename itself.

In addition to the Image # option, the
Sequence and Date section of the Filename
Template Editor also offers the slightly
cryptic-sounding Sequence # option. The
numbers created using the Image # option
begin with 1, 01 or 001, depending on the
number of digits you have selected, while
Sequence # allows you to select a custom
number to begin your sequence. Both
options count upward using whole
numbers, and the increment cannot be
adjusted. Once you have selected your
desired settings, you can start exporting
your images for distribution to your client,
your family or whoever you like. (jr) c
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Unfortunately, because it sorts
images according to their

filenames rather than their Exif
timestamps, Lightroom rearranges

the order of photos shot
chronologically during export. One

way to work around this problem
is to rename your image files

using one of the program’s various
naming scheme templates.

The Lightroom export dialog allows
you to choose the first number in a

sequence but not the increment
used to name each subsequent file

c’t Digital Photography 11 (2013) 119



c’t Di-



Images like the one on the left appear quite
normal at first glance. However, on closer

inspection, the unusual combination of a wide
angle of view with pronounced foreground
and background blur gets us thinking: was it
taken using a particularly bright wide-angle?
Or maybe, after all, with a telephoto located
at a fair distance from the subject? In fact,
neither can be the case – a telephoto would
produce a much tighter crop, while a
wide-angle would have produced much more
pronounced depth of field and no real bokeh
to speak of, as in the comparison images
shown on page 122. 

The solution to this conundrum is clever
use of wide-angle crops taken from telephoto
images. This technique has been popularized
by wedding photographer Ryan Brenizer and
is known as either ‘bokehrama’ or the Brenizer
method. The basic technique involves
shooting the portions of a scene that would
normally make up a wide-angle view one by
one using a telephoto lens set to its widest
aperture, and then merging the resulting
source images digitally using panorama
stitching software. For more detail on
panorama techniques see the c’t Digital
Photography articles listed on page 123. The
finished image combines a moderate wide-
angle view with shallow depth of field and a
strong overall feeling of depth. 

Choosing a Subject

The best subjects for bokehrama shoots are
larger objects or people located at a medium
distance from the foreground (and/or the
background). The subject itself should take up
only a minority of the space within the frame.
It helps to ‘think wide-angle’ while planning
your framing but to concentrate on the
telephoto lens you will be using for the shoot
while planning your depth-of-field effect. The
technique isn’t suitable for macro subjects, as
there is simply not enough depth of field
available to achieve usable results.

Static subjects don’t produce changes in
detail in the overlaps between the individual
source images, which makes it easier to merge
the source images later on. The subject in our
sample image only occupies the central
portion of the frame and only had to stay still
for a few of the shots in the sequence – in fact,
she could have left the scene altogether while
we shot the edge images.

During the Shoot
Your source images should overlap by about
a third, and it makes the merging process a lot
easier if you use a ball or panorama tripod
head to set up and adjust the camera’s
position during the shoot. However, handheld

source images can be just as effective, as our
sample image demonstrates. For detailed
information on how to stabilize handheld and
tripod-mounted shots, see the articles listed
in notes 4 and 5 at the end of this article. 

Set your camera to manual exposure mode
and make sure that you don’t alter exposure
or white balance, and especially not the focus
settings while shooting your source images.
Focus on the main subject, select a wide
aperture setting and shoot your chosen
sequence row by row. Many of the source
images will end up out of focus, but that’s
exactly the effect we are after. The feeling of
depth in the finished bokehrama image is
especially emphasized if – as in our sample
image – both the foreground and background
in the scene are out of focus.

To really do justice to the ‘bokehrama’
label, you should use a high-end lens with
good bokeh characteristicsˇ(see note 3
below). The image shown here was shot using
an AF Nikkor 85mm f/1.4D, a lens that is well
known for its wonderful bokeh. Another
highly suitable lens is the AF DC (Defocus
Control) Nikkor 105mm f/2.0D, which even
has built-in adjustable bokeh functionality. It
is useful to have a second camera with a
wide-angle lens on hand when shooting
bokehramas, so you can check your
composition without having to swap lenses.
It also makes it easier to judge the effect of
flash before you shoot.

When it comes to shooting with flash,
merging multiple source images has distinct
advantages. For our bokehrama sequence, we
were able to position our flash much closer to

We shot the source images for this
‘bokehrama’ using an AF Nikkor 85mm
f/1.4D lens opened right up and mounted 
on a Canon EOS 600D/Rebel 3Ti 
(with a crop factor of 1.6). 

To capture this image in a single shot would
have required an effective focal length of
26mm (or 41mm for APS-C) and an effective
aperture of f0.4ˇ[see note 6 below].

Workshop | Bokeh Panorama

Alexander Altmann

Bokehrama
Normally, photographers have to choose between using the large
angle of view provided by a wide-angle lens and the smooth
background blur that a telephoto produces. The innovative
‘bokehrama’ method gives you the best of both worlds.
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the subject than would have possible in a
single shot (see the left-hand image above). If
you move your light source gradually to the
side while shooting your sequence, you can
position it within the frame without running
the risk of having it show up in the final
panorama. 

If you shoot JPEG and RAW source images,
you can use the JPEGs to render a quick
preview panorama and check whether your
merge has worked.

Merging the Source Images

The Photoshop Photomerge tool does a pretty
good job of merging single-row panoramas,
but has its shortcomings when it comes to
merging multi-row sequences. Specialized
tools, such as Hugin (see note 3 below), are

available for free for Linux, Mac and Windows
and take a lot of the drudgery out of merging
complex sequences of images

Hugin functions largely automatically. To
begin the process, use the program to give all
your source images TIFF or JPEG filename
extensions. If your images contain Exif crop
factor and focal length data, Hugin detects it
automatically and uses it during the merge,
but you can enter this data manually if
necessary. Now click the ‘Align’ button to start
the merge process, which uses automatically
selected control points. If your source images
contain too much overlap, the program
automatically leaves out the ones it doesn’t
need to complete the merge.

If you are happy with the merged image
shown in the preview window, click the
‘Stitcher’ button followed by the ‘Stitch now...’

button in the dialog that follows. If the
resulting TIFF panorama contains errors, such
as the misaligned columns in our example,
you can adjust the control points manually
until you get the result you are looking for.
Sometimes all you need to do is delete the
control points with the most obvious
discrepancies from the list, but you can also
use the control point editor to edit their
positions or set new control points of your
own if you need to. Always save your project
after adding new control points and before
you generate a new preview. This way, if
anything goes wrong, all you have to do is
reload the appropriate PTO file and try again.
In our example, once we had found the right
control points, we only had to adjust contrast
and crop the resulting image a little to get the
result you can see on the previous page.
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These two comparison shots were captured at the same distance as the bokehrama reproduced on page 120. 
To keep the lighting consistent, we left the flash where it was. The left-hand shot was captured using a 35mm
(55mm full-frame equivalent) lens mounted on an APS-C camera, and displays much greater depth of field than
the right-hand image, in spite of shooting at f1.4. The angle of view in the left-hand image is slightly narrower
than that of the bokehrama but is much broader than that in the right-hand image, which was shot using an
85mm lens (also at f1.4) mounted on a Canon EOS 600D/Rebel 3Ti, giving it an equivalent focal length of 135mm.



In addition to its panorama functionality,
Hugin offers other advanced image
processing tools, such as the Mask, Exposure
and Stitcher dialogs. It is also capable of
producing HDR panoramas and outputting
them to separate layers in which you can
individually alter exposure, projection type,
field of view and output size. 

The high resolution inherent in bokehrama
images makes them ideal for making large
prints. Our 1.3-gigabyte sample image can
easily be printed on a 1.4 x 2.6-meter canvas
at 150 dpi. If you prefer to work with normal
sized prints, you can adjust output resolution
to virtually eliminate the effects of image
noise, even at high ISO settings. In contrast to
other techniques, which add artificial digital
blur to previously captured images, the
bokehrama method produces images with
natural-looking sharpness and smooth bokeh
effects. (anm)

Further Reading

Ralph Altmann, Perfect Panoramas, 
c’t Digital Photography, Issue 4, p. 78

Stefan Arand, Gigapixel Panoramas, 
c’t Digital Photography, Issue 7, p. 26 

Thomas Saur, the Beauty of Blur
c’t Digital Photography, Issue 2, p. 16

Alexander Jansen, Handheld Long 
Exposures, c’t Digital Photography, 
Issue 10, p. 68

Ralph Altmann,Combating Camera Shake, 
c’t Digital Photography, Issue 10, p. 78

Tool for calculating effective focal length
and aperture for bokehrama images:
http://brettmaxwellphoto.com/
Brenizer-Method-Calculation
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Once Hugin has finished its automatic search for control points, it displays a
merged preview image, often producing acceptable results at the first attempt.

In most cases, you’ll need to do a bit of manual tweaking to get the result you are looking for. Hugin’s built-in control point
editor includes color coding, a magnifier function and a comparison image view to help you find exactly the right points. c

Workshop | Bokeh Panorama
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Maike Jarsetz

The ABC of

Color Correction
Photoshop offers a wide variety of color correction settings and tools for
removing color casts, adjusting saturation globally or selectively, and
adjusting color balance. This article gives you an overview of the various
approaches to color corrections and provides detailed guides on how 
to apply selected advanced techniques.



If you take the trouble to set white balance
correctly while you are shooting, you will

have a much easier time at the image
processing stage. If you are working with RAW
image files, you can still alter white balance in
a RAW converter after the image has been
captured, either by using the software’s built-
in white balance tool to select an area of
neutral gray or by entering specific color
temperature and tint values. But you can
open JPEG images in Camera Raw too –
starting in Bridge, either use the Ctrl+R
keystroke or click the button shaped like an
aperture iris in the application bar at the top of
the window. The Camera Raw white balance
tool displays absolute Kelvin color
temperature values for RAW images or
abstract positive (warmer) or negative (cooler)
correction values without specific units for
JPEGs. 

This difference doesn’t affect the way the
tool looks or works for the different file types,
but nevertheless illustrates the fundamental
difference between RAW and JPEG
processing: while the RGB color channels are
created when you open a RAW file for
processing, JPEG color channels have already
been adjusted according to the parameters
stored in the camera’s firmware and can only
be be re-adjusted during processing – a
process that always causes the loss of some

tonal values and a reduction in overall image
quality. This is one of the major reasons why
you should always apply color corrections
carefully and sparingly.  

Color correction processes should always
begin with global corrections such as the
removal of a color cast and saturation
adjustments. Once you have established the
general coloring of an image, you can make
selective local adjustments to individual
image elements. You can adjust white balance
by using the gray point eyedropper built into
the Levels and Curves tools to select the basic
neutral gray tone for your image. This value is
set to 50 percent gray by default. All you have
to do to remove a color cast is use the
eyedropper to select an image detail that you
wish to appear neutral gray in the finished
image – Photoshop then automatically adjusts
the colors in the rest of the image accordingly.

The gray point eyedropper is a reliable,
highly controllable white balance adjustment
tool, but there are alternatives. The Auto Color
command in the Image menu uses the same
default neutral gray tone and applies it to the
midtones while simultaneously applying
neutral white and black point values to the
lightest and darkest areas in an image. This is
an extremely fast color adjustment technique
but gives you no control over where in your
image the white and black points and neutral
gray value are applied. The settings used for
auto corrections can be found in the Auto Color
Corrections Options dialog revealed by
selecting the Color Options command in the
Levels panel menu. 

The Match Color command represents a
slightly less orthodox way to achieve similar
results. This command applies all colors from
a selected source image or selection to your
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The White Balance tool shows color temperature values for RAW files (on the left)
or abstract correction values for JPEGs (on the right)

Use the gray point (midtone)
eyedropper in the Levels tool
to select a neutral gray tone
and eliminate color casts



target image, making it possible to apply
wide-ranging color corrections with a single
click (see the workshop section on page 134).
The Match Color dialog also contains the
powerful Neutralize checkbox that
automatically shifts all three color channels to
keep the midtones in the finished image
neutral. While this generalized approach
doesn’t suit all subjects, it does allow you to
effectively balance images that contain a large
number of neutral tonal  zones (such as winter
landscapes) using a single click.

Global and Selective 
Color Corrections

Once you have found the right white balance
settings, it’s time to set about adjusting color
globally, and the first step in this process is to
adjust saturation. At this point it is important
to note that the effects that can be achieved
using the traditional Saturation slider have
been superseded by the newer Vibrance
slider. Both sliders are part of the Basic
settings panel in Camera Raw and can also be

found in the Vibrance adjustment in the
Photoshop Adjustments panel. 

One way to remember the difference
between the two is to think of the Saturation
slider as a linear correction and the Vibrance
slider as proportional. While Saturation
adjusts all the colors in an image to the same
degree, Vibrance takes existing differences in
saturation between tones into account and
corrects less saturated colors more gently
than ones that are already fairly intense. This
approach protects skin tones and other
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The image on the left shows the effect of increasing Vibrance, while the one on the right shows the effect of increased Saturation

The Neutralize option in the Match Color
dialog automatically adjusts midtone color
balance



neutral areas from becoming too saturated
and helps them retain a natural look.

Applying color balance adjustments is
always a matter of taste. Analog fans often
use the Photo Filter adjustment’s presets,
which simulate the effect of attaching a
variety of physical filters to your lens. You
can, of course, select custom filter settings
too, based on user-defined colors or colors
that are found in the image itself. If you
activate the Preserve Luminosity option, the
filtered image will retain the same luminosity
as the original, making the result much more
subtle than a simple recoloring. The overall
intensity of the effect is controlled using the
Density slider.

Color Balance is another very popular
Photoshop adjustment tool. Three sliders
enable you to adjust the balance between the
primary colors and their complementaries
separately for shadows, highlights and
midtones. This function, too, includes a
Preserve Luminosity option, giving you the
opportunity to adjust color while preserving
clarity in the individual image zones.

Now that we have covered global
adjustments, it’s time to look at some of the
adjustments available for altering individual
tonal areas. The Hue/Saturation tool is a real
multi-talent in this segment, and uses the

principles of the Lab color model without
actually having to convert your image to the
Lab color space first (for more detail on Lab
mode, see page 130). Changes to hue,
saturation and luminance are made using
separate sliders, and the values displayed in
the preview diagram at the foot of the dialog
window represent the number of degrees of
rotation on the color wheel between the
selected color and the original color of the
pixel you are adjusting. You can select which
colors you want to adjust from a pop-up list
and further fine-tune the range covered by
your selection using the adjustment sliders in
the preview bar. The On-image Adjustment
tool (the ‘hand’ icon) is a really clever feature
of this particular tool, and allows you to adjust
saturation directly for the color at the current
cursor position simply by dragging it to the
right or the left  

Take care when using the Lightness slider,
as it adjusts all of the tonal values in the image
rather than just the midtones, which can lead
to a loss of shadow or highlight detail. 

Many RAW converters have similar
adjustment tools built in.  Lightroom, for
example, has the HSL/Color/B&W tool panel
and its own Adjustment Brush tool for
applying adjustments selectively. Some say
the Lightroom tools are even more capable
than those in Photoshop, as they offer a more
finely differentiated set of color segments and
a Luminance slider that works like a Levels
adjustment that preserves shadow and
highlight detail.

Although its functionality is no longer
really up to date, the Selective Color
adjustment – with its Cyan, Magenta, Yellow
and Black sliders – is still a favorite among
traditionalists, offering tools for adding or

subtracting percentage CMYK values in the
individual color  zones. The tool also offers
options for applying the values you select as
Absolute or Relative in relation to the value
you are adjusting.

Unfortunately, this tool doesn’t allow you
to preserve luminosity and lacks an option for
separating the adjustments you make to hue
and saturation, making it less flexible than the
ones described above. However, because it
treats blacks, whites and neutral tones as
separately adjustable color zones, it is
particularly good for adjusting neutral tones.
This enables you to adjust the color
component in gray tones without altering the
overall look of the image or having to make
selections first.

You can also use selective adjustments in
combination with various Photoshop tools. For
example, if you want to accentuate the color
of a particular image detail, select the Brush
tool from the toolbox and either set the tool
itself to Soft Light mode or apply it to a layer
that is set to Soft Light. Using a low opacity
value and a soft edge, press the Alt key to
select the color you wish to partially
strengthen. All you then have to do is use the
brush to apply it at the desired strength at
your chosen location.
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Press or release the Ctrl key to switch
between Hue and Saturation
adjustments when using the 
On-image Adjustment tool

Quick Tip

Select Color blending mode for your
adjustment (layer). This applies the
correction to color data only, thus
preserving luminosity and preventing
a loss of image detail.

Quick Tip

The Selective Color adjustment is particularly useful for adjusting selected neutral tones 
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Correcting Colors
using Reference
Values

Things get really interesting when you begin
to adjust colors according to specific
preselected values. The precise values we use
for CMYK image processing lose importance
here because – in these times of RGB image
processing, color management and
media-neutral publishing – color values are
only relevant if they are seen in relation to a
specific target color space.

However, you can still correct colors using
reference colors regardless of the actual color
space you are working in. 

Once again, the inconspicuous-looking
gray point eyedropper is a powerful tool, and
using it to define and apply target colors is just
as easy as applying a white balance correction,
as described earlier.  The process is described
in the workshop on page 132. 

A reference color can be taken from any
image file saved using any color space, so
even dyed-in-the-wool CMYK experts can use
it to get started in the world of RGB image
processing. If you use the eyedropper
technique from within the Curves tool, any
corrections you make will be recognizable in
the resulting RGB curves and can be
fine-tuned later on.

But even the eyedropper technique is not
definitive enough for some of the real ‘color
value fetishists’ out there. You can only be
sure of producing a precise, predictable
color value correction if you are working 
in an output-media-independent color
space, namely: the Lab space. The color
model used to describe this color space is
based on two color channels and a third 
channel that stores the lightness (i.e., the
luminosity) of the resulting color. This color
space can be used to make corrections
according to absolute reference values
which can then be converted for use in other
color spaces.

Here too, we use a previously corrected
image as the source for our reference color. In
order to create a reliable reference value, you
need to switch the Second Color Readout
option in the Info panel to Lab Color.

These target values are then defined as the
output values for the a and b channels in the
Curves for the Lab-mode interim file (see
opposite for more details on how).

Getting started: If your target image isn’t already in Lab
mode, you need to convert it before you begin. Your source
image can be saved in any color space. Open the Info panel
and go to the panel’s
Options menu.
Select Lab Color for
the Second Color
Readout option. This
enables you to
sample Lab color
values from your
source image,
regardless of its
original color space.

Step1

Select a Lab color: Move your
cursor to the color you want to
sample in your source image. You
will see that the L (Lightness) value
varies strongly between light and
dark details, whereas the a and b
values remain relatively constant.
This is because you are measuring
a pure color value independently
of its luminosity. Note the values
you want to apply and switch to
your target image.

Step 2

Working with Lab channels: Start by taking a look at the
Channels panel for your target image. You will see the Lab,
Lightness, a and b channels. Medium gray represents a
neutral color, while an
adjustment toward black or
white represents a color shift
between cyan and magenta
(in  the a channel) or
between blue and yellow (in
the b channel).

Step 3

Using Lab Mode to Duplicate Colors

c’t Digital Photography 11 (2013)
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Correct the a channel: If necessary, select the specific area you want
to adjust and then select the Curves tool in the Adjustments panel.
Switch to the a channel via the drop-down menu and use the
On-image Adjustment tool to select the color you wish to correct. Click
to apply the selected color to the curve’s diagonal. Now deactivate the
On-image Adjustment tool and enter the output value you noted
previously in the Output box.

Step 4

Correct the b channel and image contrast: Now switch to
the b channel and repeat the procedure described in step 4,
finishing by entering your previously noted output value.
The colors in your
target image are now
precisely matched to
those in your source
image. To finish off,
you can adjust image
contrast in the
Lightness channel
without affecting the
colors you have just
corrected. 

Step 5

Converting your adjustment into a
smart object enables you to convert it
for use in a different color space and
re-adjust your settings if necessary.
Double clicking the resulting smart
object re-opens the Lab mode
adjustment.

Quick Tip
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Correcting Skin Tones

Make your selection: Skin tones are generally so soft that it can be
quite difficult to isolate them from other image areas. The best
approach to adjusting them is therefore to start by making a basic
selection (for example, using the Quick Selection tool) which you can
then fine-tune using the Refine Edge dialog. You can then use an
appropriate View mode to help you judge the effect of the feather value
you have set.

Step1

Define your target color value: Select
the Curves tool from the Adjustments
panel – this is the best tool for judging
the effects of the changes you make.
Double click the gray point eyedropper
to open the midtone color picker and
sample your target color by clicking on
an area of your reference image that has
light shadows but also an obvious black
component.

The default target color should remain neutral gray, so
do not save your newly selected target color as default
when asked.

Step 2

Apply your reference color: The new gray point color you have
selected is only saved in the eyedropper for the current
adjustment and can be applied directly to your working
selection by clicking
on the area you want
to adjust. This type of
adjustment is most
effective when
applied to a slightly
shadowed area, but
the effect will vary
with the tone of the
detail you apply it to.
Just click away until
you end up with a
result that you like. 

Step 3
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Attenuate color shifts: If you use it to perform a serious color
shift, this type of adjustment adjusts shadow and highlight
details too, and can end up producing  a slightly blocky effect.
You can counteract this by selecting Color blending mode for
the adjustment layer, which reduces the effect of the adjustment
in the shadows and highlights. Reducing opacity for the
adjustment layer can also help to keep the effects subtle. 

Step5

Build up a library of reference color files: If you find this technique useful, 
it is a good idea to build up a library of standard skin tones and other ‘basic
materials’. All you have to do is sample two or three representative tones from 
a corrected image and save them as a gradient using the Gradient tool.

Step6

Step4 Fine-tune your selection: Using the Adjustments panel
automatically creates a new layer mask, which you can now
fine-tune to fit your particular needs. Right-click the mask
icon in the Layers panel and select the Refine Mask
command to adjust the size or contrast
of the mask, either using a brush or by
entering your desired values directly.
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Hue and Saturation settings can be used to
completely recolor parts of an image 

Transferring Image Statistics

Prepare your source and target images: It is not usually possible to use
the complete set of image statistics from a source image to color a target,
so you will normally have to select the area you want to adjust before
proceeding. The Match Color tool doesn’t work with separate adjustment
layers, so it is important to make as precise a selection as possible. For
safety’s sake, always duplicate the layer you are working on. The source
selection doesn’t have to be quite so precise but should contain a good
cross-section of the tones you want to transfer.

Step1

Match color: Navigate to Image > Adjustments > Match Color and select
your source image from the Source drop-down list. The colors in your
target selection will immediately be replaced by the selected source
colors. Be sure to activate both image statistics checkboxes – this ensures
that you use only the selected source colors and that they are applied to
your target selection only.

Step 2

Replacing Colors

Most conventional color correction
techniques cannot generate completely
new colors and are limited to adjusting
existing tones. Only the Hue/Saturation tool
is capable of isolating and coloring
individual tonal areas. Another way of
recoloring image detail is using the Channel
Mixer, although this does require more
detailed knowledge of how color channels
work. The best place to start replacing colors
is in the Channels panel, where you can get
an idea of how additive color synthesis
works and how colors are created by mixing
different levels of red, green and blue. While
you are still learning to use the Channel
Mixer, it is a good idea to try out some color
switches using the Hue/Saturation tool to
get a feel for how to manipulate channels to
achieve the results you are looking for. We
have included an example in the workshop
section on page 136.

The Hue/Saturation and Channel Mixer
tools reach the limits of their capabilities
when it comes to making extreme color
adjustments or changes to the basic
modulation of a color area – for example,
when switching from dark blue to bright
yellow or white. If this is the type of effect
you want to achieve, it is more effective to
simply replace colors rather than trying to
perform extreme manipulations. The Match
Color tool enables you to import color
statistics from a source image and apply
them to selected areas in your target image.
The workshop opposite explains how. (pen)
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Using layers to duplicate colors: You can also apply image
statistics from one part of an image to another part of the
same image. It is impossible to work with two selections
simultaneously, so in this case, you have to copy your
selections to separate layers before you make your
adjustments. You can then select the file itself as your
source image and the saved reference layer as your source
color for the adjustment.

Step 3

Adjust luminance and color intensity: If the new colors
don’t quite match your expectations, you can adjust their
luminance and intensity using the sliders in the Match Color
dialog. Using these sliders alters the source image statistics
before applying them to the target. The Fade slider reduces
the opacity of your adjustment in relation to the original, but
is less effective and less flexible than the adjustments you can
make using the opacity setting in your copied layer.

Step 4

Color and contrast: Even though the results of applying
Color Match are not saved on separate layers, you can still
fine-tune the final look using blending modes. New colors are
often too intense in comparison to the existing colors in the
target image, but you can modulate their effect by selecting
Color blending mode for the adjusted layer. This merges the
new colors with the tones of the original background,
producing a more authentic-looking result. 

Step 5
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Using the Channel Mixer

Channel analysis: Use an image with clearly defined colors when you
start to use the Channel Mixer. In our example, the bold blue of the door
makes it relatively easy to see and control what’s going on. You can
always try out some Auto Tone corrections for practice (for example, on
the red circle in our sample image) before switching to the Channels
panel. Check out the RGB channel first and then click through the
separate red, green and blue channels to see what they contain. In our
example, we are going to re-color the blue door in red.

Comparing the red and blue channels with and without auto correction
reveals that we could almost get away with just swapping the channels.
However, to get exactly the right effect, we also need to reduce the
intensity of the green channel to match that of the original red channel.

Step1

Red Green Blue

Swapping channels: Hide your trial correction and open a Channel Mixer
layer from the Adjustments panel. The red channel is displayed as the
default output channel in the Channel Mixer dialog. Reduce the red
component to 0% and increase blue to 100%, then switch to the blue
channel and do the opposite. This copies the original blue channel data
to the red channel and vice versa.

Step 2
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Mixing the individual channels: The resulting red tone still has a
yellowish cast. To adjust this, switch to the green output channel and
increase the red component, making sure to reduce the green
component by the same amount. The total value for a single channel
shouldn’t exceed 100% if you want to be sure of producing realistic-
looking colors. The dialog displays a warning sign if you do exceed 100%.

The aim here is to give
the green component a
similar intensity to the
original red component.
Work methodically when
performing this type of
adjustment, until you
find exactly the right mix
for the new channel. 

Step 3

Step 4 Mask neutral tones: This type of adjustment also affects the
neutrally-colored areas in your image, so you will either have
to work on a selection or mask any critical areas using a layer
mask.

Check the histogram display before and after you make your
adjustment. This makes it doubly clear which parts of the
image data have been swapped during the mixing process.

Before After

c
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Book Reviews

This is an exceptional book of photographs
that was out of print for ages. Cologne

publisher Taschen has recently brought out a
new 25th anniversary edition at a bargain price
of just US$30, which is fantastic value for a
printed work of this quality.

This book is a masterpiece, not just because
of the technical and artistic quality of
award-winning natural history photographer
Frans Lanting’s work. Many of the images have
an allegorical character that succeeds where
many textbooks fail, and they pave the way for
a deep understanding of evolution that is both
intuitive and intellectual.

Life begins without a foreword, launching
straight in to a brief summary of the earth’s
history. Captivatingly poetic, the first nine
photos show us the path from lifeless
substances to the first land animals. The final
photo in the series shows two barely visible
marine iguanas looking up from the shore at a
pelican flying over the ocean. It is hard to

imagine a more eloquent way of portraying the
conquest of Earth’s three major habitats.

The book’s explanatory text only begins
after the introductory photo sequence,
helping the reader to retain a sense of having
taken a ramble through the major milestones
of evolutionary history. The remaining 240 or
so pages are devoted almost entirely to
images. The aesthetically impressive photos
are either two-page spreads or full-page prints
that offer a sympathetic view of the natural
world and its myriad inhabitants. The photos
themselves are unhindered by text, but there
is an extensive section with explanatory notes
at the back of the book.

Virtually all the photos in Life are of poster
quality and many are already available
individually. But Lanting is sensitive even 
at his most striking, and fans of abstract or 
super-subtle photo art may not find what they
are looking for in this book. For everyone else it
is not to be missed, especially at this price.

Images of Evolution
Life: a Journey through Time

Life: A Journey Through Time

Frans Lanting
Published by Taschen
304 pages, 188 illustrations
14.6x 11.9 inches
US$29.99
ISBN 3-8-2283-9949

Conquering the elements:
Lanting describes the

development of life in a
series of spectacular images Ph
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A café on wheels, a floating concrete tea
house and roofs that grow chives:

Terunobu Fujimori designs unique, memorable
buildings. This new book shows excerpts of his
life’s work with extensive, sometimes amusing
commentary, most of it written by Fujimori
himself. In a refreshingly light, readable style
that is not the least superficial, he talks about
the background to his work – not only do his
designs use natural materials, they are unlike
anyone else’s, and though he doesn’t shy away
from using ultra-modern materials, Fujimori’s
constant desire is to envelop the products of
science and technology in nature.

Without a doubt, his tea houses are 
his most spectacular designs. For an
exhibition in Munich, he designed a 35 
square-foot tea house on wheels and high
stilts, a whimsical vehicle with wacky
proportions that are worthy of any fantasy
film. For all his sense of humor, Fujimori wants
to be more than merely decorative, as the

photos of the building’s interiors show. The
‘Walking Café’ evokes an engaging blend of
clarity, sensuality and security that is clearly
typical of all his work.

Architect presents 23 of Fujimori’s designs,
including his own home. The diversity of forms
is fascinating and hints at how he works – he
accepts very few commissions and usually
designs no more than one building a year. His
commitments as a university professor take
most of his time, so restricting commissions to
one a year allows him sufficient time to
consider the particular features of each
project, the physical setting and the materials
available in the locality. 

Whatever materials they are made from, all
the buildings and interiors shown in Architect
reveal their own unique and obvious sense of
harmony that immediately raises questions in
the viewer’s mind. After leafing through these
pages, readers may well find their own
surroundings rather lackluster. c

Beautiful Living
Terunobu Fujimori – Architect

Architect 

Terunobu Fujimori
Edited by Michael Buhrs and Hannes
Roessler
Photos by Ahihisa Masuda
Published by Hatje Cantz
240 pages, 199 illustrations
11.6 x 7.5 inches
US$60.00
ISBN 978-3-7757-3323-6

Crazy on the outside, 
cozy on the inside.

Fujimori’s eccentric-looking
designs always have human

comfort in mind. Ph
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Remote Control Apps for
DSLRs

❚ˇConnecting cameras to mobile devices opens
up a whole new range of creative opportunities
for photographers. Cheap (and free) apps for
Android and iOS are revolutionizing remote
DSLR control. We get to grips with some of the
latest solutions to hit the market and take them
for a spin.

32-bit Image Processing

❚ˇ32 bits don’t just mean another increase in
color depth like the one we experienced when
16-bit colors took over from 8-bit. 32-bit
processing heralds the beginning of a new 
era and spells the end of limitations to tonal
range, pixel brightness and contrast, giving us
the opportunity to capture the  world around
us the way it really looks. We introduce some
32-bit tools and take a look at the pros and
cons of the next big step up the image quality
ladder.

Photographing Nature

❚ˇWhether in the garden, the park or further
afield on vacation, when you are out and about
you are sure to find a wealth of natural subjects
to capture and keep. This workshop from pro
photographer Reinhard Eisele gives you
invaluable tips on the right gear to use, finding
potential subjects and composing your 
images once you have the right scene in the
viewfinder.
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